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This document contains important safety information. Read this document before
attempting to install or use the Chirascan Q100. Failure to do so could result in death or
serious injury.
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Use of this Document

1 Use of this Document

This document is intended to inform the operator of the Applied Photophysics Chirascan Q100 on its
design, installation and operation with 21 CFR part 11 software. A dedicated Chapter describes the
specific operation of the software regarding functionality required for compliance with the 21 CFR Part 11
regulation. The user should be familiar with the means by which Chirascan systems can meet the
requirements imposed by the 21 CFR Part 11 regulation as described in the Chirascan 21 CFR Part 11
Compliance Booklet..

Some of the items that may be supplied with the instrument are manufactured by external companies,
and are supplied with separate user manuals provided by those companies. The operator should be
familiar with the contents of those manuals, and, in particular, with the safety and hazard information
contained in them.

The Chirascan Q100 is an accessory for the Chirascan Q100, and this document should be used in
conjunction with the Chirascan Q100 user manual. It is assumed that the user of this document is
familiar with the operation of the Chirascan Q100 and with Applied Photophysics’ Chirascan software. In
particular, it is assumed that the user is familiar with the hazards associated with the operation of the
spectrometer, and has read the safety information contained in its user manual.

The information in this document is subject to change without notice and should not be construed as a
commitment by Applied Photophysics, who accept no responsibility for errors that may appear herein.
This document is believed to be complete and accurate at the time of publication, and in no event shall
Applied Photophysics be held responsible for incidental or consequential damages with or arising from
the use of this document.

COPYRIGHT © 2023 APPLIED PHOTOPHYSICS LIMITED. ALL RIGHTS RESERVED. THIS
DOCUMENT OR PARTS THEREOF SHALL NOT BE REPRODUCED IN ANY FORM WITHOUT THE
WRITTEN PERMISSION OF THE PUBLISHER. 

THE SOFTWARE PROVIDED WITH THE CHIRASCAN Q100  (CHIRASCAN CONTROL, CHIRASCAN
VIEWER, CHIRASCAN AUTOSAMPLER ETC.) IS THE PROPERTY OF APPLIED PHOTOPHYSICS
LIMITED AND IS SUPPLIED UNDER LICENSE. APPLIED PHOTOPHYSICS IS WILLING TO LICENSE
THE SOFTWARE ONLY UPON THE CONDITION THAT THE LICENSEE ACCEPTS ALL THE TERMS
CONTAINED IN THE LICENCE AGREEMENT. THESE INCLUDE THAT THE LICENSEE MAY NOT
SELL, RENT, LOAN OR OTHERWISE ENCUMBER OR TRANSFER LICENSED SOFTWARE IN
WHOLE OR IN PART TO ANY THIRD PARTY. FOR A FULL COPY OF THE LICENCE PLEASE
CONTACT APPLIED PHOTOPHYSICS OR SEE THE SOFTWARE INSTALLATION DISK.

Applied Photophysics makes every effort to ensure the functionality and stability of its software and
reserves the right to make changes or improvements to the software at any time without notice. Applied
Photophysics cannot be held responsible for any errors in, omissions or loss of data as the result of:
system malfunctions arising from power or hardware failures; errors or omissions in this user manual; or
user action beyond what is described in this user manual. The latter includes but is not limited to: failing
to establish regular database backups; failing to secure the database externally; replacing the database
by restoring a database backup; accessing the database through Microsoft SQL Server Management
Studio or by other means that are not an integral part of the Chirascan software. Moreover, Applied
Photophysics accepts no liability for the interpretation of data measured with its instruments or the
outcome of such interpretation.

Software version numbers and appearance of operating system or graphical user interfaces displayed in
screenshots may not always correspond to the currently released software version or the user’s
operating system. However, all screenshots show the content related to the functions that they are
supposed to illustrate.
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Use of this Document

This document refers to ANMS 2.0.2 and the Chirascan software suite 5.5.0.4.

This document does not replace older document versions; users are advised to keep the document
version received upon installation of the instrument, as deprecated software and/or hardware functionality
might not be reflected in current document versions.

Chirascan is a trademark of Applied Photophysics Limited.
All other trademarks or registered trademarks are the sole property of their respective owners.
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Use of this Document

1.1 Hazards and Other Indicators

HAZARD INDICATORS USED IN THIS DOCUMENT

The sign to the left is used to indicate a hazardous situation, which, if not
avoided, could result in death or serious injury.

The sign to the left is used to indicate a hazardous situation, which, if not
avoided, could result in minor or moderate injury.

OTHER INFORMATORY INDICATORS USED IN THIS DOCUMENT

The sign to the left is used to indicate a situation which, if not avoided, could
result in damage to the instrument, incorrect data, loss of data or failure to
comply with 21 CFR Part 11 regulations.

HAZARD INDICATORS USED ON THE SPECTROMETER

Note that these hazard indicators may be either colored as below or black and white and indicate the
presence of a hazard that is either described by text accompanying the sign or in this user manual.

The sign to the left is a general hazard indicator.

The sign to the left indicates risk of electricity / high voltage.

The sign to the left indicates risk of optical radiation / UV radiation.

The sign to the left indicates risk of hot surfaces / high temperatures.

1.2 Hyperlinks and References

The electronic version of this document contains hyperlinks between references (including the Table of
Contents and references to Sections in the text) and sources. Left-click to follow a link. Hyperlinks in the
text are indicated by underlined blue  font.

Elements and terms from the Windows operating system or the Chirascan software that are referred to
as they appear in the graphical user interface are indicated in bold font.

Arrows (→) indicate the selection of a sub entry in a menu.

12
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Use of this Document

1.3 Glossary

The following abbreviations are used in the descriptive text in this user manual:

ANMS Active Nitrogen Management System
APD Avalanche photodiode
AU Absorbance units (dimensionless)
CD Circular dichroism
21 CFR Part 11 The Food and Drug Administration’s (FDA) Part 11 of Title 21 of the 

Code of Federal Regulations (CFR): Electronic Records; Electronic Signatures
CP Circularly polarized
DC Direct current
LAAPD Large area avalanche photodiode
HT High tension – the same as high voltage
HV High voltage – the same as high tension
L-CP Left-handed circularly polarized
LED Light-emitting diode
PEM Photoelastic modulator
R-CP Right-handed circularly polarized
SCP Spectrometer control panel
S/N Signal-to-noise ratio
UV Ultraviolet
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Essential Safety Information

2 Essential Safety Information

MAKE SURE THAT YOU HAVE READ AND UNDERSTOOD ALL THE SAFETY INFORMATION
CONTAINED IN THIS DOCUMENT, AS WELL AS ANY DOCUMENTATION BY THIRD-PARTY
MANUFACTURERS SUPPLIED WITH THE INSTRUMENT, BEFORE ATTEMPTING TO INSTALL OR
OPERATE THE CHIRASCAN Q100. IF YOU HAVE ANY QUESTIONS REGARDING THE OPERATION
OF THE SPECTROMETER, PLEASE CONTACT APPLIED PHOTOPHYSICS CUSTOMER SUPPORT.

OBSERVE ALL SAFETY LABELS AND NEVER ERASE OR REMOVE SAFETY LABELS.

PERFORMANCE OF INSTALLATION, OPERATION, OR MAINTENANCE PROCEDURES OTHER
THAN THOSE DESCRIBED IN THIS USER MANUAL MAY RESULT IN A HAZARDOUS SITUATION
AND WILL VOID THE MANUFACTURERS WARRANTY.

The Chirascan Q100 is powered by the mains electricity supply which can
produce an electric shock leading to serious injury or death. Do not connect or
disconnect electrical leads to the mains supply unless the supply is powered
off at source. Exercise care during operation and do not operate units with
their covers removed. In the case of emergency, switch off the system at
mains power outlet / switchboard. For reconfiguration or maintenance, switch
off the system power supply unit before disconnecting any cables.

Ensure all communications and electrical connections are made and any
jackscrews (if present) are tightened before powering on the spectrometer.
Operate the spectrometer using only the cables provided. Never operate a
spectrometer or any peripherals such as the Peltier controller with damaged
cables.

The metal components of the spectrometer can produce an electric shock
leading to serious injury or death if they are not earthed (grounded). The
design of the spectrometer provides protection against electric shock by
earthing appropriate metal components. This protection will be lost unless the
power cable is connected to a properly earthed outlet. It is the user’s
responsibility to ensure that a proper earth connection can be made.

Detectors of the Chirascan Q100, including the avalanche photodiode (APD)
detector, operate at high voltages and can produce an electric shock leading
to serious injury or death. Do not connect or disconnect the detector from the
spectrometer unless the spectrometer is powered off. Do not allow any item to
come into contact with the front end of the detector while the detector is
connected and powered up, as this may cause an electrical short leading to
serious injury to the user and damage to the detector.
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Essential Safety Information

The light source of the Chirascan Q100 is a 150-watt xenon arc lamp that
produces intense UV radiation that can be harmful to skin and eyes and may
even impair eyesight permanently. Do not allow the skin to be exposed to UV
radiation. Never look directly at the light source. Do not power on the lamp
unless it is correctly mounted in the lamp housing. Do not remove the lamp
system cover and do not open the lamp housing while the lamp is operative,
as indicated by the yellow lamp system cover indicator. Do not attempt to
remove the UV filter of the lamp housing port. Do not attempt to remove the
Single Cell Peltier Holder or any accessory that replaces it unless the lamp is
powered off or the lamp shutter is closed.

Xenon arc lamps have a high internal pressure and can burst, particularly when
hot, causing injury to the user and bystanders. Do not open the lamp housing
immediately after it is powered off. Handle carefully, do not submit the lamp to
shock, and wear eye, full face (shield / visor), and body protection, including
full arm covering. Do not touch the glass bulb of the lamp with bare hands.
When handling lamps, ensure that others are restricted from entering the area
or wear protective personal equipment as well. If not installed, always store
and transport lamps (old or new) only in safety metal cases provided by
Applied Photophysics to guard against implosion.

 
The moving parts of the autosampler could cause serious injury to the user or
damage to the instrument. For safe operation the moving parts are contained
within an enclosure fitted with an interlock device, which is engaged while the
autosampler is operating. Do not attempt to open the enclosure door upon
autosampler operation or to override the interlock device. In some
circumstances, for example when manually adjusting the position of the probe,
it may be possible to move the autosampler arm using the autosampler
software while the enclosure door is open. Do not use the software to move
the autosampler arm while the enclosure door is open. Do not operate the
autosampler without the removable panels at the lower front, side and rear in
place. Do not introduce any object through the brush panel ports on the rear of
the autosampler while the autosampler is operating.

The autosampler usually uses acetone (propanone) as a cleaning agent.
Acetone liquid and vapor is highly flammable and must be kept away from
sources of ignition. Vapor can form explosive mixture with air and ignition by
static discharge is possible. Appropriate fire safety provisions (e.g., fire
extinguishers) must be available on-site. Acetone is volatile and harmful upon
inhalation - it must be ensured that measures for venting acetone fumes from
the top of the autosampler enclosure are in place. For other hazards
concerning acetone and other cleaning agents, see the supplier’s material
safety data sheet (MSDS).
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Essential Safety Information

Upon normal operation, the Chirascan Q100 is purged with nitrogen gas, which
can act as an asphyxiant—high levels of nitrogen gas in the operation
environment may cause hazard due to oxygen depletion (atmospheric
concentration below 19.5%). Therefore, safety measures (i.e., ventilation,
oxygen monitoring etc.) that take into account site-specific constraints (e.g.,
room size, altitude, experimental regimen etc.) must have been established
upon commissioning of the system (on-site risk assessment) and be
continuously maintained to ensure safe oxygen levels. It is highly
recommended to operate an oxygen monitoring device in close proximity to
the instrument at all times where risk of oxygen depletion is evident, and it is
the user's responsibility to ensure that any operators of the Chirascan Q100
understand function of such a device. If nitrogen purging must be stopped in
case of emergency (e.g., if ventilation cannot be maintained), nitrogen flow
must be cut off by closing the mains gas outlet at the operation site.

Depending on the target measurement temperature, the autosampler cartridge
and cell may be very hot or cold, causing injury to the user when touched.
Ensure that they have been allowed to reach a safe temperature before
handling or use protective equipment (e.g., thermally protective gloves) if their
insertion or removal at extremely high or low temperature is required. Carry out
risk assessment and consider additional personal protective equipment if in
doubt.

Depending on system configuration and experiment design, target

measurement temperature can reach between -20°C and 105°C. Extra care

should be taken when handling a potentially hot/cold cell as the target

measurement temperature is actively set through computer control and
monitored only via the Peltier controller display or the control software. As
unsafe temperatures cannot be identified otherwise (e.g., after hard- and
software is switched off or fails), the Chirascan Q100 may only be used by, or
under supervision of, trained laboratory personnel familiar with this user
manual and the risks associated with usage of the system and related
procedures, particularly when conducting experiments at elevated sample
temperatures.

The lamp is at high temperature during operation. Do not remove outer lamp
system cover while the lamp is on. Surface temperature of the lamp unit
housing exceeds 50°C during operation, imposing risk of burns, DO NOT
TOUCH. After powering off, allow lamp housing temperature to decrease until
cool to touch (at least 30 minutes) before removing the lamp.

Although microplate temperatures are not set to extreme values upon typical
system usage, the range of temperatures accepted by the microplate
temperature controller is from -10°C to 80°C and, thus, microplate holders may
be hot. When setting microplate temperatures, take extra care to enter safe
temperatures only.

 
The interaction between UV light and oxygen leads to the formation of ozone,
a very reactive gas that is damaging to health and may cause deterioration of
the optical components of the instrument. It is essential that the spectrometer
is thoroughly purged with nitrogen before the lamp is powered on.
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When changing a lamp, remember that the programmed schedules for the
ANMS will remain active. Do not power on a Xenon or Mercury-Xenon lamp
until the lamp spectrometer has been thoroughly purged.

The Chirascan Q100 may only be used by, or under supervision of, trained
laboratory personnel familiar with this user manual and the risks associated
with usage of the system and related procedures. Users are expected to
adhere to local health and safety regulations and wear personal protective
equipment according to good laboratory practice. Operators are expected to
act on local risk assessment that has been carried out in advance. The
system or any of its parts may not be used when tired or under the influence
of alcohol, medication, or other substances that possess a known potential to
impair user capabilities.

The Chirascan Q100 must not be used if any displays, indicators (e.g., for
lamp status and sample temperature) or warning devices (e.g., nitrogen alarm
system) are not operable.

 
Regularly assess liquid levels of waste containers and empty after each
experiment to prevent overflow and spill hazard. Place vessels in a tray at all
times to contain any spills or inadvertent overflow.

 
The intended use of the Chirascan Q100 is within a laboratory environment for
research and development purposes. As such, samples used for
measurements with the system are usually not yet fully characterized and are
typically biological samples or, less commonly, samples containing volatile
organic solvents. Risk assessment in terms of known and unknown potential
hazards arising from the nature of these samples (e.g., biohazards, corrosion,
flammability etc.) and implementation of suitable safety measures (e.g., usage
of biocides, sealed cuvettes) when operating the instrument with such
samples is the responsibility of the user(s). Applied Photophysics shall not be
liable for any damage to equipment or users arising from inadequate risk
assessment or sample handling by the user(s). For health and safety
information about chemicals, refer to manufacturers and local regulators. Risk
assessment must be carried out, particularly, regarding potential risks of
leakage from tubing or fittings and related sample spills,

The electronic circuitry used in the spectrometer is very sensitive and must be
correctly earthed (grounded) to avoid electrical interference. It is the user’s
responsibility to ensure that a proper earth connection can be made.

The performance of xenon arc lamps shows some deterioration over time. It is
recommended that the lamp is replaced after 1000 hours of use.

The performance of the nitrogen filter decreases over time as trace organic
impurities are accumulated. It is recommended to replace the filter whenever
the lamp is replaced.

To confirm correct operation of the nitrogen alarm, the system should
occasionally be subjected to a power cycle. This will sound the alarm if it is
functional.
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The monochromator of the spectrometer contains computer-controlled moving
parts which may move without warning. The monochromator may only be
accessed by Applied Photophysics personnel and after system power has
been switched off.

Upon reconfiguration of the system, ensure that any parts are being installed
as described, screws tightened, electrical connections fixed with jackscrews
(if applicable), and gas fittings secured.

The spectrometer has components than can be damaged if their movement is
not restricted when the spectrometer is moved. Please contact  Applied
Photophysics if you wish to move the spectrometer.

Corrosive chemicals and organic solvents can cause damage to the
spectrometer. Do not allow corrosive fluids to come into contact with any part
of the spectrometer. Do not clean the spectrometer with organic solvents. Use
only a soft cloth and water or a mild detergent solution.

Do not attempt to lift the cell cartridge by pulling on the exposed flow tubing,
as this could cause the tubing to come away from its connectors.

An autosampler stop button is located on the lower front panel of the
autosampler enclosure. Pressing this button will cause all autosampler activity
to stop as soon as possible, but will not cut the mains electricity supply. All
power cords of the Chirascan Q100, including spectrometer and autosampler,
should be connected to a power strip with switch so that the mains electricity
supply can be cut in case of an emergency.
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3 Installation and Operational Requirements

Environmental requirements
The Chirascan Q100 is best installed in a safe position, in a clean, air-conditioned, and well-lit laboratory
environment. Installation must be close to the facility’s mains power and nitrogen gas outlet as it must
be possible to quickly isolate the instrument from mains power or gas supply in case of emergency.

Operating conditions
Temperature: 20°C to 25°C controlled to within 1.5°C
Humidity: 20% to 80% non-condensing
Dust levels: minimum

Storage conditions
Temperature: -20°C to +50°C
Humidity: 5% to 80% non-condensing

The Chirascan Q100 is designed for waste volatiles such as acetone, which is used as a cleaning agent,
to be vented from the top of the protective enclosure. The user should ensure that an extraction system
is available for these to be removed from the laboratory environment, for example by conveying to an
appropriate fume hood. 

Bench space
The total bench space required for the Chirascan Q100 is:

Length × depth × height: 3.5 × 0.8 × 1.3 meters

Additional space is also required below the bench for the water circulator and for waste vessels.

A flat, stable, and vibration-free work surface which is sturdy enough to support the total bench weight of
the system is required. In regions prone to seismic activity, it is recommended that the system is
tethered. If the latter is necessary, please contact  Applied Photophysics Customer Support.

Weights
Spectrometer lift weight*: 84 kg
Spectrometer bench weight: 91 kg
Autosampler: 98 kg
Total bench weight**: 207 kg

*without lamp housing cover
**includes Peltier controllers and empty cleaning solution
bottles, does not include computer

Electrical requirements
The Chirascan Q100 is supplied with two filtered mains distribution boards which require an earthed
(grounded) mains electricity supply of 100 to 240 VAC 50/60 Hz each. One distribution board powers the
spectrometer (including monochromator, lamp and ANMS), whereas the other distribution board powers
the autosampler and the Peltier controllers. The distribution boards have power ON/OFF switches and
must be in an accessible position, for disconnection from the mains supply.

Monochromator electronics unit
Input voltage 100 to 240 VAC 50/60 Hz. Current 3 A max. Fuse type, rating T 4A H 250 V.

Lamp electronics unit
Input voltage 100 to 240 VAC 50/60 Hz, Power 185 VA max. Fuse type, rating T 3,15A H 250 V.

ANMS electronics unit
Input voltage 100 to 240 VAC 50/60 Hz, Power 40 VA max. Fuse type, rating T 1A H 250 V.
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Autosampler electronics unit
Input voltage 100 to 240 VAC 50/60 Hz. Power 125 VA max. Fuse type, rating T 4A H 250 V.

Peltier controller electronics unit
Input voltage 100 to 240 VAC 50/60 Hz. Power 85 VA max. Fuse type, rating T 2A H 250 V.

Nitrogen purge gas
The Chirascan Q100 requires constant purging with 99.998% oxygen free nitrogen at a pressure of 4 to 6
bar (60 to 90 psi) and flow rate of at least 5 liters per minute. 

Fluid circulator unit
The fluid circulator supplied as standard with the Chirascan Q100 is a CW-3000 Industrial Chiller. The
circulator should be placed on the floor, close to the spectrometer. Using other circulators is not
advised.
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4 General Information

Computer configuration
The Chirascan Q100 is normally supplied with a PC pre-configured for use with the instrument. However,
there are some issues that you need to be aware of, described below.

Administrator login
No password is set by Applied Photophysics for the Administrator account. Customers are advised to
set the Administrator password of the Chirascan PC themselves.

Applied Photophysics Service Account
The user account “APLService” has been created and given administrative privileges by Applied
Photophysics. This account will be used by Applied Photophysics' engineers during servicing of your
spectrometer. Do not remove this user, or change the password.

Chirascan User Login and the Chirascan Users Group
The user account “Chirascan User” has also been created by Applied Photophysics. Chirascan Q100
users may log in as “Chirascan User”, or the system administrator may create individual user accounts.
A “Chirascan Users” group has also been created, and users should be made members of this group. If
the Chirascan PC is connected to a network then this may affect the way in which users log on to the
Chirascan PC. The system administrator should ensure that “network” or “domain” users who want to
use the Chirascan software are members of the “Chirascan Users” group.

Virus protection

The Chirascan PC may be supplied with a trial version of a 3rd party anti-virus package. Applied
Photophysics recommends that the Chirascan PC has up-to-date anti-virus software installed at all
times. Most users will have a preferred anti-virus software package, and Applied Photophysics generally
recommends that the anti-virus software which is supported by the users' ICT department be installed on
the Chirascan PC. However, please see the note on installing 3rd Party software below.

Networking
The Chirascan PC is supplied with networking capabilities. However, before the Chirascan PC is
connected to a network, the System Administrator should ensure that appropriate anti-virus (and
optionally anti-spyware) software is installed and maintained. Applied Photophysics cannot be held
responsible for failure of the Chirascan PC due to viruses or other malware.

Installation of 3rd Party Software
The Chirascan software suite is not compatible with most 3rd party firewall programs, including Norton,
McAfee and Sophos firewall programs. The software suite is compatible with Microsoft Windows built-in
firewall, provided that Chirascan software is listed as an exception. Applied Photophysics is not aware of
any other conflicts with 3rd Party Software and will not be held responsible for failure of the Chirascan
software because of any such conflict. 

Upgrading Software and/or Hardware
The Chirascan software has been developed for use with Microsoft Windows software and has been
extensively tested on the PCs supplied by Applied Photophysics. Applied Photophysics cannot be held
responsible for failure of the Chirascan software if the Chirascan user or system administrator upgrades
the PC, or the PC's Operating System.

Technical Support and Licensing
Applied Photophysics will provide technical support, under the terms of the Service Level Agreement, for
the software, subject to the Chirascan Software License, and for the supplied PC. However, Applied
Photophysics cannot be held responsible for failure of the software or hardware through misuse or
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neglect by the user, nor can Applied Photophysics be held responsible for loss of data. It is the sole
responsibility of the user to ensure that data is backed up and that a disaster recovery plan is in place.

If you have any queries relating to the software or PC, please contact  Applied Photophysics
Customer Support.

Servicing
Servicing of the Chirascan Q100 and its peripherals should only be undertaken by qualified personnel. If
you are in any doubt at all please contact  the Applied Photophysics Customer Support.
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5 Introduction

This Chapter contains a brief introduction to the Chirascan Q100, its hardware, software and operation
with 21 CFR part 11 compliant software. It also describes the basics of making a good Circular
Dichroism (CD) measurement.

5.1 The Chirascan Q100

5.1.1 The Spectrometer Hardware

Figure 1: The Chirascan Q100 spectrometer

The Chirascan Q100 (Figure 1) is designed for high performance automated CD measurements on a
number of samples in a highly regulated research environment.

The Chirascan Q100 comprises two main sections : the spectrometer with lamp housing and
monochromator on the left and the autosampler on the right.

In its standard configuration, up to 192 samples are loaded into up to two 96-well microplates which are
then mounted manually on the autosampler, and that configuration is shown in this user manual. All
subsequent operations are performed by the autosampler. Samples are collected in turn from each well
by a probe and delivered into a sample cell which is fixed in position in a light-proof chamber. The
sample cell is automatically cleaned after each measurement, and the next sample is then loaded into
the clean cell. Cells with path lengths from 0.1 to 10 mm are available.

Each cell has a unique serial number which is stored in the spectrometer software along with other cell
details. The number will be automatically read when the cell is mounted on the spectrometer, and its
details will be used for all subsequent operations. 

More detailed information on the spectrometer Hardware  is given in the corresponding Chapter. 

40
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5.1.2 The Spectrometer Software

The Chirascan Q100 software comprises three main programs, Chirascan Control ,  Chirascan
Viewer  and Chirascan Autosampler . The Active Nitrogen Management System  (ANMS) for
monitoring and control of nitrogen purging runs independently of the Chirascan software.

The software platform architecture that the Chirascan Q100 runs under is summarized schematically in
Figure 2.

Figure 2: The software platform architecture

Experimental procedures, cleaning routines, file names, results folders and other information for each
well are entered on a spreadsheet, which can be filled out and edited either from within the spectrometer
software or using Microsoft Excel™. 

The experimental procedures are set up as templates , which are created, editedand saved in
Chirascan Control . Experimental data is saved to Datastores , and is viewed, analyzed, exported
and imported in Chirascan Viewer . The autosampler is controlled and configured  with Chirascan
Autosampler .

Experimental templates, Datastores, Application definitions for autosampler configuration and other
information are stored in an SQL (Structured Query Language) Database, the management of which is
controlled by a Chirascan Server. Chirascan Control , Chirascan Viewer  and Chirascan
Autosampler  form the presentation layer of the architecture which is visible to the user and has two-
way communications with the Chirascan Server.

Experimental templates , Datastores  or Application definitions  are organized in revisions: If
these records are modified in any way and saved, a new revision is created. This ensures that the
originally recorded data is kept on record and any changes become part of a separate revision.

The software supplied with the Chirascan Q100 is compliant with the U.S. Food and Drug Adminstration
(FDA) Part 11 of Title 21 of the Code of Federal Regulations: Electronic Records, Electronic Signatures
(21 CFR part 11 ) and certain software functions are made available by the corresponding license.
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5.2 Operating Principles

This section gives a short introduction to CD spectroscopy and describes the operating principles of the
Chirascan Q100.

5.2.1 Circular Dichroism

Circular dichroism (CD) is the difference in absorbance between left-handed circularly polarized (L-CP)
light and right-handed circularly polarized (R-CP) light and occurs when a molecule contains one or more
chromophores (light-absorbing groups) in chiral environments, i.e.:

CD = ΔA(λ) = A(λ)
L-CP

 - A(λ)
R-CP

(1)

where λ is the wavelength and A is the absorbance. 

Circular Dichroism spectroscopy is a technique where the CD of a sample is measured over a range of
wavelengths. It is used extensively to study chiral molecules of all types and sizes, but it is in the study
of large biological molecules where it finds its most important applications. A primary use is the analysis
of the secondary structure and tertiary structure of macromolecules, particularly proteins. As protein
conformation is sensitive to environment, e.g. temperature, pH, or the presence of ligands, CD can be
used to observe how secondary or tertiary structure changes with environmental conditions or on
interaction with other molecules. Structural, kinetic and thermodynamic information about
macromolecules can be derived from CD spectroscopy.

Measurements carried out in the UV and visible regions of the electromagnetic spectrum monitor
electronic transitions, and, if the molecule under study contains a chromophore in a chiral environment,
then one CP light state will be absorbed to a greater extent than the other, and the CD signal over the
corresponding wavelengths will be non-zero.

The spectrometer measures alternately the absorbance of L- and R-CP light, at a frequency of 50 kHz,
and then calculates the CD signal. A CD signal can be positive or negative, depending on whether L-CP
light is absorbed to a greater extent than R-CP light (CD signal positive) or to a lesser extent (CD signal
negative). 

Simultaneously with the CD measurement, the spectrometer can measure the sample absorbance, but
note that, unlike on conventional CD spectrometers, the absorbance measurement is exact, as the
LAAPD detector gain is known precisely. The Chirascan Q100 can also be used in direct absorbance
mode  as a single-beam absorbance spectrometer. 

5.2.2 How the Spectrometer Works

The spectrometer scans across a range of wavelengths , from high to low. The wavelength does not
change continuously but is selected step-wise  by the monochromator, with an acquisition being
performed after each step. 

At any step, light with a certain spread in wavelength is allowed to pass through the sample rather than
light of a single wavelength. This spread is the spectral bandwidth . For example, with the
monochromator set to 260 nm and a bandwidth set to 1 nm, the light arriving at the sample will be
between 259.5 and 260.5 nm (approximately – the situation is slightly more complicated than that).

At each step, photons are collected by the detector for a given amount of time, the time-per-point .
After the scan across the specified wavelength range is completed, the scan may be repeated
multiple times with the same settings.
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In summary, the settings that need to be defined for spectral acquisition are the wavelength range, step
size, time-per-point, bandwidth, number of repeats and, usually, temperature.

For example, with the wavelength range set to 260 to 180 nm, the step size to 1 nm, and the time-per-
point to 1 s, the monochromator remains stationary for 1 s for a reading at 260 nm, then it moves to
259 nm for another reading for 1 s, then moves to 258 nm, and so on.

The acquisition settings defined above will give a total of 81 data points, so the nominal acquisition time
will be 81 s. However, the monochromator will spend a little time moving between wavelengths and
acquisition will take slightly longer if the AutoPM  function is enabled (which it is by default), so the
total scan time will be longer than that (about 100 s). Therefore, an approximate scan time is shown on
the Sampling panel  of the spectrometer control panel . If more than one repeat is used, the
acquisition time increases in proportion.
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6 Quick Start

This Chapter describes the basic operation of the Chirascan Q100, covering the startup of hardware and
software, functions of the spectrometer  and autosampler  control software essential for setting up
and running measurements, and general features of the data acquisition  software that enable the
user to display CD spectra, perform basic data analysis and export data to formats compatible with
third-party programs.

6.1 Hardware Startup
Main system power

1. Make sure the black rocker switch for the System on the front panel  is in the power on (I)
position.

2. Make sure the black rocker switch for the Lamp on the front panel  is in the power on (I) position.
3. Make sure the autosampler is switched on.

Nitrogen purging

The spectrometer requires purging with high purity nitrogen gas  before and during use to prevent the
formation of ozone and eliminate oxygen from the light path.

The interaction between UV light and oxygen leads to the formation of ozone,
a very reactive gas that is damaging to health and may cause deterioration of
the optical components of the instrument. It is essential that the spectrometer
is thoroughly purged with nitrogen before the lamp is ignited.

1. Make sure that your nitrogen purge gas supply is stocked sufficiently to provide enough nitrogen for
the planned measurements at the default flow rates . Then open the valve of the nitrogen supply.

2. Start the Active Nitrogen Management System (ANMS)  software and click Connect on its main
screen. If required, schedule purging . If the spectrometer has not been used for an extended
period, purge overnight. 

3. Click Start Lamp Ignite Sequence in the Monitor tab; the lamp will be ignited automatically once
the instrument has been purged sufficiently.

4. After ignition, leave the lamp to stabilize for at least 20 min before acquiring data.

Peripherals

1. Turn on the water circulator .
2. Turn on the Peltier controllers for the sample chamber  and microplate racks .

Always make sure that the water circulator is switched on to remove heat from
the Peltier device. Otherwise, the temperature of its heat exchanger rises until
a certain cut-off value is exceeded and temperature control is automatically
shut down to prevent damage to the unit.
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6.2 Software Startup

Before starting any software, make sure that the spectrometer including its peripheral hardware is turned
on .

The programs need to be opened in the following sequence for correct communications to be
established:

1. Open the Chirascan Server  by double-clicking its desktop icon. The Chirascan Server icon will
appear on the desktop.

2. Open Chirascan Control  by double-clicking its desktop icon.

Upon software startup, the instrument automatically checks its zero positions (you may hear the
monochromator motors moving).

2. Open Chirascan Viewer . Chirascan Viewer is launched on-line from the Spectrometer Control
Panel (SCP)  by clicking on the Chirascan Viewer launch icon in the SCP toolbar. 

For viewing and analyzing data only without performing measurements, Chirascan Viewer can also be
launched off-line  by clicking on its desktop icon.

In general, when working at the instrument, it is recommended that Chirascan Viewer is launched from
Chirascan Control using the toolbar icon as this will ensure that local communication is established, that
Chirascan Viewer will work correctly as a real-time display, and that the data will be saved in the Save to
Repository  if working in Manual Mode .

4. Open Chirascan Autosampler  by double-clicking its desktop icon.

6.3 Basic Data Acquisition

6.3.1 Configuring Acquisition Settings

The settings for spectral acquisition are set up as a template in the Spectrometer Control Panel
(Figure 3). The SCP is divided into a number of panels: Signal (with sub-panels Options and
Background), Temperature Control Unit, Sample Chamber, Monochromator, Sampling,
Sequencer, and Progress and Status, which group the parameters relevant for the control or
management of each panel’s function. In addition, there is an unlabeled panel for controlling shutter
function and detector emulated high voltage in the upper right section of the SCP.
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Figure 3: The Spectrometer Control Panel

Configure the settings for spectral acquisition:

1. In the Monochromator panel , choose a wavelength range (Low and High), set the Step size, and
click Set to confirm.

2. In the Monochromator panel , set the Bandwidth and click Set to confirm.
3. In the Sampling panel , set the Time-per-point.
4. In the Temperature Control Unit panel , set the measurement Temperature: click into the Target

input field, adjust the temperature value and click Set to confirm.
5. In the Sequencer panel , tick the Repeats check box. Set the repeats number and adjust other

acquisition settings as required.
6. After configuring the acquisition settings, save them as a template. Enter a new name to create a

new template or the name of an existing template to create a new revision of this template.

To use a configuration of settings for spectral acquisition during an automated measurement they must
be saved as a template which is then selected in the Chirascan Autosampler  software. A
configuration does not have to be saved as a template if used for manual measurements .
An existing template can be loaded by choosing File → Open… in the menu. Default settings can be
loaded in the SCP by choosing File → New in the menu.

The choice of acquisition settings  depends on sample requirements.

6.3.2 Preparing the Microplate

6.3.2.1 Sample Preparation

Excess dissolved gas should to be removed and any particulates spun down before buffer and sample
are loaded into a microplate.
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1. Remove excess dissolved gas by using a vacuum pump or similar. 

This step is required to prevent formation of bubbles during measurements that might result in improper
loading of the flow cell. It is recommended that this step is always performed, but it is crucial, in
particular, if measurements are to be performed above room temperature. This step should be done
before loading a microplate, as otherwise small bubbles formed upon removal of excess gas are difficult
to remove from wells. However, a loaded plate can be subjected to removal of excess gas if a plate
centrifuge is available for subsequent removal of bubbles.

Remember that solubility of most gases in water is higher the lower the
temperature.

2. Inspect the sample and, if any particulates are present, spin them down by centrifugation.

Removal of excess gas should be carried out before spinning down particulates by centrifugation, as
diffusion of gas back into the sample is usually a much slower process than resuspension of
particulates.

6.3.2.2 Loading Sequence

To ensure reproducibility and independence of sample replicates, the following guidelines for
microplate  loading are recommended:

· Every sample well should be preceded with a corresponding buffer well, to 
o confirm the absence of cross contamination.

o remove a possible effect of baseline drift.

o prevent cross correlation in statistical data analysis of multiple replicates.

· If more than one sample is examined, the loading sequence should alternate between different
samples, to minimize effects of storage time bias. 

This way each row of the microplate can contain up to 4 buffer/sample pairs. If your sample number is
not divisible by 4, you might find it easiest to leave some wells empty to allow for a clearly arranged
pipetting scheme where all samples of the same type are in the same column (Figure 4). If you do this,
make sure that the rows for the empty wells are not populated on the spreadsheet of the Wells View .
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12 B5 S5 B6 S6 B7 S7
Replicate 6

11 B1 S1 B2 S2 B3 S3 B4 S4

10 B5 S5 B6 S6 B7 S7
Replicate 5

9 B1 S1 B2 S2 B3 S3 B4 S4

8 B5 S5 B6 S6 B7 S7
Replicate 4

7 B1 S1 B2 S2 B3 S3 B4 S4

6 B5 S5 B6 S6 B7 S7
Replicate 3

5 B1 S1 B2 S2 B3 S3 B4 S4

4 B5 S5 B6 S6 B7 S7
Replicate 2

3 B1 S1 B2 S2 B3 S3 B4 S4

2 B5 S5 B6 S6 B7 S7
Replicate 1

1 B1 S1 B2 S2 B3 S3 B4 S4

A B C D E F G H

Figure 4: Typical microplate preparation for six replicates of seven samples. S1 to S7 are samples 1 to
7 and B1 to B7 are the corresponding buffers. 

The sample volume  required for each well depends on the path length  used.

If you are intending to use Applied Photophysics’ HOS Comparison Suite software, at least 3 replicates
(i.e. buffer/sample pairs corresponding to two microplate wells each) are required for proof-of-principle,
while 5 or more replicates are required for a rigorous statistical analysis.

1. Pipette buffer and samples into wells according to your pipetting scheme.
2. Check wells for bubbles and remove any bubbles found, e.g. by carefully tapping the microplate.
3. Cover microplate with pierceable film or cover.
4. Place microplate on rack holder and attach retaining clips .
5. Close the door of the autosampler enclosure.
6. Prime system by running PrimeSystemQuick script in the Autosampler section of the Actions

panel .

6.3.3 Setting an Autosampler Procedure

After preparation of a microplate, the liquid handling procedure for the autosampler must be set-up. 

1. In the Rack Stage  window of Chirascan Autosampler , select all the wells that will be used
during the measurement. Selecting wells  is most easily done by dragging boxes around wells to
be selected using Shift-Left-click. Selected wells will appear yellow.

2. Populate the Wells View  spreadsheet.

For each selected well, a row in the Wells View  will appear labeled with its corresponding well ID .
The spreadsheet in the Wells View  must be populated with the experimental parameters for each
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well. This can be done either directly, or by importing or opening  an existing spreadsheet using the
corresponding toolbar buttons. Providing an entry for the columns  that can be populated in the Wells
View  is mandatory for some of them.
Only existing templates and methods can be selected from the corresponding dropdown lists in the
spreadsheet cells. If you require methods that are more sophisticated than the default methods, please
contact  Applied Photopysics Customer Support. Not all rows need to be populated; if the row for a
well is empty, that well will be ignored. 

As an example, a spreadsheet used for obtaining far-UV spectra of lysozyme is shown in Figure 5. Once
populated, it is recommended that the spreadsheet is exported  for later reference.

Figure 5: Spreadsheet populated for obtaining example Lysozyme far-UV spectra

6.3.4 Starting and Running an Autosampler Procedure

Check once more that:

· The correct cell cartridge is inserted, and coordinates  have been set.
· The instrument has been purged  and there is enough nitrogen for the duration of the measurement.
· The lamp is on, the reservoir bottles  are filled sufficiently, and the waste containers  are empty.
· All settings for spectral acquisition have been configured  correctly in the template used.
· The microplate is in place  and temperatures of microplate racks have been set  correctly.
· The Wells View spreadsheet has been populated  correctly.

Once everything is ready, select Experiment → Start Experiment from the Chirascan Autosampler
Experiment menu  to start the autosampler procedure. Follow the current status of the autosampler
with the Robot Methods Activity View tab . Sampled wells will be colored blue in the Rack Stage
tab.

Once the autosampler procedure is completed, select Experiment → Stop Experiment from the
Chirascan Autosampler Experiment menu .

6.4 Basic Data Analysis

Likewise to data acquisition with the Chirascan Q100, data analysis including averaging of repeat scans
and baseline subtraction is usually carried out in an automated manner as described below. However,
data analysis can also be carried out manually  if required, for example, if a small number of
measurements have been performed in Manual Mode .

Automated data analysis is carried out by using AverageAll  in the data section of the Actions
panel .
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The Datastores to be analyzed are defined by the current contents of the Experiment Result Folder
and Experiment Result Filename columns of the Wells View . Therefore, if the spreadsheet does
currently not already reference the data to be analyzed, populate it accordingly:

1. Import a spreadsheet into the Wells View  that provides the reference to the data to be analyzed in
the Experiment Result Folder and Experiment Result Filename columns.

2. Make sure that in the autosampler procedure every sample well was preceded by a well the name of
which contains the keyword buffer.

3. Click AverageAll  in the data section of the Actions panel .

Automated buffer subtraction requires correct matching of buffer and sample wells. This is achieved by
AverageAll  by assigning to each sample well the buffer well that is preceding the sample well most
closely. Buffer wells are identified by their name, which must contain the keyword buffer (note this is not
case-sensitive).
If the naming convention required by AverageAll  was not followed, automated data analysis might still
be possible using AverageAlternating . AverageAlternating  does not require specific naming of
buffer wells, but requires buffer and sample wells to alternate in the procedure, starting with a buffer well.

The automated data analysis creates processed data in two locations:

· In the location of the input Datastores processed DataStores are created the names of which are
appended by a ‘p’.
· In ..\Documents\My Data five CSV output files (comma separated values) are created (i.e. the

Documents directory being that of the current Windows user).

The output DataStores include averages of repeat spectra, standard deviations (buffer), and baseline-
corrected spectra (samples).

All CSV output files contain data for all samples against wavelength. Each row of data is followed by an
accompanying row with standard deviations derived from the corresponding set of repeat scans. Two of
the CSV output files (UncorrectedCD.csv and UncorrectedAbs.csv) contain the uncorrected CD and
absorbance data, while two files (CD_SamplesBaseCorrect.csv and Abs_SamplesBaseCorrect.csv)
contain the averaged and baseline-corrected CD and absorbance data. The fifth file (Gfactor.csv)
contains data converted to G-factors (CD divided by absorbance at each wavelength).

143

143

142 139

142

142

142 142



Hardware

3939



40

Chirascan Q100 User Manual 
 
                                                                                                                   © 2023 Applied Photophysics Limited

Hardware

7 Hardware

This Chapter describes the Chirascan Q100 hardware, covering the general layout of the spectrometer
and autosampler, the electrical and purge gas connections, and the detector and light source and their
removal and replacement, the temperature controllers and the liquid handling components.

7.1 The Spectrometer Layout

Figure 6: The spectrometer layout

There are two sections to the Chirascan Q100: the spectrometer to the left and the autosampler to the
right.

The spectrometer consists of the lamp housing on the left and the monochromator with accompanying
optics and electronics in the center. A temperature-controlled sample chamber and a light sensitive
detector are located at the lower left of the autosampler. The lamp housing and monochromator /
electronics sections have removable covers fitted that can be easily removed for servicing.

The spectrometer  uses a 150-watt air-cooled xenon arc lamp as the light source and a solid state Large
Area Avalanche Photodiode (LAAPD) detector, which is both more sensitive and has a broader
wavelength operating range than a conventional detector.

7.2 The Front Panel

The front panel of the spectrometer consists of the lamp panel on the left and the system panel on the
right (Figure 7).
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Figure 7: The front panel, including lamp panel (left) and system panel (right)

The lamp panel contains a black rocker switch for the Lamp power and a red light-emitting diode (LED)
that is illuminated when lamp power is switched on. The lamp panel also contains a counter showing the
Time in hours of lamp operation since the last reset. The counter can be reset to zero by pressing the
Reset button using an object with a diameter of 2 mm. The red Start button on the lamp panel allows to
ignite the lamp if the ANMS  is not used.

The system panel contains a black rocker switch for the System power and a green Status LED that is
illuminated when the instrument is powered on. The system panel also contains red LEDs labelled Tx
and Rx which will illuminate when commands are being transmitted or data is being received,
respectively.

System, lamp and autosampler can be kept switched on permanently. These instrument components
can be switched on and off independently.

As the ANMS  is usually used to control lamp ignition, the lamp power switch should be switched on
at all times during normal operation and only be switched off for maintenance purposes such as lamp
replacement .

7.3 Electrical Connections

The Chirascan Q100 is powered by the mains electricity supply which can
produce an electric shock leading to serious injury or death. Do not connect or
disconnect electrical leads to the mains supply unless the supply is powered
off at source. Exercise care during operation and do not operate units with
their covers removed. In the case of emergency, switch off the system at
mains power outlet / switchboard. For reconfiguration or maintenance, switch
off the system power supply unit before disconnecting any cables.

Ensure all communications and electrical connections are made and any
jackscrews (if present) are tightened before powering on the spectrometer.
Operate the spectrometer using only the cables provided. Never operate a
spectrometer or any peripherals such as the Peltier controller with damaged
cables.
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The metal components of the spectrometer can produce an electric shock
leading to serious injury or death if they are not earthed (grounded). The
design of the spectrometer provides protection against electrical shock by
earthing appropriate metal components. This protection will be lost unless the
power cable is connected to a properly earthed outlet. It is the user’s
responsibility to ensure that a proper earth connection can be made.

The electronic circuitry used in the spectrometer is very sensitive and must be
correctly earthed (grounded) to avoid electrical interference. It is the user’s
responsibility to ensure that a proper earth connection can be made.

The spectrometer has three electronics units mounted above the monochromator. When viewed from the
rear of the spectrometer with the back panel removed, the lamp electronics unit is to the right, the
monochromator electronics unit to the left, and the ANMS  unit is above. Each unit requires a mains
electricity supply at the local voltage. Figure 8 shows the mains connections from the rear of the
spectrometer (the spectrometer back cover has been removed for clarity).

Figure 8: Rear of the spectrometer showing the three mains connections

7.4 Nitrogen Purging

The interaction between UV light and oxygen leads to the formation of ozone,
a very reactive gas that is damaging to health and may cause deterioration of
the optical components of the instrument. It is essential that the spectrometer
is thoroughly purged with nitrogen before the lamp is powered on.

Upon normal operation, the Chirascan Q100 is purged with nitrogen gas, which
can act as an asphyxiant—high levels of nitrogen gas in the operation
environment may cause hazard due to oxygen depletion (atmospheric
concentration below 19.5%). Therefore, safety measures (i.e., ventilation,
oxygen monitoring etc.) that take into account site-specific constraints (e.g.,
room size, altitude, experimental regimen etc.) must have been established
upon commissioning of the system (on-site risk assessment) and be
continuously maintained to ensure safe oxygen levels. It is highly
recommended to operate an oxygen monitoring device in close proximity to
the instrument at all times where risk of oxygen depletion is evident, and it is
the user's responsibility to ensure that any operators of the Chirascan Q100
understand function of such a device. If nitrogen purging must be stopped in
case of emergency (e.g., if ventilation cannot be maintained), nitrogen flow
must be cut off by closing the mains gas outlet at the operation site.
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In its standard setup, the flow of nitrogen purge gas to the Chirascan Q100 is controlled by the Active
Nitrogen Management System (ANMS). It monitors purge gas flow, sets optimal flow rates, and reduces
overall purge gas consumption by allowing for scheduled purging. If your spectrometer has an older
setup without ANMS, please consult its original manual.

By purging the system with nitrogen, oxygen is excluded from the spectrometer. This is important
because the xenon arc lamp used with the spectrometer emits high intensity UV light which interacts
with oxygen to form ozone (Equation 2).

3O
2(g)

 + uv → 2O
3(g)

(2)

Ozone is a highly reactive gas that is damaging to health and to the optical components of the
spectrometer. It has a strong and broad absorbance peak at about 250 nm, and a further broad peak at
about 600 nm, so it attenuates the light from the spectrometer lamp across a large part of its wavelength
range, particularly in the UV region. 

Purging the sample chamber completely after it has been left unpurged is a
slow process. Therefore, it is recommended to purge overnight if the system
has not been in use for an extended period. Insufficient purging of the sample
chamber can result in an absorbance artefact at wavelengths below 200 nm,
which disappears over time with continued purging.

Purging with low-purity nitrogen may introduce oxygen to the system and thus
fail in eliminating the detrimental effects of ozone formation. Usage of low-
quality nitrogen may result in contamination of the system with organic
impurities or humidity. Never use the system without the filter installed.

The nitrogen should be 99.998% pure (which corresponds to 20 ppm of gaseous contaminants, or grade
N5.0 or higher), and may be supplied by a cylinder, Dewar, or nitrogen generator, and should be
regulated to 4 to 8 bar (58 to 116 psi). The connection to the spectrometer is through the 6-mm diameter
white tubing supplied with the spectrometer, which connects at the rear of the spectrometer. This
regulator is set to 4 bar (58 psi), and this setting should not be altered. 

It is also essential that the nitrogen used to purge the instrument is clean. Any trace organic impurities
from the nitrogen supply could deposit on the internal optical surfaces of the spectrometer and, thus,
need to be removed from the nitrogen stream. To this end, a combined molecular sieve (13×) and
activated charcoal filter is integrated in the instrument. It is recommended that this filter is replaced
whenever the lamp is replaced. Figure 9 shows the main components of the nitrogen purge gas flow (the
spectrometer front cover has been removed for clarity).

To allow for purging of the system, the instrument must be connected to an
external nitrogen supply. As pressurized nitrogen jets may cause injuries to
skin, eyes, and ears, and propel objects, care must be taken to avoid potential
harm due to high pressure release (e.g., regular inspection of pipework and
fittings). A valve must be installed close to the instrument allowing quick shut-
off of flow from the external nitrogen supply in the case of an emergency (e.g.,
if ventilation cannot be maintained and there is increased risk of oxygen
depletion).

After passing through the filter, the nitrogen enters a solenoid box, which is split three ways. Each outlet
of the solenoid box leads to a solenoid fitted with a flow meter and from there the nitrogen is taken in
washed steel tubing to the three purge inlet ports on the spectrometer, at the lamp housing, the
monochromator and the sample chamber.
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Figure 9: Components of the nitrogen purge gas flow

As the ANMS  software is usually used to control lamp ignition, the lamp power switch on the front
panel  should be on at all times. Note that the Start button on the front panel allows for lamp ignition if
the ANMS is not used.

The Chirascan Q100 must not be used if any displays, indicators (e.g., for
lamp status and sample temperature) or warning devices (e.g., nitrogen alarm
system) are not operable.

To confirm correct operation of the nitrogen alarm, the system should
occasionally be subjected to a power cycle. This will sound the alarm if it is
functional.

Insufficient nitrogen flow to the system (e.g., if the external nitrogen supply runs out) will be detected and
raise an audible alarm which will be active for 10 min. If adequate nitrogen flow cannot be restored within
this grace period, the lamp will automatically be shut off to prevent harm due to prolonged ozone
formation.

7.5 Light Source

The light source of the Chirascan Q100 is a 150-watt xenon arc lamp that
produces intense UV radiation that can be harmful to skin and eyes and may
even impair eyesight permanently. Do not allow the skin to be exposed to UV
radiation. Never look directly at the light source. Do not power on the lamp
unless it is correctly mounted in the lamp housing. Do not remove the lamp
system cover and do not open the lamp housing while the lamp is operative,
as indicated by the yellow lamp system cover indicator. Do not attempt to
remove the UV filter of the lamp housing port. Do not attempt to remove the
Single Cell Peltier Holder or any accessory that replaces it unless the lamp is
powered off or the lamp shutter is closed.

Xenon arc lamps have a high internal pressure and can burst, particularly when
hot, causing injury to the user and bystanders. Do not open the lamp housing
immediately after it is powered off. Handle carefully, do not submit the lamp to
shock, and wear eye, full face (shield / visor), and body protection, including
full arm covering. Do not touch the glass bulb of the lamp with bare hands.
When handling lamps, ensure that others are restricted from entering the area
or wear protective personal equipment as well. If not installed, always store
and transport lamps (old or new) only in safety metal cases provided by
Applied Photophysics to guard against implosion.
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The lamp is at high temperature during operation. Do not remove outer lamp
system cover while the lamp is on. Surface temperature of the lamp unit
housing exceeds 50°C during operation, imposing risk of burns, DO NOT
TOUCH. After powering off, allow lamp housing temperature to decrease until
cool to touch (at least 30 minutes) before removing the lamp.

The Chirascan Q100 must not be used if any displays, indicators (e.g., for
lamp status and sample temperature) or warning devices (e.g., nitrogen alarm
system) are not operable.

While health and safety information in this user manual covers important
provisions related to operation of xenon lamps with the Chirascan Q100, the
user must refer to the lamp manufacturer's guidance and safety instructions for
complete understanding of risks and dangers associated with such lamps and
required precautions.

The light source used with the spectrometer is an air-cooled, 150-watt xenon (Xe) arc lamp. The low
wavelength radiation produced by this lamp is responsible for the conversion of oxygen to ozone, and the
lamp should only be used with nitrogen purging. The lamp housing includes a port fitted with a UV filter
that connects by a light guide to the lamp system cover indicator, which emits yellow light when the
lamp is installed and lit, and lamp status is displayed in the Manual Display and Control  screen of
the ANMS software.

Mercury-xenon lamps contain several milligrams of mercury, which can be
harmful upon acute exposure. Inhalation of elemental mercury may cause
respiratory, central nervous system, and cardiovascular effects, renal damage,
and gastrointestinal disturbances. Should the lamp break while hot, ensure
that all personnel leave the surrounding area at once, then ensure thorough
ventilation of the area and prevent access to the area until safe re-entry is
possible. In case of cold lamp rupture, remove mercury spills with adhesive
tape or paper, or using a syringe, transfer waste into a container for disposal
and seal tightly. Mercury is considered toxic and, therefore, mercury-xenon
lamps must be treated as hazardous waste and be disposed of in accordance
with local regulations. 

The performance of xenon arc lamps shows some deterioration over time. It is
recommended that the lamp is replaced after 1000 hours of use.

The housing is designed for the lamp to be easily removed and replaced , without the need for
realignment or refocusing. The spectrometer lamp panel  contains a counter showing the number of
hours of lamp operation which should be reset when the lamp is exchanged for a new one.

7.6 Detector

The large area avalanche photodiode (LAAPD) detector supplied with the
Chirascan Q100 operates at high voltages and can produce an electric shock
leading to serious injury or death. Do not connect or disconnect the detector
from the spectrometer unless the spectrometer is powered off or detector high
voltage is set to zero via the Zero HV button in the shutter / attenuator panel
of the Chirascan Control SCP.
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Never operate the lamp of the Chirascan Q100 with an open CD detector port.
If the detector must be removed, e.g., for replacement, shut off the lamp
beforehand.

The Chirascan Q100 uses a large area avalanche photodiode (LAAPD) for CD detection with an
operating range from below 163 nm to 1150 nm. The CD detector is mounted on the transmission port in
line with the light beam and a CCD Emission Fluorometer (optional) can be installed on the port
perpendicular to the beam. The CD detector can easily be replaced if required, though this may only be
done by or under supervision of Applied Photophysics engineers..

7.7 The Autosampler

The moving parts of the autosampler could cause serious injury to the user or
damage to the instrument. For safe operation the moving parts are contained
within an enclosure fitted with an interlock device, which is engaged while the
autosampler is operating. Do not attempt to open the enclosure door upon
autosampler operation or to override the interlock device. In some
circumstances, for example when manually adjusting the position of the probe,
it may be possible to move the autosampler arm using the autosampler
software while the enclosure door is open. Do not use the software to move
the autosampler arm while the enclosure door is open. Do not operate the
autosampler without the removable panels at the lower front, side and rear in
place. Do not introduce any object through the brush panel ports on the rear of
the autosampler while the autosampler is operating.

The principle of operation of the autosampler is straightforward: a probe, mounted on an autopositioner
with individual linear drives along three axes, takes up (aspirates) a sample from a well in a microplate,
and transports it to a sample cell. The sample is dispensed into the cell, and the required spectroscopic
measurements are made as on a manual instrument (Chirascan VX or Chirascan V100). The sample is
then flushed from the cell, the cell and probe are cleaned, and the procedure is repeated for the next
sample. It is also possible to recover the sample; however, this should only be considered if the samples
is known to be resistant to photolysis.

The cell  is mounted in a cartridge  that can easily be installed on and removed from the
autosampler.
 
In the standard configuration, there are positions for up to two microplates: each plate contains 8 × 12
(96) wells, giving a maximum of 192 wells. Samples are usually loaded into the wells manually, for
example using a displacement pipette, before the microplates are installed on the autosampler, although
the facility exists for samples and buffers to be aspirated from auxiliary stages, for operations such as
dilutions and titrations.

The experimental procedure  is set up on a spreadsheet , with a row for each well. The
experimental details for each well are entered on the spreadsheet, i.e. the sampling and cleaning
procedures and the acquisition settings, together with the DataStore names and locations for saving
results. The acquisition settings are configured and stored as experimental templates . 

For safe operation, the moving parts of the autosampler are contained within an enclosure  fitted with
an interlock device.
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7.7.1 The Enclosure

The moving parts of the autosampler could cause serious injury to the user or
damage to the instrument. For safe operation the moving parts are contained
within an enclosure fitted with an interlock device, which is engaged while the
autosampler is operating. Do not attempt to open the enclosure door upon
autosampler operation or to override the interlock device. In some
circumstances, for example when manually adjusting the position of the probe,
it may be possible to move the autosampler arm using the autosampler
software while the enclosure door is open. Do not use the software to move
the autosampler arm while the enclosure door is open. Do not operate the
autosampler without the removable panels at the lower front, side and rear in
place. Do not introduce any object through the brush panel ports on the rear of
the autosampler while the autosampler is operating.

The autosampler usually uses acetone (propanone) as a cleaning agent.
Acetone liquid and vapor is highly flammable and must be kept away from
sources of ignition. Vapor can form explosive mixture with air and ignition by
static discharge is possible. Appropriate fire safety provisions (e.g., fire
extinguishers) must be available on-site. Acetone is volatile and harmful upon
inhalation - it must be ensured that measures for venting acetone fumes from
the top of the autosampler enclosure are in place. For other hazards
concerning acetone and other cleaning agents, see the supplier’s material
safety data sheet (MSDS).

The moving parts of the autosampler are contained within an enclosure, with an interlock fitted which is
engaged while the autosampler is operating (Figure 10). The autosampler cannot be operated unless the
enclosure door is closed, and the interlock is engaged, and the enclosure door cannot be opened until
the operation is complete.

Figure 10: The autosampler enclosure front view with the door closed (left) and open (right)

If the autosampler develops a fault with the interlock on, the interlock can be overridden. If you need to
do so, please contact  Applied Photophysics Customer Support.

An autosampler stop button is located on the lower front panel of the autosampler enclosure (Figure 10).
Pressing this button will cause all autosampler activity to stop immediately, but will not cut the mains
electricity supply.
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An access panel is located at the lower front of the autosampler enclosure (Figure 10) which can be
removed to gain access e.g. for installing the CCD Emission Fluorometer and connect it to the port at
the back of the sample chamber  (Figure 11).

The autosampler mains power on/off (I/O) switch is located on the rear of the main electronics box,
which is suspended beneath the platform containing the microplate racks. Access is through the right
brush port (Figure 11).

Figure 11: The autosampler enclosure rear view with the back panel present (left) and removed (right)

7.7.2 The Sample System

The probe used for aspiration and dispensing is mounted on an autopositioner arm with individual linear
drives along three axes (x, y and z), as shown in Figure 12. When viewed from the front, the x-axis of the
autopositioner is left to right, the y-axis rear to front and the z-axis down to up. The autopositioner drive
can be overridden through the software to allow the probe to be positioned manually for calibration  of
coordinates.

The main components of the autosampler sample system are indicated in Figure 12. The functions of the
components are described in later sections of this user manual.

Figure 12: The main components of the autosampler
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7.7.3 The Flow System

The system that controls the flow of samples and cleaning agents in the autosampler consists of two
unconnected sets of flow lines, one upstream of the probe, the other downstream of the probe.

Those parts of the autosampler that come into contact with the sample
consist of chemically resistant materials used in similar applications. Please
note that Applied Photophysics cannot accept responsibility for damage to the
autosampler caused by interaction of these parts with user sample. If you are
in any doubt, please contact  Applied Photophysics Customer Support.

7.7.3.1 The Upstream Flow System

A schematic of the flow system upstream of the probe is shown in Figure 13.

Figure 13: Schematic of the flow system upstream of the probe

In Figure 13 the control flow line is shown in green and the three cleaning flow lines in blue (water),
yellow (detergent) and gray (organic solvent). The line common to the control and cleaning circuits is
shown in red. The connectors on the autosampler use the same color convention.

The main components of the upstream flow system are: 

· Modular, digital 1-mL syringe pump, used to aspirate and dispense measured quantities of sample,
driven by a 3000-step stepper motor.
· 2-port non-distribution valve connected to the syringe pump: it connects the syringe to either inlet (I) or

outlet (O); a third position of bypass (inlet to outlet) is not used. 
· 6-port distribution valve. The C (common) port is connected to any one of 6 ports labelled 1 to 6

anticlockwise (counterclockwise).
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· 3 single-direction diaphragm pumps. 
· 4–way connector between the water diaphragm pump and the 6-port valve.
· Reservoirs for the control and cleaning fluids (water is used as both control and cleaning fluid).

The flow tubing is 1/16 inch (≈1.6 mm) outer diameter, 0.04 inch (≈1 mm) inner diameter PTFE
microtubing.

7.7.3.2 The Downstream Flow System

Regularly assess liquid levels of waste containers and empty after each
experiment to prevent overflow and spill hazard. Place vessels in a tray at all
times to contain any spills or inadvertent overflow.

A schematic of the flow system downstream of the probe is shown in Figure 14.

Figure 14: Schematic of the flow system downstream of the probe

In Figure 14, the line upstream of the 3-way solenoid is shown in blue, the gravity drain from the solenoid
in green, the vacuum line in red, the gravity drain from the wash station in yellow, and the vent line in
gray.

The main components of the downstream flow system are:

· Cell cartridge containing the sample cell, which mounts into a sample chamber.
· 3-way solenoid with a vent port that can be set open or closed.
· Diaphragm vacuum pump.
· Wash station with a drain position and wash position.
· Gravity fed waste vessel at atmospheric pressure.
· Vacuum waste vessel at lower than atmospheric pressure.
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The flow tubing between the injection port and flow cell, and the flow cell and 3-way solenoid is PTFE
microtubing, the remaining tubing is Tygon 2075 Ultra Chemical Resistant tubing.

7.7.3.3 Sample Aspiration and Dispensing

The moving parts of the autosampler could cause serious injury to the user or
damage to the instrument. For safe operation the moving parts are contained
within an enclosure fitted with an interlock device, which is engaged while the
autosampler is operating. Do not attempt to open the enclosure door upon
autosampler operation or to override the interlock device. In some
circumstances, for example when manually adjusting the position of the probe,
it may be possible to move the autosampler arm using the autosampler
software while the enclosure door is open. Do not use the software to move
the autosampler arm while the enclosure door is open. Do not operate the
autosampler without the removable panels at the lower front, side and rear in
place. Do not introduce any object through the brush panel ports on the rear of
the autosampler while the autosampler is operating.

The flow tubing, probe and other components of the flow circuit are designed to give long-term
continuous service without the need for replacement. However, the flow tubing and probe can be
replaced  by the user if necessary.

Sample aspiration and dispensing are controlled by the syringe pump in the upstream flow system. The
control system is shown in green and red in Figure 13 and is bi-directional. The syringe-pump valve
opens to the water reservoir when set to I. Water is collected from the reservoir on the syringe
downstroke, for the upstroke the syringe pump valve switches to O, and the 6-port valve to 2, and the
water is passed into the control line, shown in green in Figure 13. In this way the direction of flow and
amount of water in the line can be controlled. 

Sample can therefore be aspirated or dispensed by controlling the direction of flow of the water. In
normal operation, the line and probe are filled with water, then a small plug of air is aspirated, followed by
a small sacrificial conditioning volume of sample, a second plug of air, the main sample and finally a
third plug of air. The reason for the first and second (conditioning and leading) air gaps and the
conditioning sample is to isolate the main sample from the control fluid, to prevent dilution or
contamination. The final (travel) air gap is to prevent the sample leaking from the probe during transport
to the cell. This is shown schematically in Figure 15. 

Figure 15: Schematic of the sample and air gaps

Parameters such as the sample and airgap volumes and aspiration and dispense rates are set on the
Hardware  tab of the Autosampler software.

As the pipette volume is 1 ml and the stepper motor has 3000 steps, the sample volume can be
controlled to a precision of one third of a microliter. 
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If a closed flow cell is installed, the sample is injected through an injection port that connects to the
lower port in the cell. If an open flow cell is installed, the sample is injected directly into the cell. For
sample injection, the 3-way solenoid in the downstream circuit is set to connect the cell to the gravity
fed waste vessel, with the solenoid air port set to open.

7.7.3.4 Automated Cell Cleaning

The autosampler usually uses acetone (propanone) as a cleaning agent.
Acetone liquid and vapor is highly flammable and must be kept away from
sources of ignition. Vapor can form explosive mixture with air and ignition by
static discharge is possible. Appropriate fire safety provisions (e.g., fire
extinguishers) must be available on-site. Acetone is volatile and harmful upon
inhalation - it must be ensured that measures for venting acetone fumes from
the top of the autosampler enclosure are in place. For other hazards
concerning acetone and other cleaning agents, see the supplier’s material
safety data sheet (MSDS).

The cleaning fluid flow lines are shown in blue (water), gray (volatile, water miscible organic solvent) and
yellow (detergent) in Figure 13. The line shown in red is common to the control and cleaning fluids.
Usually the solvent is acetone, and the detergent a 10% solution of Decon 90 (non-US countries) or
Contrad 70 (US).

The cleaning fluid lines are unidirectional, and flow is controlled by separate diaphragm pumps, not by
the syringe. The default protocol for the cleaning cycle for the control line, probe and flow cell is as
follows: 

1. Clear the cell contents to vacuum waste.
2. Flush the control line and probe with water (6-port valve set to 5).
3. Flush the control line, probe and cell with detergent (6-port valve set to 4).
4. Flush the control line, probe and cell with water (6-port valve set to 5).
5. Flush the control line, probe and cell with organic solvent (6-port valve set to 6).
6. Flush the control line and probe with water (6-port valve set to 5 then 3), leaving water in the line to

act as the control fluid for the next sample.

The reason for the water connections to the 6-port valve ports 1, 3 and 5 is to prevent cross
contamination between the organic solvent and detergent (which could result in precipitation), as the
valve must pass across a water port when moving between them; and to avoid contamination of the
control line by organic solvent or detergent, as the valve must pass across a water port when moving to
port 2 (the connection to the syringe pump).

Probe cleaning is performed with the probe tip within the wash station, which has two positions: the
drain position at the back, which is an opening connected to the gravity-fed waste vessel, and the wash
position at the front, which is a closed trough with an overflow to the drain position. 

Each cleaning cycle of control line and probe is performed twice, first with the probe tip in the drain
position, to clean the inside of the line and probe, and then with the tip within the wash position, to rinse
the outside of the probe tip, that might have been in contact with the sample during aspiration.

The various cleaning and rinse fluids drain under gravity to the gravity fed waste vessel, except after the
cell has been flushed with organic solvent, in which case the 3-way solenoid is set to connect the cell to
the vacuum pump with the solenoid vent port closed, and a vacuum is applied to remove the organic
solvent and dry the cell.
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The standard cleaning protocol described above is not suitable for all samples.
For example, some samples may be insoluble in water except in the presence
of solubilizing agents or pH adjusters, in which case the cell will need to be
flushed with the appropriate solution before flushing with water.

7.8 Temperature Control

Depending on the target measurement temperature, the autosampler cartridge
and cell may be very hot or cold, causing injury to the user when touched.
Ensure that they have been allowed to reach a safe temperature before
handling or use protective equipment (e.g., thermally protective gloves) if their
insertion or removal at extremely high or low temperature is required. Carry out
risk assessment and consider additional personal protective equipment if in
doubt.

Depending on system configuration and experiment design, target

measurement temperature can reach between -20°C and 105°C. Extra care

should be taken when handling a potentially hot/cold cell as the target

measurement temperature is actively set through computer control and
monitored only via the Peltier controller display or the control software. As
unsafe temperatures cannot be identified otherwise (e.g., after hard- and
software is switched off or fails), the Chirascan Q100 may only be used by, or
under supervision of, trained laboratory personnel familiar with this user
manual and the risks associated with usage of the system and related
procedures, particularly when conducting experiments at elevated sample
temperatures.

The Peltier effect is used to raise or lower the temperature of the sample chamber and microplate racks:
when a current is made to flow across the junction of two dissimilar electrical conductors, the result is
an increase in temperature on one side of the junction, and a decrease in temperature on the other. If the
current is reversed, the direction of the thermal gradient will also be reversed. Unlike resistive heating,
the Peltier effect can therefore be used for both heating and cooling. 

To maintain the temperature gradient, the current must also be maintained, meaning that electrical
energy must be continuously supplied to the system, resulting in the generation of heat which must be
removed. Circulating water  is used for this, but it is important to remember that the circulating water
is not controlling the temperature of the system, it is only removing excess heat, and the temperature of
the circulating water does not need to be controlled accurately.

For measurements at elevated temperatures, subject any aqueous buffer or
samples to removal of excess dissolved gas (e.g., using a vacuum pump
connected to a desiccator) to prevent bubble formation in the cell (and to
remove oxygen), particularly when performing temperature ramps.

7.8.1 Sample Temperature Control

The sample temperature is read by a in-sample temperature probe positioned in the sample chamber,
and the temperature is controlled to this temperature probe readout by a Peltier device embedded in the
sample chamber in close thermal contact with the sample cell.

The Peltier device of the sample chamber is controlled by the Peltier control module shown in Figure 16
(left). The control unit will have been set up during the autosampler installation process, but connections
are shown in Figure 16 (right). Power on the Peltier Control module at the ON/OFF switch on the rear of
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the module (Figure 16) before starting Chirascan Control. The target temperature is set in the Chirascan
software on the Temperature Control Unit panel . Communication between control module and
software can be reestablished in the Chirascan software if the control module has been switched on after
starting the software.

Figure 16: The Peltier temperature control unit for the sample chamber front view (left) and rear view with
connections (right)

Do not power on the Peltier control module unless the Peltier devices have a
throughput of water, as this may cause the Peltier elements to reach
excessive temperatures and get damaged.

Note that the sample temperature may differ slightly from the target temperature, particularly at very high
or low temperatures. The Peltier device requires a throughput of water to act as a heat sink, which is
provided by a water circulator .

7.8.2 Microplate Temperature Control

Although microplate temperatures are not set to extreme values upon typical
system usage, the range of temperatures accepted by the microplate
temperature controller is from -10°C to 80°C and, thus, microplate holders may
be hot. When setting microplate temperatures, take extra care to enter safe
temperatures only.

The temperature of each microplate rack is controlled by individual Peltier devices. Like the Peltier
device of the sample chamber, these devices require a throughput of water to act as a heat sink, which
is provided by a water circulator .
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Figure 17: The Peltier temperature control unit for the microplates front view (left) and rear view with
connections (right)

The Peltier devices are controlled by the control module shown in Figure 18 (left). The module will have
been set up during installation of the autosampler, but the connections are shown in Figure 18 (right).
Note that there are six slots available on the control module: in the standard configuration, only slots 1
and 2 are used, connecting to microplate racks 1 and 2 respectively, numbered from left to right.

For full operating instructions of the microplate temperature control module see the manual supplied by
the manufacturer (Inheco) that is provided on a USB stick; only a summary is given here.

Do not power on the microplate temperature control module unless the Peltier
devices have a throughput of water, as this may cause damage to the Peltier
elements. 

Power on the microplate temperature control module using the I/O switch on its rear and set
temperatures using the display on its front. On the Main Menu (Figure 18), use the left and right arrows
to select a microplate, then press the temperature Set button on the middle right to bring up the Set
Temperature Menu.

 
Figure 18: the microplate temperature control module Main Menu (left) and Set Temperature Menu (right)
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On the Set Temperature menu, enter the required temperature and press the button that shows the
entered temperature in the top left; this will return you to the Main Menu. On the Main Menu, press the
Temp. button to confirm: the Temp. button should now be highlighted black, the target temperature
should appear on the Set button, and the Peltier device of the selected microplate should begin to
approach this temperature.

Temperatures must be set independently for each microplate rack. Typically, it is advisable to set a
temperature between 4°C and 8°C, though the optimal temperature range depends on environment
humidity and volatility of the sample. In general, too low temperatures might result in condensation within
the wells, leading to droplets on the well walls and a reduction of sample volume at the bottom of wells,
while too high temperatures might result in evaporation of the sample. However, the latter phenomenon is
mitigated by using pierceable films or covers.

7.8.3 Peltier Heat Dissipation

Circulating water flows through a heat exchanger which removes heat from the Peltier devices.
Insufficient flow will allow the temperature of the heat exchangers to rise, and if a certain cut-off value is
exceeded, the Peltier control modules will automatically stop controlling the Peltier elements. 

The water circulator must be sitting on a plane and sturdy surface, ideally on
the floor beneath the system. Make sure that tubing is routed unobstructed
and retained to prevent trip and pull hazard. Make sure tubing is regularly
inspected for leaks to prevent spills that might result in slip and trip hazard.

The standard water circulator provided with the Chirascan Q100 has fan-assisted cooling but no other
temperature control and is shown in Figure 19. Switching on the water circulator is accompanied by an
alarm sound that becomes also active if the water tubing is blocked or the liquid level is too low. Always
switch off Peltier controller and water circulator when temperature control is not required.

 
Figure 19: The water circulator (left) and circulator quick release fittings (right)

If a water circulator other than the standard one is used and is temperature-controlled, the temperature
should be set to about 5°C below the target temperature. Cooler circulating water can improve the
performance of the Peltier elements at low temperatures, whereas warmer water can improve
performance at very high temperatures.
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The circulator is connected to the inlet and outlet manifolds of the Peltier devices in the autosampler
through quick release Legris type fittings (Figure 19). Inlet and outlet of the water circulator can be
connected either way.

It is recommended to supplement the circulating water with additives such as 10% ethylene glycol to
prevent microbial growth.

To prevent the buildup of deposits such as limescale, distilled water should be
used as the circulating fluid. To prevent corrosion, a small amount (~1%) of
tap water should be added. Moreover, the addition of an anti-bacterial agent
and antifreeze is recommended, provided that these comply with the circulator
supplier’s specifications. When supplementing the circulating water with
additives, make sure to follow the chemical manufacturer's guidance on dosing
and precautions.

7.9 Sample Cells and Cell Cartridges

The sample cells are mounted in cartridges that can easily be installed on and removed from the
autosampler. The cartridges can be disassembled, and the cells demounted, but it is recommended that
this is done for cleaning purposes only.

7.9.1 The Sample Cells

Two types of flow cells can be used. For shorter path lengths (0.1, 0.2, 0.5 and 1.0 mm) closed flow
cells are used, in which the sample is dispensed through an injection port that connects to the bottom of
the cell; i.e. the sample enters the cell at the bottom and exits at the top. For a long path length (10
mm), an open flow cell is used into which the sample is dispensed directly through the top, exiting at the
bottom. In addition, the spectrometer can be used in Manual Mode  with standard cuvettes. Examples
of the two types of flow cell are shown in Figure 20.

 
Figure 20: A 0.1-mm closed flow cell (left) and the 10-mm open flow cell (right)
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7.9.2 Cell Volumes and Concentrations

The minimum volumes for each cell are given in Table 1. The volumes for cells up to 1.0 mm are for
guidance only, as the minimum volume can vary between samples. Differences in surface tension can
change the sample’s ability to wet the well surface, and can reduce the depth of the sample meniscus in
the well. To be on the safe side, use at least 200 µl for cells up to 1.0 mm if the available amount of
sample affords it. The volumes also assume a gap of 0.5 mm between the probe and the bottom of
Well 1, and a difference in gap between Well 1 and Well 96 of less than 0.1 mm.

The concentrations are typical for proteins, but protein absorbances tend to vary widely, particularly in
the near-UV region, and you should check that they give the appropriate absorbance before filling the
microplate.

Table 1: Sample volumes and typical protein concentrations for each flow cell

path length, mm Volume per well,
µl

Protein concentration, mg/ml

Far-UV Near-UV

0.1 100 1.8 -

0.2 110 0.9 -

0.5 124 0.35 -

1.0 167 0.18 8.0

5.0 600 - 1.6

10.0 900 - 0.8

7.9.3 The Cell Cartridges

The cartridges for the short path length cells, as shown on the left in Figure 21, have a port through
which the sample is injected. For the 10-mm path length open flow cell, shown in the middle in Figure
21, the sample is injected directly into the cell. A cartridge for cuvettes  as shown on the right of
Figure 21 allows for measurements in Manual Mode .

Figure 21: Cartridges for a closed flow cell (left), the open flow cell (middle) and cuvettes (right)

7.9.4 Installing Cell Cartridges

The cell cartridges fit into a lidded chamber with a stepper motor-driven shutter that slides to cover the
injection ports when the spectrometer is running (Figure 22). There are two fill ports in the lid, for the
open (front port) and closed (back port) flow cells. By default, the shutter is closed when the Chirascan
Autosampler  program is not running and open when the Chirascan Autosampler  program is
opened; it can be manually opened and closed via the Actions panel .
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Figure 22: sample chamber with the lid lowered

A cartridge is mounted into the sample chamber with the cell to the left and fixed by tightening the four
sprung retaining screws (Figure 23). There should be no need to use a screwdriver, firm finger tightness
is all that is required. A red warning light is connected to the temperature probe, and will be illuminated if
the cartridge is not seated down correctly and the autosampler is on. After installation of a cartridge, the
lid of the sample chamber needs to be closed. As positioning might be slightly different, it is
recommended to recalibrate  the coordinates of the cell injection port after changing the cell cartridge.

Although the coordinates are factory set, the position of the injection port
varies slightly, and it is suggested that recalibration is carried out if a different
cartridge is fitted, or if any position appears to have changed. Failure to do so
may result in damage to the autosampler.

Figure 23: Flow cell cartridge installed on the autosampler

A cartridge is removed from the sample chamber by following the installation procedure in reverse. The
cartridge must be lifted from the sample chamber by gripping the thumbscrews, not the exposed flow
tubing.

Depending on the target measurement temperature, the autosampler cartridge
and cell may be very hot or cold, causing injury to the user when touched.
Ensure that they have been allowed to reach a safe temperature before
handling or use protective equipment (e.g., thermally protective gloves) if their
insertion or removal at extremely high or low temperature is required. Carry out
risk assessment and consider additional personal protective equipment if in
doubt.
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Depending on system configuration and experiment design, target

measurement temperature can reach between -20°C and 105°C. Extra care

should be taken when handling a potentially hot/cold cell as the target

measurement temperature is actively set through computer control and
monitored only via the Peltier controller display or the control software. As
unsafe temperatures cannot be identified otherwise (e.g., after hard- and
software is switched off or fails), the Chirascan Q100 may only be used by, or
under supervision of, trained laboratory personnel familiar with this user
manual and the risks associated with usage of the system and related
procedures, particularly when conducting experiments at elevated sample
temperatures.

Do not attempt to lift the cell cartridge by pulling on the exposed flow tubing,
as this could cause the tubing to be released from its connectors.

7.9.5 The Cell Recognition System

All sample cell cartridges are digitally encoded with a 16-digit ID number for automatic recognition by the
autosampler. The specific parameters that are to be used with a certain cell are stored in the
autosampler memory and are set  when the cartridge is installed.

7.9.6 Removing and Replacing a Flow Cell

It is recommended that the cell is removed from the cell cartridge only if necessary for cleaning
purposes. To remove a flow cell, first remove the cartridge from the holder. Invert the cartridge and
unscrew the two caphead screws holding the lowest section of the cartridge in place (Figure 24, left),
using a 2.5 mm hexagon key. Rotate the lower part of the cartridge anticlockwise (counterclockwise) to
give access to the flow cell (Figure 24, middle).

Do not unscrew the hexalobular security screws unless instructed to do so by
an Applied Photophysics engineer, as this could cause damage to the cell.

Figure 24: Disassembly of the closed flow cell cartridge

Grip the cell, and gently slide it from the cartridge (Figure 25, right). To replace the cell, reverse the
process for removing it.
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Take care not to damage the cell tubing by stretching or kinking it while
removing the cell. 

7.10 The Microplates

7.10.1 Microplate Dimensions and Materials

The autosampler uses 96-well deep well microplates with a footprint defined by the American National
Standards Institute (ANSI) / Society for Biomolecular Sciences (SBS) document ANSI/SBS 1-2004, for
example the 2-ml round well polypropylene microplates available from Axygen Inc, California, U.S.A,
product number P-DW-20-C (Figure 25). Pierceable films and covers are also available to prevent solvent
evaporation.

Figure 25: Microplate (left) and piercable film (right)

7.10.2 Microplate Numbering

In the standard configuration, there are positions for up to two microplates. Each plate contains 8 × 12
(96) wells, giving a maximum of 192 wells: the well volume depends on the microplate type, but a volume
of about 2.0 ml is recommended. Sample is usually loaded  into the wells manually, for example
using a dispensing pipette, although the facility exists for operations such as dilutions and titrations for
the sample to be aspirated from the auxiliary stages.

The microplate racks are numbered 1 to 4 from left to right. Each well in a microplate is normally
designated by a letter for one of the 8 columns (A to H) and a number for one of the 12 rows (1 to 12)
embossed on the plate. In the Chirascan Autosampler software, the cells are identified by the Well ID,
which is a single number from 1 to 96 corresponding to wells A1 to H12 (or A12 to H1 if the Front/Rear
check box  is unticked in the Setting Up panel). The numbering of Well IDs is identical for all racks,
and wells of different racks are distinguished by their value in the Rack Name column of the Wells View
spreadsheet . Note that any wells from one rack are used during an autosampler procedure before
wells of the next rack are used. It is therefore not possible to alternate sampling of wells from different
racks.

The autosampler is normally set to sample sequentially beginning at Well 1, and the wells should be
filled correspondingly. The volume  required depends on the cell type and path length , and the
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number of replicates required. Pierceable films or covers should be fitted with their well designations
corresponding to those of the microplate.

7.10.3 Installing Microplates

Although microplate temperatures are not set to extreme values upon typical
system usage, the range of temperatures accepted by the microplate
temperature controller is from -10°C to 80°C and, thus, microplate holders may
be hot. When setting microplate temperatures, take extra care to enter safe
temperatures only.

The microplates fit over the racks, and can only be installed with the beveled corners to the right (i.e.
position A1 at the front left, H12 at the right rear). Ensure that the microplate is correctly seated down,
and held in place with the front and rear retaining clips (Figure 26).

Figure 26: Microplate seated in position with retaining cips in place
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8 Software

This Chapter describes the Chirascan Q100 software, covering the different programs  used to operate
the system.

Prolonged operation of computers and display screen equipment may cause
discomfort or even harm the user. It is the user's responsibility to carry out a
risk assessment of the system's workstation, if required, and enforce further
administrative and/or procedural measures to prevent related risks and comply
with local workplace health and safety regulations

8.1 The Active Nitrogen Management System

The Active Nitrogen Management System (ANMS) software is the interface of the ANMS  which
controls nitrogen purging of the system. After starting the software, choose the right COM port in the
drop-down menu at the upper left and click Connect to establish communications between the ANMS
software and the ANMS electronics. After initialization, the lamp and nitrogen flow rate status can be
viewed on the Monitor tab. Timings for a lamp ignition schedule can be set by the user on the
Schedule tab. All other tabs can be viewed, but are password protected, and it is recommended that
the defaults set by Applied Photophysics are not changed. For information on how to change these
settings, please contact  Applied Photophysics Customer Support.

8.1.1 Manual Display and Control

The current nitrogen flow rates are shown on the center panel on the Monitor tab (Figure 27). From left
to right the indicators show the flow rates to the lamp, monochromator and sample chamber,
respectively, in liters per minute. The flow rates are also shown numerically in the top panel to the left.
The default flow rates of 1 L/min, 3 L/min, and 1 L/min for the lamp, monochromator, and sample
chamber, respectively, are usually adequate.

Figure 27: The Monitor tab of ANMS
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To start the timed lamp ignition sequence, make sure that the lamp power switch on the front panel
is switched on and click Start Lamp Ignite Sequence. The other buttons on the two panels to the right
of this tab can be used to turn on or off the nitrogen and/or lamp without running the sequence (the
nitrogen cannot be turned off without turning the lamp off, too). The lamp status is shown in a box below
the buttons, which is green if the lamp is lit correctly and red if the lamp has not been lit correctly,
although it has been scheduled to be turned on. Green text on the buttons indicates that a connection to
the ANMS electronics has not yet been established.

8.1.2 Scheduling Purging

Timings for the nitrogen and lamp are set on the Schedule tab (Figure 28). A Startup and a Shutdown
schedule are allowed; remember to check that the scheduled Shutdown time is after the completion of
any experiments that you are running. 

To set a schedule, click Set Schedule Time, tick the check boxes for the required days (the M-F
check box activates the schedule for all work days) and set the times for the nitrogen purge to begin in
the Hours Minutes Seconds boxes which operate on a 24-hour clock. Tick the Run Once check box if
you want the schedule to be initiated once only.

Figure 28: The Schedule tab of ANMS
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8.2 Chirascan Control

This section describes the Chirascan Control program, the purpose of which is to create, edit, load and
run experimental templates and to store them securely. Chirascan Control is part of the Chirascan
software platform architecture  together with other software components.

8.2.1 Introduction

8.2.1.1 Launching Chirascan Control

If PC and spectrometer have been connected by USB, two-way communications between Chirascan
Control and the spectrometer will be established when Chirascan Control is launched. If there is no
connection between the PC and the spectrometer, Chirascan Control can be opened in Emulation Mode.
Emulation Mode can be used for creating, editing, and saving templates on a PC remote from the
spectrometer, or with the spectrometer powered off. A label in the lower right corner of the Spectrometer
Control Panel  indicates that the software has been launched in emulator mode (Figure 29).

Figure 29: Indication for Emulator Mode

Simulated data (including spectral properties, temperatures etc.) can be obtained by performing an
acquisition in Emulation Mode. An entry in the Remarks  of a Datastore will indicate that it was
obtained in Emulation Mode.

8.2.1.2 The Spectrometer Control Panel

Chirascan Control is versatile enough to cope with a wide variety of experiments while being simple to
use. It operates under Windows 10 and some earlier versions of Windows.

The software is launched by clicking on its desktop icon. The Chirascan Control spectrometer control
panel (SCP) shown in Figure 30 will appear. The layout of the SCP follows Microsoft Windows
conventions.
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Figure 30: The Spectrometer Control Panel

There are two main areas on the SCP:

· The menu bar and toolbar
· A number of panels on which information is entered and viewed
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Both menu bar and toolbar are movable and dockable, and the toolbar can be displayed or hidden by
right clicking on the menu bar or toolbar, or using the View menu .

8.2.2 Configuring Signal and Attenuator Settings

8.2.2.1 The Signal Panel and Live Display

The Signal panel (Figure 31) is used to select the mode of data collection. Three options can be
selected from the drop-down menu by default: Circular Dichroism, Absorbance and Voltage. CCD
can be selected if this accessory is fitted. Please refer to the corresponding accessory user manual for
more information about this modeof data collection. The panel changes appearance to reflect the mode
of data collection.

Figure 31: The Signal panel

Common to all modes is an oscilloscope-style live signal display (Figure 32) that can be launched by
clicking the corresponding icon in the top right corner of the panel (Figure 31). The units will be those of
the chosen measurement mode; an instantaneous value of the measurement is also displayed in the
box to the right of the drop-down menu.
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Figure 32: The Live Signal display

8.2.2.2 The Signal Panel for Circular Dichroism Measurements

The most commonly used mode of data collection is circular dichroism. When this option is selected,
the Signal panel has two sub-panels, Options and Background (Figure 31). On the Options
sub-panel, choose either delta A (delta absorbance) or millidegrees for the units of the CD
measurement. 

If the AutoPM check box is ticked, the LAAPD detector gain will be adjusted so that the detector output
is at optimum level for the electronics. This adjustment requires a short assessment of the current light
throughput preceding actual acquisition and can increase total scan time for a given data point by up to
25%. As the duration of this initial assessment depends on light throughput and light throughput
typically decreases towards shorter wavelengths, the AutoPM function typically increases scan duration
towards lower wavelengths in particular. The dependence of scan duration on light throughput also is the
main reason why the duration of an acquisition cannot be exactly predicted and the Sampling panel
provides an approximate scan time only. However, AutoPM usually increases scan time only marginally
and is recommended to be used at all times.

Tick the Absorbance check box if you wish to simultaneously record an absorbance spectrum of the
sample (recommended) but note that a background must be acquired before the absorbance can be
obtained. This is done automatically if the instrument is used in automated mode, or by using the
Background panel if doing manual measurements . It is not necessary to take a background
spectrum if only the CD measurement is required.

In CD mode, the absorbance is derived from the detector gain, which is know precisely, and the
absorbance is therefore identical to that measured in direct absorbance mode.

The Fluorescence check box is a deprecated function required for backwards-compatibility only.
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Likewise, if the CCD Emission Fluorometer is installed, a CCD check box is present in the Options
sub-panel that allows you to record fluorescence excitation and/or emission spectra if ticked. For more
information on making fluorescence measurements with the CCD Emission Fluorometer, see the CCD
Emission Fluorometer user manual.

Whereas at the beginning of autosampler procedures a background is acquired automatically, in Manual
Mode  the Background sub-panel of the Chirascan Control SCP is used to acquire a background.
Clicking on Background will initiate a background acquisition using the current settings. A Graphical
Display  in Chirascan Viewer will automatically show the CD background trace. The acquisition can
be stopped at any time by clicking Stop, which is the label that appears on Background during an
acquisition; it can also be Paused and Resumed, using the buttons in the Sequencer panel . At the
end of the acquisition, the background will be stored in the current Save to Repository  as a
DataStore, the name of which is generated by a seed name (the default seed name for background data
is ‘Base’) and a running number with leading zeros (e.g., ‘Base0001.dsx’), unless a different seed name
has been specified (Configuration → Preferences → File names, or File Names toolbar  icon). If
the DataStore name already exists, the data will be saved as a new revision. The Auto Subtraction
check box becomes enabled at the conclusion of a background scan; tick the box if you wish to
subtract the background automatically from subsequently measured spectra.

Figure 33: The Quickview - CD Baseline dialog

The Show… button is used to reinstate a previously-measured background. It calls up the Quickview -
CD Baseline dialog that enables you to load any background DataStore (Figure 33).

Click on Recall Last to reinstate the most recently measured background; click on Load… to browse
for other background files. The chosen DataStore will appear in the preview window. Clicking Smooth
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will smooth the trace, which is useful if you wish to subtract a single background from an average of a
number of spectra. Under these circumstances, smoothing prevents reinforcement of the background
noise in the final result. However, it is recommended to subtract single backgrounds from single spectra.

The Save… and Print… buttons have their usual functions. Click OK to confirm your choice and close
the dialog or Cancel to close without implementing the new background.

Calibration is used to recalibrate the CD scaling factor and requires administrator privileges to gain
access to it. It should not be necessary to use it routinely and will be disabled for the normal user.In
addition, changing the CD scaling factor is a 21 CFR controlled action . Please contact  Applied
Photophysics Customer Support if you wish to recalibrate the CD scaling factor.

8.2.2.3 The Signal Panel for Direct Absorbance Measurements

When Absorbance is selected on the Signal panel (Figure 34), the absorbance will be measured
directly, rather than derived from the detector gain as is the case when the Absorbance check box is
ticked with Circular Dichroism selected. Accurate values comparable to those obtained on a dedicated
absorbance spectrometer are obtained in both cases, but when Absorbance is selected the CD signal
cannot be measured simultaneously.

Figure 34: The Signal panel with Absorbance selected

The Options sub-panel enables you to choose between Absorbance and Transmission as the
measured variable. If the Total Fluorescence or Scanning Emission Monochromator accessory (not
longer available) is present, a simultaneous fluorescence excitation spectrum can be measured by
ticking the Fluorescence check box. For more information on making fluorescence measurements, see
the user manual of the corresponding fluorescence accessory.

The Baseline sub-panel is used when performing manual measurements  to measure a reference
background relative to which the absorbance of the sample is calculated. Ticking the Auto HV check
box will optimize the gain applied to the detector for every point in the background scan, similarly to the
AutoPM  function in CD signal mode. In absorbance mode however, these background values are
remembered and applied at each corresponding point in subsequent absorbance scans, allowing an
accurate absorbance spectrum to be recorded easily. Usage of the Baseline sub-panel is similar to that
for CD measurements.
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8.2.2.4 The Signal Panel for Voltage

This panel is intended for diagnostic purposes only and, thus, not required in the course of normal
instrument use.

8.2.2.5 The Shutter / Attenuator Panel

The light source of the Chirascan Q100 is a 150-watt xenon arc lamp that
produces intense UV radiation that can be harmful to skin and eyes and may
even impair eyesight permanently. Never have the lamp powered on, the
shutter of the spectrometer monochromator opened manually (i.e., by clicking
Open in the Shutter / Attenuator panel), and the sample chamber lid opened
simultaneously.

This part of the SCP controls the shutter/attenuator mechanism, which is essentially an aperture that
regulates the light intensity the sample is exposed to. The shutter/attenuator can be opened or closed
by clicking Open and Close, respectively. The black rectangle to the right of these buttons represents
the aperture, and the yellow circle represents its opening: the smaller the attenuator opening is the more
the black rectangle occludes the circle (Figure 35).

Figure 35: The Shutter / Attenuator panel

Click Zero HV to set the voltage on the detector to zero, for example, if you want to exchange the
detector. With zero voltage on the detector, the button will read Restore HV. Click to restore the voltage
to its previous value. 

The AutoShutter check box is ticked by default. This provides automatic opening of the shutter at the
start of a scan and closes it at the end. It also closes the shutter while waiting for the temperature to
stabilize during temperature-ramp experiments. The main purpose of Autoshutter is to minimize the
exposure time of a sample and of the optical components of the monochromator to intense radiation.

8.2.3 Configuring Acquisition Settings

A set of acquisition settings is designed to provide instructions to the spectrometer to carry out a
measurement or a series of measurements according to your requirements and is stored as an
experimental template.

Templates are created using the SCP  by entering the required acquisition settings on the
corresponding panels. 

When a template has been created it can be saved from the File menu , using either Save or Save
as…. Choosing Save as… opens the Save Experiment Template as dialog (Figure 36) that lets you
enter a template name.

If Save is used after a template has been opened and changes have been made to the current
acquisition settings, or Save as… is used and an existing DataStore name entered, the template will be
saved as a revision  of the existing template, so existing templates will not be overwritten. If Save
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as… is used and a new DataStore name entered, the template will be saved as a new template. The
revisions of existing templates can be inspected .

Note that the information stored with a template does not include DataStore names specified in the File
Names dialog  for manual measurements.

Figure 36: The Save Experiment Template as dialog

8.2.3.1 The Monochromator Panel

The Monochromator panel (Figure 37) provides access to the settings that control the operation of the
Chirascan Q100 monochromator. Here you set the wavelength range, step size and bandwidth for your
experiment; you can also move the monochromator to a specific wavelength.

Figure 37: The Monochromator panel

To drive the monochromator to a specific wavelength, use the Wavelength (nm) input box and click Set
below the box; to set the bandwidth, use the Bandwidth (nm) input box and click the same Set button.
Setting wavelength and bandwidth can be done simultaneously with a single click.

To set the wavelength range for a scan, use the Low and High input boxes to set the lower and upper
wavelength limits; use the Step input box to set the step size; all units are nanometers. Click Set to the
right of these boxes to confirm these settings. Note that the spectrometer always scans from high to low
wavelength. If discrete wavelengths or a skip-scan have been defined in the advanced monochromator
setup , the Step box will be disabled and display “---“.

To save the current monochromator settings as the default ones, use the Monochromator Scan Setup -
Advanced dialog .

8.2.3.2 Advanced Monochromator Setup

The Monochromator Scan Setup - Advanced dialog (Figure 37) is opened by clicking Adv... in the
Monochromator panel  and can be used to set the software up to perform discrete wavelength scans
or skip-scans. It can also be used to save the current monochromator settings as the default ones. To
do so, click Save As Default.
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Figure 38: The Monochromator Scan Setup - Advanced dialog

Discrete wavelength scans

Discrete wavelength scans are useful when following a change in property as a function of some
independent variable other than wavelength - temperature, for example.

To do so, select Single wavelength, specify the wavelength in the associated input box and click OK. 

It is possible to create a list of more than one discrete wavelengths. Clear the wavelength list by clicking
Clear list and then tick Append to list. Now select Single wavelength, specify the wavelength in the
input box and click on Generate list. Each time you type in a wavelength and click on Generate list,
the specified single wavelength will be appended to the list. When you are satisfied with the list of
wavelengths, click OK.
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Skip-scans

A simple wavelength range can be set in the Monochromator panel and there is no need to use the
advanced panel to set such a range. However, if you wish to carry out a more sophisticated scan, select
Wavelength range in the Monochromator Scan Setup - Advanced dialog. Clear the wavelength list
by clicking on Clear List and tick Append to list. Now specify the Start, Stop and Step values for the
first wavelength range and click on Generate list. A number of entries that correspond to your
specification will appear in the list. Repeat this procedure to append additional wavelength ranges until
you have completed the skip-scan list. In general, skip-scans are used to reduce acquisition time by
excluding wavelength ranges that are known to be unimportant for well-described samples.

Ticking the No fly-back check box will let the monochromator remain at the lowest wavelength of the
given wavelength range once reached instead of moving back to the first one. Ticking No Scan will
prevent the scan from commencing at all. Both functions are for the use of Applied Photophysics
engineers and should not be ticked for normal user operation.

Use the Save As… button to save the list as a .conf (configuration) file that can be retrieved using the
Load button in the future. This obviates the need to generate the same list every time it is required.

Addition of single wavelengths and wavelength ranges can be combined to create a list. The total number
of entries in the list is displayed below the list. With the list generated, click on OK to return to the SCP.
At the onset of a measurement, the monochromator will drive to the specified wavelengths in the order in
which they appear in the list and the chosen property (CD, absorbance, voltage, etc., depending on
measurement mode) will be recorded.

8.2.3.3 The Trigger and Timebase Panels

The Trigger and Timebase panels (Figure 39) are visible when operating in Kinetics mode . In the
Trigger drop down menu, only Internal is used with the Chirascan Q100. 

Figure 39: The Trigger and Timebase panels

The acquisition Time and number of data Points are set using the drop-down menus in the Timebase
panel. The Samples box displays the number of samples which will be averaged in order to obtain each
data point. Ticking the Logarithmic check box results in a logarithmic distribution of data points over
the selected acquisition time. This feature may be useful when the kinetic change being monitored has a
fast initial phase, but a slower second phase. As an alternative, a Split Timebase may be used in
which data points are distributed between two linear intervals.

8.2.3.4 The Sampling Panel

The Sampling panel (Figure 40) is visible when operating in Spectrum mode , and is used to control
the sampling time for each point in a scan. Use the Time-per-point (s) edit box to specify the time in
seconds to be spent collecting data at each point; an Approximate scan-time is calculated based on
the product of the time-per-point and the number of points in the scan (which is equal to wavelength
range divided by the step size as specified in the Monochromator panel ). Note that this is an
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approximate scan time, because the LAAPD detector gain is tuned to optimize the CD signal
(AutoPM  function), which is a feedback process of variable duration, and monochromator movement
adds to the total scan time as well.

Figure 40: The Sampling panel

Advanced sampling settings can be configured in the Sampling-Advanced dialog  which is opened by
clicking Adv....

8.2.3.5 The Sampling-Advanced Dialog

Advanced sampling settings can be configured on the Sampling – Advanced dialog (Figure 41), which
is opened by clicking Adv… on the Sampling panel . 

The Sample Period is the interval between successive data acquisitions, i.e. samples, on the
electronics (or the reciprocal of the data acquisition frequency). By default, this is set to 25.0 μs, which
is close to the lower limit achievable by the electronics. It is recommended that this value is not
changed.

The Default number of samples is the time-per-point  divided by the sample period as given by
Equation 3:

Number of samples = time-per-point / sample period (3)

If the default number of samples or sample period is changed on this dialog, the time-per-point  on the
Sampling  panel changes accordingly. For example, for the default sample period of 25.0 µs and a
number of 40,000 samples performed by the spectrometer electronics, the time-per-point is 1 second.
Conversely, if the time-per-point is adjusted, the number of samples changes accordingly. 

Typically, a number of samples are accumulated and averaged (oversampled) for each point of a
wavelength scan or kinetic measurement reported by Chirascan Viewer in order to improve the signal-to-
noise of the collected data. Most electronic scientific instruments operate in a similar way but usually
report only the average of the samplings. However, the Chirascan Q100 also reports a standard error,
which is calculated based on the samplings as follows: First, all samplings are divided into bins with a
size of 100 samplings each, and for each bin the mean of samplings is calculated. Then the standard
error of these means, σ

M
, is calculated according to Equation 4.

σ
M
 = σ / √N (4)

where σ is the standard deviation of the sampling means and N is the number of bins, i.e. 400 bins for a
default number of 40,000 samplings. σ

M
 is a measure of how close the measured mean is to the actual

mean, i.e. there is a ~95% chance that the true mean lies within 2 σ
M
 of the measured mean.
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Figure 41: The Sampling - Advanced dialog

Calculation of the standard error upon acquisition can be disabled by ticking the Disable Standard
Error check box (the other functions on this dialog should only be changed under instruction from
Applied Photophysics). By default, display of the standard error  in Chirascan Viewer error is enabled.

If Disable oversampling is ticked, a single sample will be collected from the electronics for each point
of the scan, rather than averaging multiple acquisitions (oversampling). This will generally lead to
extremely noisy data and is not recommended.

The settings in the Adaptive sampling limits panel are deprecated.

Clicking Save will retain any changes made even after the software is closed down.

8.2.3.6 The Sequencer Panel

The Sequencer panel (Figure 42) allows you to specify the type of measurement you will make and to
control the starting, stopping, pausing and resuming of data acquisitions. Tick the Repeats check box
to run repeat acquisitions, and enter the number of repeats in the adjacent input box or choose one of
the given numbers from the drop-down menu. A delay between individual acquisitions can be set by
ticking Timed intervals, which is the time between the beginnings of successive repeats; if it is set to
be shorter than the time for each run, then each run will begin after the previous one without delay. All
data from repeat runs will be written to a single Datastore. 
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Figure 42: The Sequencer panel

The radio buttons allow you to select the sequencing mode. It will usually be Spectrum for equilibrium
measurements. Kinetics mode is used to follow spectral changes over time and Spectra-Kinetics
mode is not used with the Chirascan Q100. When Kinetics mode is selected, the Sampling panel is
replaced by the Trigger and Timebase panels .

Click Acquire to begin a manual  acquisition according to the settings in the SCP; clicking Stop
(which appears after Acquire has been clicked) will abort the manual acquisition; clicking Pause will
stop the manual acquisition without aborting and Resume (which appears after Pause has been clicked)
will restart the manual acquisition from the point at which it was paused.

8.2.3.7 The Progress and Status Panel

The Progress and Status panel (Figure 43) provides information concerning the current status of the
spectrometer and of data acquisition. The box on the left of the panel will give the status (e.g. Ready,
Stirring, Acquiring); the two bars to the right of the panel give a visual representation of the progress
(upper bar: total acquisition progress at each step, lower bar: sampling progress).

Figure 43: The Progress and Status panel

8.2.4 Configuring Temperature Settings

8.2.4.1 The Temperature Control Unit Panel

Depending on the target measurement temperature, the autosampler cartridge
and cell may be very hot or cold, causing injury to the user when touched.
Ensure that they have been allowed to reach a safe temperature before
handling or use protective equipment (e.g., thermally protective gloves) if their
insertion or removal at extremely high or low temperature is required. Carry out
risk assessment and consider additional personal protective equipment if in
doubt.
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Depending on system configuration and experiment design, target

measurement temperature can reach between -20°C and 105°C. Extra care

should be taken when handling a potentially hot/cold cell as the target

measurement temperature is actively set through computer control and
monitored only via the Peltier controller display or the control software. As
unsafe temperatures cannot be identified otherwise (e.g., after hard- and
software is switched off or fails), the Chirascan Q100 may only be used by, or
under supervision of, trained laboratory personnel familiar with this user
manual and the risks associated with usage of the system and related
procedures, particularly when conducting experiments at elevated sample
temperatures.

The temperature of the sample cartridge is controlled and monitored on the Temperature Control Unit
panel on the main Chirascan SCP (Figure 44).

Figure 44: The Temperature Control Unit panel

The sample chamber has an integral Peltier element fitted that can be used to regulate the
temperature . The temperature shown in the lower box on the Temperature Control Unit panel is
read from a thermocouple embedded in the sample chamber, i.e. a probe positioned in close proximity
to the Peltier element. The temperature is controlled to this thermocouple.

To set the temperature for isothermal acquisitions, click the Target input box and either enter or use the
up/down arrow buttons to change the desired temperature, then click Set to confirm. If you wish to
perform a temperature ramp, click Settings... in the Temperature Control Unit panel to bring up the
Temperature Control dialog .

8.2.4.2 The Sample Chamber Panel

Sample temperature is monitored on the Sample Chamber panel on the main Chirascan SCP (Figure
45).

Figure 45: The sample chamber panel

Each cell carriage has a read-only temperature probe fitted in close proximity to the flow cell. The
temperature read from this probe is shown on the Sample Chamber panel if T1 is selected from the
drop-down menu. Note that there may be a difference of several degrees between the probes in the
sample chamber and the carriage, and it is suggested that the carriage temperature probe should
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always be used for temperature readings. Note that T5 provides the monochromator temperature for
diagnostic purposes and the remaining entries are not used.

Clicking Setup… opens the Sample and Cell Description dialog  that allows the user to provide
detailed information about sample and cuvette when measuring in Manual Mode .

8.2.4.3 The Temperature Control Dialog

The Temperature Control dialog is opened by clicking Settings... in the Temperature Control Unit
panel  and is used to to configure temperature ramps  only.

To enable temperature ramping, tick the Enable temperature ramping check box (Figure 46), then
choose the type of temperature ramp . A stepped ramp will be performed if the Stepped radio button
is selected, a continuous ramp will be performed if the Smooth radio button is selected. For a smooth
ramp, the temperature will change continuously at a set rate; for a stepped ramp, it will change in set
increments, taking spectra at each set temperature, and moving rapidly between temperatures.

Figure 46: The Temperature Control dialog
 
Radio buttons allow to select if the readings of either the temperature probe of the cell carriage (In-
Sample Temperature Probe (T1...T4))or the thermocouple of the sample chamber  (Temperature
Controller) are monitored.

Clicking Next to advance will bring up either the Smooth ramp or the Stepped ramp dialog (Figure
47).
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Figure 47: The Temperature Control - Smooth Ramp (left) and Temperature Control - Stepped Ramp
(right) dialog

After enabling and choosing the type of temperature ramp and choosing the correct source of
temperature readings, configure settings to perform a temperature ramp .

8.2.4.4 Performing Temperature Ramps

Before performing full-scale automated procedures for thermal denaturation, it is recommended to carry
out preliminary experiments to confirm the suitability of the chosen cleaning procedures of both probe
and cell for the samples at hand. This is because some proteins have a high tendency to adhere tightly
to the inner walls of the flow cell upon unfolding. In such cases, more rigorous cleaning protocols might
be required or it might even be necessary to remove the cell  from its cartridge and subject it to
prolonged cleaning in concentrated nitric acid, in which case automated thermal denaturation is not
compatible with the sample and experiments should be performed manually.

Make sure that the chosen cleaning procedures are suitable for thermal
denaturation of your sample before performing full-scale automated
procedures. Failing to establish the required settings for thermal denaturation
of a sample might otherwise result in unsatisfactory results and, thus, a
substantial loss of sample.

Types of temperatue ramps

Three types of temperature ramps can be performed:

· Stepped (multiwavelength): the temperature is changed in steps, and spectra are acquired
isothermally after each step, while the temperature remains constant.
· (Continuous) single wavelength: the temperature is changed at a fixed rate, and the CD or other

signal is monitored at a single wavelength. 
· Continuous multiwavelength: the temperature is changed at a fixed rate and spectra are acquired

while the temperature is changing. 

The Temperature Control dialog  is used to enable temperature ramping, to select if a stepped or
continuous temperature ramp is performed and to select the correct probe for temperature readings. If a
continuous temperature ramp is performed, the settings chosen on the Monochromator panel  and the
Monochromator Scan Setup – Advanced dialog  determine if it is a single wavelength or
multiwavelength temperature ramp. Analysis of data obtained by a continuous multiwavelength
temperature ramp requires the Global Thermodynamic Analysis software by Applied Photophysics.
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Stepped ramp

A stepped temperature ramp is performed if the aim of the experiment is to investigate the structural
changes that occur within a sample during the ramp, but the temperature at which these changes occur
is of secondary importance. It has the advantage that spectra are acquired isothermally, and as many
spectra as necessary can be acquired at each temperature, but the disadvantage is that it is relatively
time-consuming and that transition temperatures cannot be obtained precisely.

Settings for stepped temperature ramps are configured on the Stepped Ramp dialog (Figure 47).

Settings include the Start and Stop temperatures, the temperature Step and the Settling time and
Tolerance. The Settling time input field specifies a duration for which the target temperature must be
stable within the set temperature Tolerance before isothermal acquisition at the target temperature
starts.

Typical conditions for a stepped temperature ramp for a protein are given in Table 2. Note that the
Tolerance and Settling time are applied at every temperature step.

Table 2: Typical conditions for a stepped temperature ramp

Setting Value

Start Temperature 20°C

Stop Temperature 90°C

Step 5°C

Tolerance 0.2°C

Settling Time 30 s

For a stepped temperature ramp with the above settings, the temperature will move to 20 ± 0.2°C, where
it will be held for 30 seconds. After this time isothermal acquisition begins, on completion of which the
temperature will go to 25 ± 0.2°C, where it will be held for 30 seconds before the next isothermal
acquisition begins. This procedure will continue up to 90°C and result in one or more spectra at each of
the 15 temperatures, depending on the number of repeats set in the Sequencer panel  of the SCP. 

If the Return Ramp check box is ticked, the process will be repeated from high to low temperature. 

At the end of the ramp, the temperature will go to that specified on the End-of-ramp behavior panel,
and a final spectrum will be taken at that temperature if the Take a final measurement check box is
ticked.

Single wavelength ramp

A single wavelength temperature ramp is used if the aim of the experiment is to investigate the
temperature at which structural changes within a sample occur, but the nature of these changes is of
secondary importance. It has the advantage of being quick and accurate if the correct wavelength is
used, but the disadvantage that information about the nature of the structural changes is lost, and if an
incorrect wavelength is used, any structural changes may be hidden.

Settings for single wavelength temperature ramps are configured on the Smooth Ramp dialog shown. 

Settings include the Start and Stop temperatures, the temperature Step, the temperature ramp Rate
and the Settling time and Tolerance. The Settling time input field specifies a duration for which the
start temperature must be stable within the set temperature Tolerance before the first acquisition
begins. Note that the Settling time is not applied to any temperatures other than the start temperature.
Step refers to the increments of temperature at which an acquisition is performed.
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Settings for a single wavelength temperature ramp are configured similarly as for a continuous
multiwavelength temperature ramp. However, acquisitions are performed at a single wavelength instead
of over a wavelength range, as specified in the Monochromator Scan Setup – Advanced dialog .

During the temperature ramp, the temperature is increased continuously with the rate specified in the
Rate input field. The time interval between acquisitions corresponds to the step divided by the
temperature ramp rate. For example, if a step of 5°C and a temperature ramp rate of 1°C per minute are
chosen, then an acquisition will be performed every five minutes. 

The acquisition settings are usually configured such that the total acquisition time is a bit less than the
time interval of acquisitions. For a single wavelength temperature ramp, this means that the time-per-
point  is shorter than the acquisition interval.

For a single wavelength temperature ramp with the settings in Table 2 and a rate of 1°C per minute, the
temperature will move to 20 ± 0.2°C, where it will be held for 30 seconds. Then acquisition at the chosen
wavelength will be performed isothermally. After this first acquisition, the temperature will increase at 1°
per minute and when the temperature reaches 24.8°C (i.e. 25.0°C minus the tolerance of 0.2°C), the
second acquisition will be performed, while the temperature continues to increase at the set rate of 1°C
per minute. When the temperature reaches 29.8°C, the third acquisition will begin, and so on.

If the Return Ramp check box is ticked, the process will be repeated from high to low temperature. At
the end of the ramp, the temperature will go to that specified on the End-of-ramp behavior panel.

Continuous multiwavelength ramp

A continuous multiwavelength temperature ramp is used if the transition temperatures and structural
changes are of equal importance. It has the slight disadvantage that the temperature changes during a
spectrum acquisition, although this is accounted for in the Applied Photophysics Global Thermodynamic
Analysis software.

Settings for a continuous multiwavelength temperature ramp are configured similarly as for a single
wavelength temperature ramp. However, acquisitions are performed over a wavelength range instead of at
a single wavelength, as specified in the Monochromator Scan Setup – Advanced dialog . Note that the
temperature will be increasing at the set temperature ramp rate during acquisition. 

Again, the acquisition settings are usually configured such that the total acquisition time is a bit less
than the time interval of acquisitions. For a continuous multiwavelength temperature ramp, this means
that the total time required to acquire a given number of repeat spectra - over the chosen wavelength
range and at the chosen time-per-point and step size - is shorter than the acquisition interval. 

If each acquisition takes longer than the acquisition interval, the total number of spectra will be the
same, but spectra will be labeled according to their target temperatures, which will then not correspond
with their start temperatures. To reduce the total acquisition time, wavelength range and time-per-point
should be curtailed.

For a continuous multiwavelength temperature ramp with the settings in Table 2 and a rate of 1°C per
minute, the temperature will move to 20 ± 0.2°C, where it will be held for 30 seconds. Then acquisition of
a first spectrum will be performed isothermally. After this first acquisition, the temperature will increase
at 1° per minute and when the temperature reaches 24.8°C (i.e. 25.0°C minus the tolerance of 0.2°C),
acquisition of the second spectrum will be performed, while the temperature continues to increase at the
set rate of 1°C per minute. When the temperature reaches 29.8°C, the acquisition of the third spectrum
will begin, and so on.
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8.2.5 Providing Sample Information

Details about the sample and the cuvette used in Manual Mode  can be provided by the user in the
Sample and Cell Descripton dialog (Figure 48) which is opened by clicking Setup... in the sample
chamber panel . Note that any information entered in this dialog are for reference only; they are
stored  with the Datastore, but are not otherwise used by the instrument software.

Figure 48: The Sample and Cell Description dialog

Additional information related to both a manual and automated acquisition can be provided by the user in
the Well Experiment Remarks dialog (Figure 49) which is opened by choosing Remarks... in the View
menu  or by clicking the Remarks toolbar  icon. The information entered in this dialog is saved with
the data acquired and can be inspected later through the Remarks tab of the Advanced Datastore
Content Info panel  in Chirascan Viewer .
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Figure 49: The Well Experiment Remarks dialog
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8.2.6 The Preferences Dialog

Clicking on the Preferences icon in the toolbar  or selecting Preferences… from the Configuration
menu  opens the Preferences dialog and contains seven tabs which are described in the following.

8.2.6.1 The CD Tab

On the CD tab (Figure 50), preferences for CD measurements can be set. In the Default Mode panel,
select either delta A (delta absorbance) or millidegrees as the units for expressing circular dichroism.
In the Auxiliary Measurements panel, the HV check box is disabled and permanently selected, i.e. the
emulated detector HV will always be recorded in CD mode. In the AutoAbsorbance panel the Enable
AutoAbsorbance by default check box can be ticked so that by default, Absorbance will always be
recorded together with the CD signal, which is recommended.

Figure 50: The CD tab
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8.2.6.2 The Absorbance Tab

On the Absorbance tab (Figure 51), preferences for absorbance measurements can be set. The Default
Mode panel enables you to choose between Absorbance and Transmission as the default measured
property. 

In the Auxiliary Measurements panel, the HV check box is disabled and permanently selected, i.e. the
emulated detector HV will always be recorded in Absorbance mode.

In the Default Options panel, the AutoPM check box enables automatic optimization of the emulated
detector HV at each point in the spectrum; if the AutoPM check box is unticked, the emulated HV is
constant and there is no risk of hysteresis associated with sharp changes in the emulated HV. This will
normally result in a more accurate absorbance measurement, but you must be careful to ensure that the
detector is not saturated during the measurement. However, as occurrence of big changes in emulated
HV from one point to the next are unlikely with AutoPM ticked, using AutoPM will not degrade the
absorbance measurement in any significant way and is recommended.

Figure 51: The Absorbance tab
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8.2.6.3 The Fluorescence Tab

There are no active panels on the Fluorescence tab.

8.2.6.4 The Data Acquisition Tab

The conditions on the Data Acquisition tab have been established as optimal by Applied Photophysics’
engineers, and they should not be changed except under guidance from Applied Photophysics Customer
Support.

The Spectrum/Spectra-Kinetics Mode Options panel includes input fields for acquisition delay times.
Use of delays can, for example, allow time for the detector or other electronic devices to settle, resulting
in more stable acquisition of data.

· Per-point acquisition delay (ms): A delay before each data point
· Pre-scan delay (ms): A delay at the beginning of acquisitions
· Post-scan delay (ms): A delay at the end of acquisitions

The settings in the Detector protection panel ensure that the detector cannot be damaged by being
exposed to too much light while an emulated  detector voltage is applied:

· PMU saturation detection: this function is only used for Chirascan systems using a PMT detector.
· Zero HVs before spectrum scan: If checked, the the emulated detector HV will be set to zero before

acquisition. This way, the AutoPM  procedure begins at zero volts and ramps upwards safely to the
HV level required, rather than starting from a HV level which is potentially too high and could lead to
detector damage.
· Zero HVs on fly-back (spectrum mode): If checked, the emulated detector HV will be set to zero at

the end of acquisition, before the monochromator moves back to the starting wavelength. This avoids
exposing the detector to excessive light during fly-back which is inappropriate for the HV level set on
the final point of acquisition, and could cause detector damage.

 The settings in the DAQ Calibration panel refer to data acquisition:

· Calibrate zero offset errors at program startup: If checked, a procedure to zero residual electronic
offsets will be run when the Chirascan software starts up. Electronic offsets can cause small errors in
data acquisition, so checking this box is recommended.
· Clear signal offsets before data acquisitions: If checked, a procedure to zero residual electronic

offsets will be run before each acquisition.

69



89

Chirascan Q100 User Manual 
 
                                                                                                                   © 2023 Applied Photophysics Limited

Software

8.2.6.5 The File Names Tab

The File Names tab provides functionality identical to the File Names dialog  which can be accessed
directly using the File names icon on the toolbar  of the SCP . Clicking Reset All sets all running
numbers to zero.

Figure 52: The File Names tab
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8.2.6.6 The Startup Preferences Tab

On the Startup Control Panel Mode panel of the Startup Preferences tab (Figure 53), the SCP can
be set to open in Spectrum, Kinetics or Spectra-Kinetics sequencer modes . The Spectrum mode
is usually set as default. 

On the Emulation panel, Chirascan Control can be set to open by default in Emulation Mode , which
can be used for data manipulation on a PC remote from the spectrometer, or with the spectrometer
powered off.

Figure 53: The Startup Preferences tab
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8.2.7 The Device Window

Select Devices… from the View menu  to open the Device Window (Figure 54). Many of the icons
require a service password or are not available, and their action is not described here. Others are only
active when a particular accessory is installed, and the user is referred to the relevant user manual. Only
the buttons and the Attenuator icon are described below.

System Reset will reset any user-adjustable parameters accessible through the Device Window to
their factory defaults. It is unlikely that you would need to do this.

Calibrate Zero Offsets will adjust the electronic offset to take into account any small drift that may have
occurred over time. It is unlikely that you will need to do this on a regular basis. The offsets should not
be changed until the instrument electronics are at their normal working temperature (it is good practice
to leave the electronics powered on at all times) nor should they be changed part-way through a series of
measurements, since recalibrating the offsets may shift the CD background slightly.

Service Password… opens a dialog that permits you to change the password that gives access to the
advanced sections of the Device window. If you change it, do not forget it because Applied Photophysics
engineers will not be able to recover it for you.

Figure 54: The Device window
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8.2.7.1 The Attenuator Icon

Clicking the Attenuator icon  opens the Attenuator / Shutter Control dialog (Figure 55).

The attenuator operates both as attenuator and shutter. The Open and Close buttons have the same
function as those found in the SCP  and are linked to them; changes in one set are replicated in the
other. 

The maximum opening of the attenuator can be limited using the slider bar and this may be appropriate
in special circumstances (for example to reduce damage to samples) but in general the attenuator
should not be limited in its maximum aperture. The status of the aperture is shown on the Current
attenuator position slider; if the maximum aperture is limited, then that is also shown in the slider
position. The shutter display on the SCP is linked to this function and therefore the status of the
attenuator can be ascertained from there, too.

Figure 55: The Attenuator / Shutter Control dialog

8.2.8 The Chirascan Control Menu Bar

Much of what is available in the menus is more readily accessible from the icons in the toolbar . The
menu bar is movable and dockable within and outside the Control Panel in the usual Microsoft Windows
way.

8.2.8.1 The File Menu

The File menu (Figure 56) gives access to the options below for handling templates. The examples
folder can be accessed from this menu, in which there are several examples of spectra  supplied by
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Applied Photophysics that can be used as templates to set up Chirascan Control or as tools to
familiarize oneself with the use of Chirascan Viewer .

Figure 56: The File menu

· Open Experiment Template… sets the acquisition settings according to an existing template from
the SQL database.
· Import Experiment template… sets the acquisition settings according to a file from the Microsoft

Windows file system.
· Open Examples… sets the acquisition settings according to one of the example files   in the

Microsoft Windows file system.
· Save saves the current acquisition settings as a new revision of the current template.
· Save as… brings up a dialog that allows saving the current acquisition settings as a new template. If

no name is entered, settings are saved as a new revision of the current template. If the name of an
existing template is entered, settings are saved as a new revision of that template.
· Export Template… exports the acquisition settings of the current template to a file.
· Exit closes the Chirascan Control software.

8.2.8.2 The View Menu

The View menu (Figure 57) gives access to the following options:

· Chirascan Viewer… launches Chirascan Viewer .
· Devices… opens the Device window . This contains a number of icons corresponding to hardware

devices that may need to have certain parameters adjusted.
· Remarks… opens the Well Experiment Remarks  dialog, in which you can record information

about your experiments.
· Toolbar toggles visibility of the toolbar .
· Always on top toggles Chirascan Control to be always visible.
· Run silently is used to suppress error and warning messages, for example the detector low HV

warning, that would pause acquisition when displayed.
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Figure 57: The View menu

8.2.8.3 The Admin Menu

The Admin menu (Figure 58) is used for administration of user permissions, access to Datastore
repositories and management of data records and logs. Most of the options are relevant for 21 CFR Part
11 compliance .

Figure 58: The Admin menu

· Users and Roles is used for 21 CFR part 11 compliance only.
· Data Stores Repositories allows datastore repositories to be managed from within Chirascan Control

similar as in Chirascan Viewer .
· Manage Actions Reasons and View CFR Controlled Actions Log are used for 21 CFR part 11

compliance  only.
· Manage Templates is used for viewing and managing templates  and their revisions.
· Diagnostics is used by Applied Photophysics Service Engineers only.
· Database Scheduled Backups opens the Pro-Data Database Backup Scheduled Jobs dialog,

which is used to set the schedules for automatic backups of the database .
· Change SQL Database Password allows to set a new password for the software's database .
· Reset JSA to Defaults results in the default Application definition  being loaded upon next start up

of Chirascan Autosampler.
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8.2.8.4 The Configuration Menu

The Configuration menu (Figure 59) gives access to the following options:

· Change sample chamber is used by Applied Photophysics Service Engineers only.
· Preferences... opens the Preferences dialog  in which personal preferences can be set.

Figure 59: The Configuration menu

8.2.8.5 The Help Menu

The Help menu (Figure 60) gives access to the following options:

· Help... launches this user manual. You can browse the contents and search for specific words and
phrases.
· About Chirascan… opens a window giving the version number and other information about Chirascan

Control.

Figure 60: The Help menu

8.2.9 The Chirascan Control Toolbar

The Chirascan Control toolbar is shown in Figure 61. Most of the toolbar actions duplicate some of those
of the menu bar  options.

Open Experiment Template… sets the acquisition settings according to an existing template from the
SQL database.
· Save saves the current acquisition settings as a new revision of the current template.
· Save As brings up a dialog that allows saving the current acquisition settings as a new template. If no

name is entered, settings are saved as a new revision of the current template. If the name of an
existing template is entered, settings are saved as a new revision of that template.
· File Names opens the File Names dialog , in which you can specify seed names for spectra and

backgrounds acquired in Manual Mode .
· Remarks… opens the Well Experiment Remarks  dialog, in which you can record information

about your experiments.
· Preferences... opens the Preferences dialog  in which personal preferences can be set.
· Chirascan Viewer launches Chirascan Viewer .
· ANMS opens the ANMS software .
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· About opens a window giving the version number and other information about the Chirascan Control
software.
· Help launches the user manual. You can browse the contents and search for specific words and

phrases.

Figure 61: The Chirascan Control toolbar
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8.3 Chirascan Viewer

This section describes the Chirascan Viewer program, which is designed to display and manipulate data
and to store them securely. Chirascan Viewer is part of the Chirascan software platform architecture
together with other software components.

8.3.1 Introduction

8.3.1.1 Launching Chirascan Viewer

Chirascan Viewer is designed to display live data while a measurement is running, to store the data
securely on completion of the experiment, and to reload, plot and manipulate the stored data at any time
later.

On completion of a measurement, the data are stored as entries, called Datastores, in a SQL Database,
called Datastore Repository. From there, the Datastores can be reloaded into Chirascan Viewer for
plotting and manipulation; the manipulated files can then also be saved.

Datastores obtained using earlier versions of Chirascan Viewer can also be loaded into Chirascan Viewer
version 5.5.0.4 from their location in the Microsoft Windows file system.

Chirascan Viewer can be used either online, with a client-server link to Chirascan Control, or off-line as a
standalone program without such a link.

Chirascan Viewer is launched on-line from the Chirascan Control SCP  by right clicking on the
Chirascan Viewer icon in the SCP toolbar . The link between Chirascan Control and Chirascan
Viewer will be established automatically. When on-line, Chirascan Viewer becomes a live display for
data as they are collected, although it can still be used for the display and manipulation of other data. 

Chirascan Viewer is launched off-line, i.e. without a link to Chirascan Control, for data display and
manipulation only by double-clicking its desktop icon. Note that in this case Chirascan Control will not
know of its existence, and Chirascan Viewer will not respond to the start of an experiment in the normal
way. However, a connection between the two programs can be established by using Go-Online.. in the
Preferences menu  of Chirascan Viewer.

The status of Chirascan Viewer is shown on the status bar  at the foot of the window, where the words
Ready (On-line) or Ready (Off-line) can be found (Figure 62). If Chirascan Viewer is off-line and you
wish to change its status to on-line, i.e. establishing the link to Chirascan Control, this can be done in
the Preferences menu .

8.3.1.2 The Chirascan Viewer Window Layout

The Chirascan Viewer window layout (Figure 62) follows Microsoft Windows conventions.

Chirascan Viewer contains two main areas:

· The launchpad, usually to the left, which contains the Datastores file list.
· The Graphical Display , usually to the right, where data are plotted.

The top of the Chirascan Viewer window contains the launchpad menu bar.

Moreover, there are several toolbars present in Chirascan Viewer:

· The Standard toolbar is used for standard Microsoft Windows functions.
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· The Analysis toolbar is used for various operations  of data analysis. 
· The Data Dimensions toolbar is used only for handling multi-dimensional  data.
· The Trace toolbar is used for selecting  traces.

The bottom of the Chirascan Viewer window contains a status bar that displays the on-line status  of
Chirascan Viewer.

Figure 62: The Chirascan Viewer window

The layout can be customized using a right click pop-up menu (Figure 63) or the View menu . To view
this pop-up menu, right-click on an area outside the launchpad or Graphical Display . The menu bar
can be hidden or displayed using the right-click pop-up menu or hidden using the View menu . The
toolbars can be hidden or displayed using the right-click pop-up menu or using the entries in the
Toolbars sub menu in the View menu . Both menu bar and toolbars are movable and dockable in the
usual Microsoft Windows way.
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Figure 63: The right-click pop-up menu

8.3.2 The Launchpad File List

Measurement data can be browsed using the DataStores Repositories View (Figure 64) of the
launchpad file list and are stored as Datastores  in SQL database repositories or sub-repositories
from where they can be accessed by Chirascan Viewer. Data can be exported  from the repository,
for example for use with third-party programs such as Microsoft Excel™, or for handling on a remote
computer. 

Figure 64: The DataStores Repositories files list
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The file lists are normally positioned to the left of the Graphical Display . To reposition a file list, grab
the title bar with the left mouse button and drag the window to its new position, or to one of the docking
arrows (Figure 65) to dock to the top, bottom, left or right of the Graphical Display .

Figure 65: The docking arrows

The DataStores Repositories view has six sub-panels:

· Repositories shows the repository tree view.
· Advanced Datastore Information provides detailed information  about the datastore currently

selected in the DataStores Repositories tree view.
· Selected File DataStores provides a list with the traces in the currently selected Datastore. The

information displayed in the sub-panels of the Advanced Datastore Information panel refers to the
selection in the Selected File DataStores sub-panel.
· Search… allows to search for datastores in the repository based on user specifications as shown in

Figure 66. After clicking Run Search…, search results are displayed in the Query Result View
panel.
· Recyle Bin lists deleted Datastores and repositories.
· DataStore File Info provides basic info about the selected Datastore and allows to select a specific

revision  of this Datastore in a drop-down menu.

Figure 66: The Search sub-panel

Right-clicking Datastores in the Recycle Bin allows inspecting their properties as well as restoring
Datastores and deleting Datastores permanently if the user has the corresponding permission .

Use the function Delete Permanently with caution, as Datastores deleted
from the Recycle Bin cannot be restored.
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Multiple entries in the file list can be selected by clicking the first and last entry with the left mouse
button + Shift. Single entries can be added to the selection by using the left mouse button + Ctrl. A
toolbar above the launchpad file list (Figure 67) assists in navigation and allows browsing, adding,
deleting and renaming repositories.  Most of the functions of these icons and navigation in the Datastore
Repository file list are also available by choosing Data Stores Repositories in the  Admin menu  of 
Chirascan Control.

Figure 67: The Datastores Repositories toolbar

· Add Sub Repository creates a new sub repository within the currently selected repository.
· Rename allows renaming the currently selected Datastore or repository.
· Show Properties either opens the Repository Property dialog  for a selected repository or the

Store File Property dialog  for a selected datastore.
· Refresh Selected Node updates the displayed content of the selected repository for recent changes

to repositories or Datastores.
· Go a Repository Level up increases the repository top level.
· Start Repository tree view from User's root sets the user's root repository  as the repository top

level.

The icons Go a Repository Level up and Start Repository tree view from User's root are only
enabled in absence of a valid license for 21 CFR Part 11  as they allow users to browse repositories
that are not part of their root repository .

Similar toolbar icons are available for the DataStores Explorer View and the Windows Explorer view:

· Set as my Root Directory sets the selected directory as working directory.
· Go back to my Root Directory recalls and navigates to the working directory.
· Move Up (DataStores Explorer View only) navigates to the directory one level above the current

directory.
· New Folder creates a new folder in the current directory.
· File Open loads and plots the selected file in the Graphical Display .
· Refresh (DataStores Explorer View only) updates the file list for any recent changes (e.g. a newly

created file).

Note that the Root Directory referred to by these toolbar icons is only used for navigation and not
related to the Save to Repository .

8.3.2.1 The Datastore File Structure

Measurement data are written to a database entry called a Datastore, which is a proprietary format
designed for handling multi-dimensional data. Its content depends on the type of measurement that is
carried out. A knowledge of the structure of Datastores is helpful for understanding some of the
functionality of Chirascan Viewer .

A Datastore contains all the data from a measurement, as well as measurement settings such as
wavelength range, bandwidth, sampling times, etc. It can also include remarks and other information
input by the user for reference.

The measurement data contained in a Datastore consists of dimensions and properties. The dimensions
are the controlled (independent) experimental variables, such as wavelength or time; the properties are
the measured (dependent) variables such as CD or absorbance; temperature may be either a dimension
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or a property or both, depending on the type of measurement. When data are plotted using Chirascan
Viewer, dimensions are always plotted on the x-axis, and properties on the y-axis. 

A Datastore can therefore have one or more dimensions, depending on the number of controlled
variables. For example, a simple measurement in which CD is measured as a function of wavelength
would generate a one-dimensional Datastore containing wavelength as the dimension, and CD, detector
emulated HV, absorbance (if measured), transmission, temperature, the detector signal voltage (DC
component), and the number of samples taken at each step (count), as properties.

If a temperature ramp is performed in which a series of spectra are measured while the temperature is
changing, a two-dimensional Datastore would result, with wavelength and temperature as dimensions,
and containing CD, HV etc. as properties. A dimension is also added if measurements with repeat
scans are performed.

Higher dimension Datastores can also be generated, for example, if a temperature ramp is performed
with repeat scans. All data from a particular measurement are written to a single Datastore.
Subsequently, the Datastore can be mined for subsets of the data.

Note that the Datastore file format is designed for Chirascan software multi-dimensional data acquisition
and is not suitable for direct access outside the Chirascan software environment. A range of file export
options is provided within Chirascan Viewer, generating formats that are suitable for third-party software.

8.3.2.2 Managing Datastore Revisions

Datastores in the database may contain more than one revision . For example, if data from a
Datastore are operated on by baseline subtraction or smoothing, and the plot is saved using Save
current plot from the File menu , unless saved under a new file name, it will be saved as an
additional revision of the same Datastore. Similarly, plots with more than one data set plotted can be
saved as revisions of the active Datastore. In either case, the original data will not be overwritten. 

To select a revision, right-click the Datastore file name and choose Select Revision… to open the
DataStore Revision dialog (Figure 68), then scroll to the required revision in the Revision drop-down
menu and click OK.

Figure 68: The DataStores File Revision dialog

To delete a Datastore, right-click the Datastore file name and choose Delete. This moves the selected
Datastore to the Recycle Bin  including any revisions if the Datastore contains more than one
revision. Only the currently selected revision will be deleted.

28

123

99



103

Chirascan Q100 User Manual 
 
                                                                                                                   © 2023 Applied Photophysics Limited

Software

To view the properties of a Datastore, right-click on the Datastore file name and choose Properties to
open the Store File Property dialog (Figure 69). At the top of the dialog, some general information of
the Datastore is shown, including its name, date and time of creation and the name of the user who
created it. 

The dialog also presents a list of all the revisions of the Datastore that provides the following information
for each of the revisions:

· Revision: The number of the revision
· Saved Time: The time that the revision was created
· Store File Size: Size of the Datastore (in bytes)
· Saved by: The name of the user who saved/created the Datastore
· Template Run: The template  used to create the Datastore
· Template Revision: Revision number of the template used to create the Datastore

Selected revisions can be plotted and their properties printed by clicking the corresponding icons above
the list. This dialog also allows users with corresponding permission  to delete specific revisions. The
Saved Time allows cross-reference to a matching time stamp in the audit trail  if
SAVE_DATASTORE has been configured to be a controlled action .

Use the Delete selected revision(s) function with caution, as revisions
deleted from the repository cannot be restored.

Figure 69: The Store File Property dialog

8.3.2.3 Viewing Datastore Information

Acquisition settings, sample information provided by the user and additional user information are stored
with the data and can be viewed on the Advanced Datastore Information panel (Figure 70). The
details shown will be those corresponding to the Datastore currently selected in the Datatores
Repositories view and the current selection in the Selected File DataStores sub-panel . 
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Figure 70: The Advanced Datastore Information panel

The Advanced Datastore Information panel has four tabs:

· Template Settings shows the settings for the experimental template  used to acquire the data
(time-per-point, wavelength range, step size, bandwidth etc.). 
· Remarks shows information entered for reference by the user in the Well Experiment Remarks

dialog in the SCP , sample information provided by the user via the Sample and Cell Description
dialog  (sample description, concentration, cell type and path length) for acquisitions in Manual
Mode  and supplement information that has been recorded automatically such as the instrument
serial number.
· History shows the time and date stamps and the results of operations  performed on the data (such

as baseline subtraction, smoothing, curve fitting etc.).
· Data Manipulation shows information about operations performed on the data during an automated

run as specified in the Data Manipulation column of the Wells View .

Some of the information shown in the Advanced Datastore Information panel or additional information
is also available by other means:

· Choosing Properties in the Datastore right-click menu
· Choosing View DataStore Info and History in the Datastore right-click menu

Information specific to automated procedures is summarized in Experiment Files which can be
inspected through the Experiment  menu.

8.3.2.4 The Datastore Right-Click Menu

Right-clicking on a DataStore or a repository calls up the context menu shown in Figure 71.

72

84

66

84

174

114

143

104

104

126



105

Chirascan Q100 User Manual 
 
                                                                                                                   © 2023 Applied Photophysics Limited

Software

Figure 71: The DataStores right-click menu

The Datastore right-click menu gives access to context-sensitive functions that are enabled or disabled
depending on whether a Datastore or a repository has been right-clicked.

The following functions are enabled for repositories only:

· Add Sub repository creates a new sub repository within the right-clicked repository.
· Refresh updates the displayed content of the right-clicked repository for recent changes to

repositories or Datastores.
· Set as Save to Repository sets the right-click repository as the Save to Repository  where any

data acquired in Manual Mode  are stored.

The following functions are enabled for Datastores only:

· Open displays (the most recent revision of) the right-clicked Datastore in a new tab of the Graphical
Display .
· Select Revision… opens a dialog that allows to select a specific revision of the right-clicked

Datastore to be displayed in a new plot of the Graphical Display .

The following functions are enabled for both Datastores and repositories:

· Rename allows renaming the right-clicked Datastore or repository.
· Export to Proprietary Format allows storing  the right-clicked Datastore or all DataStores within

the right-clicked repository in a format that is suitable for use with third-party programs.
· Decompose Data… opens a dialog that allows extracting subsets of data from a multi-

dimensional  Datastore.
· Copy copies the right-clicked repository or Datastore(s).
· Cut cuts the right-clicked repository or Datastore(s).
· Paste inserts the copied repository or Datastore(s) in the right-clicked location.
· Delete moves the right-clicked repository or Datastore(s) to the Recycle Bin .
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· Properties either opens the Repository Property dialog  for a selected repository or the Store File
Property dialog  for a right-clicked datastore.
· View DataStore Info and History opens a dialog that summarizes the same information that can be

found in the Advanced Datastore Information panel .

8.3.3 The Graphical Display

The Graphical Display is used to display and manipulate traces. Traces can be spectra (i.e. wavelength-
dependent properties), kinetic traces (i.e. time-dependent properties), melting curves (i.e. temperature-
dependent properties) or other data.

8.3.3.1 Viewing Traces

The Graphical Display uses a Multiple Document Interface (MDI) format: multiple Datastores can be
open at the same time as tabs in the Graphical Display, in each of which multiple plot windows can be
opened simultaneously to display different properties . The active tab is selected either by clicking the
tab or from the Window menu .

Data from one or more Datastores can be displayed in each plot of the Graphical Display:

· To plot a Datastore in a new window, double-click on the Datastore, right-click  on the Datastore
and click Open.
· To add a Datastore to a Graphical Display, drag it onto the plot from the file list.
· To add more Datastores to a Graphical Display, select multiple Datastores from the list in the usual

way (using the left mouse button with Ctrl or Shift keys) and drag them onto the Graphical Display
(Figure 72).
· To remove a trace from the display select  the trace, right-click and choose Remove Selected

Trace(s), press the Del key, or use the Trace manipulation dialog .

Figure 72: Data of two datastores (buffer and protein) displayed in the Graphical Display

8.3.3.2 Overlaid Traces

Displaying multiple Datastores in the same plot by drag-and-drop  is useful for comparing traces.
However, note that two Datastores must be compatible with each other to be displayed in the same plot
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– for example, a trace collected as a function of wavelength cannot be displayed together with a trace
that was collected as a function of some other dimension , such as temperature.

It is possible to add traces to a plot the property and dimension (e.g. CD and wavelength) of which are
compatible with the traces already displayed, but that differ in wavelength range, step size or bandwidth.
Such overlaid traces can be manipulated in the usual way.

8.3.3.3 Showing and Hiding the Legend

Plots open with a legend containing a list of the plotted traces to the right of the plot area. To hide or
show the legend, right-click on the area to the right of the graph and choose Hide/Show Legend.

8.3.3.4 Showing and Hiding the Error

If data has been acquired with calculation of the standard error  enabled, the standard error can be
displayed as an error band and/or as error bars (Figure 73). The standard error is calculated  based on
the number of samplings. Note that display of the standard error is limited to CD data and plots without
overlaid traces .

Figure 73: Error Band (left) and Error Bars (right)

Visibility of error band and error bars is controlled through the View menu  of the Graphical Display:
click Error and toggle either Error Band or Error Bar or both, and then choose the number of Standard
Errors for the error range in the Uncertainty sub menu (Figure 74).

Figure 74: The Error menu and Uncertainty sub menu
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8.3.3.5 Selecting a Trace

A trace can be selected in a number of ways. Once selected, it changes color to black, is highlighted
with ‘selection marks’ and crosshairs appear on it. The value of the x- and y-coordinates at the position
of the crosshairs are shown above the plot as part of the Trace toolbar  (Figure 75). Single trace
selection methods are listed below.

· Place the mouse cursor close to a data point of the trace of interest. Left-click to select it. Click a
second time to deselect it.
· Right-click anywhere in the Graphical Display to open a context menu . Choose Select Specific

Traces to open a dialog containing a list of the traces displayed. Click on an entry to select it and OK
to close the dialog.
· On the Trace menu  click Selection Dialog… or from the Analysis toolbar  click on the

Selection Dialog… icon to open the Trace Manipulation dialog . Click on an entry to select it and
OK to close the dialog.
· Select an entry from the drop-down menu at the top of the Graphical Display which is part of the Trace

toolbar .

Figure 75: Protein CD spectrum with buffer baseline selected

The method of selection will depend on personal preference and on the number of traces displayed. For
example, if you wish to select one trace from several overlapping traces, using the dialog is easier than
using the mouse pointer. Once a trace is selected, the Up / Down arrow keys can be used to move the
selection sequentially through the displayed traces.

8.3.3.6 Selecting Multiple Traces

Selecting more than one trace is often required, for example, to average several spectra. Variations in
the methods to select a single trace  are used to select more than one.

· Using the mouse pointer: Hold down the Ctrl key and left-click on a trace to toggle its selection
status.
· Using the trace list: Hold down the Ctrl key and left-click on a trace name in the drop-down menu

above the plot to toggle its selection status.
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· Using the Trace manipulation dialog : Hold down the Ctrl key and left-click on a list entry to toggle
its selection status; hold down the Shift key and left-click two list entries to select a set of entries;
alternatively, left-click and drag the mouse pointer over the list to select a set of entries. Selected
entries are highlighted. In general, using the dialog is the preferred method when dealing with more
than one trace.

8.3.3.7 Zooming and Rescaling the Display

To zoom in to a particular part of the display, click and hold the left mouse button while moving the
pointer to create a box around the area of interest. On releasing the left mouse button, the newly created
box will expand to fill the display window (Figure 76). To return to full display, double-click in the display
area or click Reset Zoom in the Scale menu .

Figure 76: Full display with zoom box (left) and zoom (right)

Use the mouse wheel to increase or decrease the displayed ranges of both axes simultaneously. Hold
down the Ctrl key and use the mouse wheel to increase or decrease the displayed range of only the
horizontal axis. Likewise, hold down the Shift key and use the mouse wheel to increase or decrease the
displayed range of only the vertical axis (Figure 77).

Figure 77: Zooming horizontal axis (left) and vertical axis (right) only

The displayed area can be specified by setting lower and upper limits for the x- and y-axis in the Select
Range dialog, which is opened by choosing Set Plot Limits... in the Scale menu .

114

128

128



110

Chirascan Q100 User Manual 
 
                                                                                                                   © 2023 Applied Photophysics Limited

Software

8.3.3.8 Changing the Displayed Property

Chirascan Viewer always plots the dimension  on the x-axis, and a selected property  on the y-
axis. Right-clicking the y-axis legend will display a menu of the properties recorded during a
measurement (Figure 78). To change the plotted property, select one from the list by double-clicking it.

Figure 78: The properties menu

When run in CD mode , five properties are recorded with every measurement made on the
spectrometer. These are:

· Circular dichroism
· HT (High Tension, i.e. HV, detector emulated high voltage input)
· Voltage (detector DC voltage output)
· Temperature at which the measurement was taken
· Count (the number of samples  taken at each step in the scan)

In addition, the absorbance can be plotted if it was selected when setting the acquisition settings .

8.3.3.9 Displaying Multiple Properties

Only one property can be plotted on each plot, but two properties can be viewed simultaneously on
different plots. On the Window menu , click New Window and select a property from the list that is
displayed. The Graphical Display will appear as in Figure 79, which shows the same data plotted as
circular dichroism against wavelength in the upper plot, and absorbance against wavelength in the lower
plot.
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Figure 79: Plots of circular dichroism and absorbance plotted against wavelength

8.3.3.10 The Graphical Display Right-Click Menu

Right-clicking on the plot area of the Graphical Display opens the menu shown in Figure 80.

This context-sensitive menu gives access to different options depending on whether a trace is currently
selected in the Graphical Display or not. These options are also accessible in other menus or toolbars in
Chirascan Viewer and include: 

The following functions are available no matter if a trace is selected or no:

· Select All Traces is similar in function to Selected All in the Trace menu  and the Trace
Manipulation dialog .
· Unset Baseline is only enabled if a baseline is currently set.
· Clear Plot is similar in function to as in the Trace menu .
· Print… is similar in function as in the File menu  and the Standard toolbar .
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Figure 80: The Graphical Display right-click menu with no (left) and a single trace selected (right)

The following functions are available only if no trace is selected:

· Select Specific Traces... is similar in function as Selection Dialog... in the Trace menu  and the
Analysis toolbar .
· Select Range... is similar in function as Select Trace Range in the Analysis toolbar  and Thin

Data in the Trace Manipulation dialog .
· Average All Traces is similar in function as in the Math menu  and the Analysis toolbar .
· Recompute Colours is similar in function as in the Analysis toolbar  and as Recompute Trace

Colours inthe Trace menu .

The following functions are available only if a trace is selected:

· File contains sub entries Save Selected Traces... and Save Current Plot... as Save Current
Plot... with its subentries in the File menu .
· Deselect All is similar in function as in the Trace menu  and the Trace Manipulation dialog .
· Remove Selected Trace(s) is similar in function as in the Trace menu  and Remove in the Trace

Manipulation dialog .
· Remove Unselected Trace(s) is similar in function as in the Trace menu  and Remove Others

the Trace Manipulation dialog .
· Set Selected as Baseline sets a single selected trace as baseline and is similar in function as

Toggle Selected as Baseline in the Trace menu  and Set Baseline the Trace Manipulation
dialog .
· Add Baseline is similar in function as in the Trace menu  and the Analysis toolbar .
· Subtract Baseline is similar in function as in the Trace menu , the Trace Manipulation dialog

and the Analysis toolbar .
· Math with its sub entries is similar in function as in the Math menu .
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· Show Trace(s) Data in Excel opens the data corresponding to the selected traces in Microsoft
Excel™ if installed.
· Convert CD units… allows converting  CD data of a single trace into other units as in the Analysis

toolbar  and as Convert... in the Math menu  and the Trace Manipulation dialog .
· Toggle Full Screen.

8.3.3.11 The Standard Toolbar

Most of the icons of the Standard toolbar (Figure 81) are used to perform standard Microsoft Windows
functions.

Figure 81: The Standard toolbar

· New creates an empty plot in the Graphical Display.
· Save Current Plot opens the Save DataStore File dialog that allows you to save  the active

plotwith all settings and data, including hidden traces.
· Print opens the Print dialog that allows printing the active plot. 
· Export to Excel exports the data of the active plot to Microsoft Excel™ format.
· Copy copies the active plot to the clipboard for pasting into third-party software such as Microsoft

Word. 
· Help opens the user manual. You can browse the contents and search for specific words and

phrases.
· About opens the About Chirascan Viewer dialog, which gives the version number and other

information about Chirascan Viewer.

Some of the functions of the Standard toolbar are also accessible through the File menu  or the right-
click menu  of the Graphical Display.

Note that Cut, Paste and Undo functions are deprecated.

8.3.3.12 The Analysis Toolbar

The Analysis toolbar (Figure 82) is used for data analysis  and gives access to the following options:

Figure 82: The Analysis toolbar

· Toggle Selected as Baseline sets / unsets a selected trace as a baseline.
· Add Baseline becomes enabled once a baseline has been set and adds the baseline to one or

multiple selected traces. It is useful if a baseline has been subtracted inadvertently from a trace.
· Subtract Baseline becomes enabled once a baseline has been set and subtracts the baseline from

one or multiple selected traces.
· Fitting… opens the Curve fitting dialog enabling a model to be fitted  to a selected trace. 
· Average calculates and plots the average of the selected traces.
· Average All Traces calculates and plots the average of all the traces in the active plot. The original

traces are removed. Removed traces can be recovered using the Trace Manipulation dialog .
· Simple Math… opens the Simple Math dialog that enables you to apply simple calculations  on

traces.
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· Smooth… opens the Smoothing – Savitsky-Golay dialog that allows you to apply a smoothing
algorithm to one or multiple selected traces.
· Convert… opens the Convert CD Units dialog enabling you to convert  from millidegress or delta A

to other CD units.
· Selection Dialog… opens up the Trace Manipulation dialog .
· Select Trace Range opens the Visible Trace Range dialog that allows removing a subset of traces

as defined by a Start, End and Step for skipped traces as Thin Data in the Trace Manipulation
dialog  and Select Range... in the right-click menu  of the Graphical Display.
· Remove Overlaid Traces removes all overlaid traces .
· X Logarithmic toggles the scale of the x-axis between logarithmic and linear. This feature can be

useful when time is plotted on the x-axis, as is the case for kinetic data.
· Recompute Colours will assign new colors to the traces in the plot. This is useful if after trace

manipulation the colors of traces are not satisfactory.

Some of the functions of the Analysis toolbar are also accessible through the Trace menu , the Math
menu  or the Trace Manipulation dialog .

8.3.4 Data Manipulation

8.3.4.1 Trace Manipulation

The Trace Manipulation dialog (Figure 83) can be opened by clicking Selection Dialog… on the
Trace menu  or in the Analysis toolbar  or clicking Select Specific Traces... in the right-click
menu  of the Graphical Display .

Figure 83: The Trace Manipulation dialog
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The dialog is an environment for basic data analysis , in particular for data obtained in Manual
Mode , in which data (traces) can be baseline corrected, averaged or otherwise manipulated. All
operations carried out within this environment are reversible, which means that if errors are made they
can be quickly and easily corrected. The original data are never over-written or otherwise destroyed and
all operations carried out on data are recorded in the Histories tab on the Advanced Datastore Content
Info panel . The results of the manipulations are displayed in real-time and can be saved  at the end
of the session.

The structure of the dialog is straightforward. There are two lists, the Visible Traces list to the right
which contains any traces that are visible in the active Graphical Display , and the Removed Traces
list to the left containing those that have been removed from the Graphical Display  during the session
and are no longer shown. Traces can be swapped between the the two lists using the arrow buttons
between the two lists. The single arrow will move a selection, the double arrow will move all listed traces.

The buttons on the right execute actions on traces that have been selected in the Visible Traces list.
Some of these functions are also accessible in other menus or toolbars in Chirascan Viewer and
include: 

· Select All selects all traces as in the Trace menu  and Select All Traces in the right-click
menu  of the Graphical Display .
· Deselect All deselects all traces as in the Trace menu  and the right-click menu  of the

Graphical Display .
· Set Baseline sets the currently selected trace as the baseline as Toggle Selected as Baseline in

the Trace menu  and Set Selected as Baseline in the right-click menu  of the Graphical
Display . Once a trace has been set as baseline, the button label will change to Unset Baseline if
the current baseline trace is selected to allow revoking the baseline selection.
· Subtract Baseline subtracts the current baseline trace from the currently selected trace as in the

Trace menu  and the Analysis toolbar .
· Remove moves the selected trace(s) into the Removed Traces list as Remove Selected Trace(s) in

the Trace menu  and the right-click menu  of the Graphical Display .
· Remove Others moves the unselected trace(s) into the Removed Traces list as Remove

Unselected Trace(s) in the Trace menu  and the right-click menu  of the Graphical Display .
· Thin Data opens the Visible Trace Range dialog that allows removing a subset of traces as defined

by a Start, End and Step for skipped traces as Select Trace Range in the Analysis toolbar  and
Select Range... in the right-click menu  of the Graphical Display .
· Average averages the selected traces as in the Math menu , Math in the right-click menu  of

the Graphical Display  and Average Selected Traces in the Analysis toolbar .
· Simple Maths opens the Simple Math dialog that enables you to apply simple calculations  on

traces as in the Math menu , in the Math sub menu in the right-click menu  of the Graphical
Display  and Simple Maths... in the Analysis toolbar .
· Smooth allows smoothing  of traces as in the Math menu , in the right-click menu  of the

Graphical Display  and Smooth Selected Traces in the Analysis toolbar .
· Fit allows fitting  traces with a model as Fitting... in the Math menu , the Math menu in the

right-click menu  of the Graphical Display  and in the Analysis toolbar .
· Convert... allows converting  CD data into other units as in the Math menu  and the right-click

menu  of the Graphical Display  and Convert CD Units in the Analysis toolbar .

8.3.4.2 Simple Calculations

The Simple Math dialog can be opened by clicking Simple Math… on the Math menu  or in the
Analysis toolbar , clicking Simple Math... in the Math sub menu of the right-click menu  of the
Graphical Display , or clicking Simple Maths in the Trace Manipulation dialog .

37

174

103 121

106

106

124

111 106

124 111

106

124 111

106

124 113

124 111 106

124 111 106

113

111 106

125 111

106 113

115

125 111

106 113

116 125 111

106 113

117 125

111 106 113

118 125

111 106 113

125

113 111

106 114



116

Chirascan Q100 User Manual 
 
                                                                                                                   © 2023 Applied Photophysics Limited

Software

Figure 84: The Simple Math dialog

The dialog enables you to add to or subtract a constant from the selected traces or multiply or divide the
selected traces by a constant. It can be useful for offsetting one trace from another for display purposes
or for normalizing spectra for easier comparison.

Other simple data manipulation procedures like averaging or baseline subtraction can be accessed
directly through the Analysis toolbar , the right-click menu  of the Graphical Display , the Trace
Manipulation dialog , or the Math menu .

8.3.4.3 Smoothing

For final presentation of traces, smoothing can be applied to reduce noise. However, it is discouraged to
perform data manipulation for mere cosmetic reasons and data manipulation that is followed by
quantitative analysis should only include averaging and baseline subtraction.

To smooth data, first select  the trace(s) you wish to smooth and then open the Smoothing -
Savitsky-Golay dialog (Figure 85) by choosing Smooth... either in the Math menu , the Analysis
toolbar , the Trace Manipulation dialog  or in the Math menu in the right-click menu  of the
Graphical Display .

Smoothing is achieved with a Savitzky-Golay filter. For each data point in the original trace, this filter fits
the data within a certain data interval centered at this data point with a low-degree polynomial by the
method of linear least squares. The value of the fit function obtained for this data point is then used for
the smoothed trace. The value of the Window Size input field corresponds to the number of data points
on each side of a data point that are used for the fitting procedure.

This value will depend on the step resolution used during the measurement and the sharpness of the
features in the trace. The number should be as large as possible without causing distortion of the trace.
Examination of the residual plot will show if any distortion has occurred. If the noise is randomly
distributed about zero, the smoothing process has not caused any distortion and, importantly, you have
the evidence to prove it. 

An example of an appropriate smoothing, in which a window of 5 data points was used, and an
inappropriate one, in which a window of 12 data points was used on the same data set, are shown in
Figure 85. The structure in the residuals that arises when a window size of 12 was used indicates that
the example spectrum has been oversmoothed.
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Figure 85: An appropriate smooth (left) and an inappropriate smooth (right)

If you want the original trace(s) to be replaced by the smoothed trace(s), tick the Replace original
data with smoothed check box; however, it is recommended to always keep the original data. If you
keep the original data, you can choose to tick the Save Residual On Graph check box to obtain the
residuals as an additional trace in the Graphical Display . When you are satisfied with the smoothing
process, click OK. The smoothed trace will be labeled Smooth (s): 0, and the residuals will be labeled
Smooth (r): 0.

8.3.4.4 Curve Fitting

To apply a fit to a trace, first select  the trace and then open the Curve Fitting dialog either by
choosing Fitting... in the Math menu , in the Math menu in the right-click menu  of the Graphical
Display , in the Analysis toolbar  or Fit in the Trace Manipulation dialog .

A model is fitted to the data using a Marquardt-Levenberg algorithm. Select the required function from
the drop-down list on the Fitting Parameters panel and enter the range over which the data are to be
fitted on the Fit Range sub-panel, then click Set to confirm. If you are unsure about initial starting
parameters for the fit, click Estimate to automatically generate a set of initial parameters, which may
not be very accurate. The curve associated with these parameters is plotted in the preview panel to the
right.

To initiate the fitting of the parameters to the data, click Fit. The algorithm will iterate until convergence
or the maximum number of cycles is reached. If the fitting is successful, the parameters will be updated
and the calculated curve plotted in the preview panel. The associated residual trace (the difference
between the observed and calculated data) will be displayed in the Residuals part of the preview panel.
The errors associated with the calculated parameters are displayed next to the calculated parameters.
You will be able to judge the quality of the fit by inspecting the residual trace and the parameter errors. If
the errors are large compared with the parameters, then it is likely that you have specified a fitting
function which contains too few parameters to adequately describe the data, i.e. the model is
underfitted. 

The number of variable parameters can be reduced by locking any parameter using the check boxes
adjacent to the parameters (to set them as invariable, fixed parameters), but such locking must be
justified and should be applied with care. Note that Estimate should not be clicked after locking
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parameters as this will unlock and yield new estimates for all parameters. Locking a single parameter
and fitting repeatedly for different fixed values of this parameter can help to evaluate the suitability of the
fitting function; if this procedure does not result in a substantial increase of the RMS (root mean square),
this could indicate an overfitted model, i.e., a model that contains more parameters than justified by the
data.

If the fitting process does not converge within the selected maximum number of iterations, a warning is
given. You may wish to increase the number of iterations, up to a maximum of 1000. Be aware that 1000
iterations of the fitting algorithm may take some time. In some instances, the fitting does not converge
because of the absence of a unique solution. This too is symptomatic of an underfitted model.

Fitting of kinetic data obtained for the hydrolysis of glucuronolactone with potassium hydroxide with a
single exponential function is shown in Figure 86.

Figure 86: The Curve Fitting dialog

When you are satisfied with the fit, you can print out a report by clicking on the printer icon. The report
displays the data, the calculated fit data with residuals and the associated fitting parameters.

To plot the fitted curve in the Chirascan Viewer display, click OK. If you do not wish the residuals to be
included on the plot, untick the Include Residuals in Final Plot check box.

8.3.4.5 Converting CD Units

To convert CD data into another unit, first select  the trace(s) whose units you wish to convert and
then open the Convert CD Units dialog (Figure 87) by choosing Convert… either in the Math menu ,
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the Trace Manipulation dialog  or in the Math menu in the right-click menu  of the Graphical
Display , or by choosing Convert CD units... in the Analysis toolbar  or the right-click menu  of
the Graphical Display .

Figure 87: The Convert CD Units dialog

The CD units of the selected trace are shown in the Convert From box; the units you wish to Convert
To are chosen from the drop-down menu.

When converting between millidegrees (mdeg) and delta A, a scaling factor is used, and the conversion
requires no further input. When converting from mdeg or delta A to units that are normalized in some
way, further input is required.

To convert to delta epsilon or molar ellipticity the calculation normalizes for (and therefore requires
knowledge of) the Molarity of the solution and the Path Length (cm) of the cell.

For proteins, it is usual to normalize for the number of amino acid residues as well as concentration and
path length. When mean residue delta epsilon or mean residue molar ellipticity are selected, the
input required is the Concentration (mg/ml) of the protein, the Path Length (cm) of the cell used and
the mean residue molecular weight, Residue (MW). The default input for the latter is 113, a commonly
accepted value for the mean molecular weight of an amino acid residue. This default value can be
changed if required. The units are presented in this way to make it possible for proteins that are not yet
fully characterized to be normalized for comparative purposes.

8.3.4.6 Handling Multi-Dimensional Data

Plotting multi-dimensional Datastores is controlled using the Data Dimensions toolbar that includes the
Primary, Secondary and Value drop-down menus as well as the Show all check box (Figure 88). To
display the toolbar, on the View menu  choose Toolbars and check Data Dimensions.

For a two-dimensional Datastore (e.g. wavelength and repeat), the x-axis corresponds to the
independent variable of the first dimension, which is selected with the Primary drop-down menu, and the
set of traces displayed corresponds to that of the second dimension, which is shown in the Secondary
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drop-down menu. Only a single trace of the second dimension is displayed if the Show all check box is
unticked.

Figure 88: The Data Dimensions toolbar

For a three-dimensional Datastore (e.g., wavelength, repeat and temperature), the Secondary drop-
down menu becomes populated with two entries to choose from and is used to select the independent
variable of the third dimension. The Value drop-down menu is used to choose traces from the third
dimension (Figure 88). If the Show all check box is ticked, all traces corresponding to the third
dimension are displayed independent of the selection in the Value drop-down menu. Any independent
variable can be assigned to any of the three dimensions; therefore, there are six different possibilities to
display three-dimensional data.

Once multi-dimensional data are displayed as described, they can be manipulated  for analysis.

Multi-dimensional DataStores can be decomposed for subsets of the original data and the subsets saved
as new DataStores. The process is recursive, so higher-dimensional DataStores can be reduced to their
simplest one-dimensional forms if required.

To decompose a multi-dimensional DataStore, right-click  on the DataStore in the DataStore
Repository view  and select Decompose Data… from the menu. The Decompose Data dialog
appears (Figure 89).

Figure 89: The Decompose Data dialog

The Decompose Data dialog displays all dimensions together with the ranges they span. To trim the
range of an independent variable, provide the desired range limits in the Range Min and Range Max
input fields. To exclude a dimension, untick the corresponding Primary check box. The output will be
split up into separate DataStores for any excluded dimension.

Click Save as…, name the DataStore, and refresh  the launchpad tree view. A new repository is
created in the specified location containing the original DataStore and a hierarchy of subrepositories that
depends on the number of excluded dimensions. For example, if the data contains three repeat scans
and repeats are exlcuded, one subrepository is created containing three DataStore, each corresponding
to one of the three repeats. If, for example, also temperature was excluded, three subrepositories would
be generated, each corresponding to a single repeat and containing multiple DataStores, one for each
temperature.
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8.3.5 Saving and Exporting Data

8.3.5.1 Saving Data

Any data acquired in automated procedures  is stored in the repositories defined in the Experiment
Result Folder column of the Wells VIew . A different path for each well can be defined if required.

All data acquired in Manual Mode  is stored in the current Save to Repository. The current Save to
Repository is displayed in the Repositories dialog  which is opened through Data Store
Repositories in the Admin menu  of Chirascan Control .
To change the Save to Repository, select your folder of choice in the Repositories dialog and then
click on the Set as current Default Save Repository toolbar icon. Alternatively, right-click  a folder
of your choice in the Chirascan Viewer launchpad file list  and choose Set as Save to
Repository.Note that only repositories can be set as Save to Repository for the current user if they have
the corresponding write permissions .

File names for automated procedures  are defined in the Experiment Results Filename column of
the Wells VIew . File names for data acquired in Manual Mode  are defined in the File Names
dialog (Figure 90) which is opened through the Chirascan Control toolbar  and similar to the File
Names tab  in the Preferences dialog .

Figure 90: The File Names dialog

On the File Names dialog, seed names for spectra and backgrounds acquired in Manual Mode  can
be set. In a series of experiments, the file names will share the chosen seed name and be appended by
an automatically incremented number (four digits with leading zeroes) as set in the corresponding input
fields.

Which file name input field is used depends on the measurement mode. The names specified in the
Spectra, Kinetics and Spectra-Kinetics input fields are used for the corresponding sequencing
modes . The name specified in the Baseline field is used when acquiring a background . The
remaining input fields are used only in conjunction with corresponding accessories. Note that entering
special characters (i.e., any of the following: */?;:.,"|=<>) is not allowed.
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If you have performed operations  in Chirascan Viewer (e.g. smoothing, averaging or baseline-
subtraction), added comments , or altered the data in any other way, you may want to save the
results of the manipulation.
 
The manipulated data are not saved automatically. To save the result, go to Save Current Plot on the
File menu  and choose Save Current Traces, Save Visible Traces or Save Selected Traces to
call up the Save DataStore File dialog. This saves the active plot, the visible traces or the selected
traces, respectively, in the Graphical Display , including all settings and data.

The original data are never over-written. If a new name is entered in the File Name input field, the plot
will be saved under that name. If an existing name is entered, the plot will be saved as a revision  of
the corresponding Datastore. 

Complete information about the manipulated traces, including acquisition settings , remarks  and
History of data manipulation , is saved with a Datastore, and can be viewed on the Advanced
Datastore Content Info panel .

8.3.5.2 Exporting Data

Data can be exported to various formats for use with other Applied Photophysics products or third-party
software. Right-click  on a Datastore in the DataStores Repositories view  and choose Export to
Proprietary Format to bring up the DataStore export from Database dialog (Figure 91). 

Figure 91: The DataStore export from Database dialog

Choose an appropriate format from the drop-down list for export to another program. Comma-Separated
Values (CSV) format is suitable for use with third-party programs such as Microsoft Excel™; whereas
the ProDataCSV format includes header information with measurement settings and remarks as well as
complete multi-dimensional data, the SimpleCSV format lacks header information and includes only
one-dimensional data. Other options relate to formats derived from other Applied Photophysics products.
Data can also be exported to Excel format from the standard toolbar .
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8.3.6 The Graphical Display Menu Bar

The menu bar of the Graphical Display  can be displayed or hidden using the right-click pop-up
menu  or hidden using the View menu .

8.3.6.1 The File Menu

The File menu (Figure 92) gives access to the usual Microsoft Windows options for opening, closing and
printing files:

· New creates an empty plot in the Graphical Display .
· Close closes the active plot in the Graphical Display .
· Save Current Plot provides three options to save the active plot with all settings and data: Save

Current Traces saves the active plot, including both visible and hidden traces. Save Visible Traces
saves the active plot, including only visible traces. Save Selected Traces saves only the traces
selected in the active plot.
· Copy to Clipboard copies the active plot for pasting into third-party software such as Microsoft Word.
· Print opens the Print dialog that allows printing the active plot.
· Exit closes Chirascan Viewer.

Figure 92: The File menuand SaveCurrent Plut sub menu

Some of the options of the File menu are also accessible through the Standard toolbar  or the right-
click menu  of the Graphical Display .

 Note that Delete and Rename are deprecated.

8.3.6.2 The Edit Menu

There are no enabled options on the Edit menu (Figure 93) except:

· Copy to Clipboard copies the active plot for pasting into third-party software such as Microsoft Word.
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Figure 93: The Edit menu

Note that any other entries in this menu are deprecated.

8.3.6.3 The View Menu

The View menu gives access to the following functions (Figure 94):

· Menu bar, Status bar and the entries of the Toolbars submenu toggle visibility of the menu bar ,
status bar  and toolbars .
· Data Stores Explorer View and DataStores Repositories View open the Datastores file list in the

Microsoft Windows file system and the repositories, respectively.
· Windows Explorer is similar to DataStores Explorer View, but expands the view to show more file

information.
· Error opens a submenu that allows to set the display properties of the standard error .

Some of the options of the View menu are also accessible through the right-click pop-up menu .

Figure 94: The View menuand Toolbars sub menu

8.3.6.4 The Trace Menu

The Trace menu gives access to the following functions (Figure 95):

· Show Trace Name toggles visibility of the name of a highlighted trace when the mouse pointer is
placed near to it.
· Selection Dialog... opens up the Trace Manipulation dialog .
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· Select All selects all traces in the active plot.
· Deselect All deselects all traces in the active plot.
· Remove Selected removes from the active plot any currently selected trace. Removed traces can be

recovered using the Trace Manipulation dialog .
· Remove Unselected removes from the active plot any trace that is not selected. Removed traces can

be recovered using the Trace Manipulation dialog .
· Toggle Selected as Baseline sets / unsets a selected trace as a baseline.
· Add Baseline becomes enabled once a baseline has been set and adds the baseline to one or

multiple selected traces. It is useful if a baseline has been subtracted inadvertently from a trace.
· Subtract Baseline becomes enabled once a baseline has been set and subtracts the baseline from

one or multiple selected traces.
· Remove Overlaid Traces removes all overlaid traces .
· Recompute Trace Colours will assign new colors to the traces in the plot. This is useful if after trace

manipulation the colors of traces are not satisfactory.
· Clear plot will remove all data from the active plot. Note that there is no possibility to restore the

original plot.

Figure 95: The Trace menu

Some of the options of the Trace menu are also accessible through the Trace Manipulation dialog ,
the Analysis toolbar  or the right-click menu  of the Graphical Display .

8.3.6.5 The Math Menu

The Math menu gives access to the following functions (Figure 96):

· Fitting… opens the Curve fitting dialog enabling a model to be fitted  to a selected trace. 
· Average. calculates and plots the average of the selected traces.
· Average All Traces. calculates and plots the average of all the traces in the active plot. The original

traces are removed. Removed traces can be recovered using the Trace Manipulation dialog .
· Simple Math… opens the Simple Math dialog that enables you to apply simple calculations  on

traces.
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· Smooth… opens the Smoothing – Savitsky-Golay dialog that allows you to apply a smoothing
algorithm to one or multiple selected traces.
· Convert… opens the Convert CD Units dialog enabling you to convert  from millidegress or delta A

to other CD units. 

Figure 96: The Math menu

Some of the options of the Math menu are also accessible through the Trace Manipulation dialog ,
the Analysis toolbar  or the right-click menu  of the Graphical Display .

8.3.6.6 The Experiment Menu

The Experiment menu gives access to a single entry, Open Experiment File, which opens the Open
Experiment File dialog (Figure 97). This dialog presents a list of automated experiments that have been
carried out. Each time an automated experiment is ran in the Chirascan software, an experiment file is
created. 

Figure 97: The Open Experiment File dialog

The experiment file contains all information related to the automated procedure so that it is possible to
trace back the steps that were taken to generate a particular Datastore in a way that is more intuitive
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than using the CFR Actions Audit Trail . The dialog lists experiment files chronologically and includes
the following columns:

· File ID is a unique identifier for each experiment file.
· File Name includes data and time of the experiment.
· Repository gives the repository where the last datastore obtained in the experiment has been saved.
· DataStores gives the total number of DataStores that have been created during the experiment.

Selecting the entry for an experiment file in the list and clicking OK opens the Experiment File dialog
(Figure 98). This dialog mirrors the information that has been provided when the experiment was set up
in the Wells View : the lower panel provides a list with one Result entry for each well of the
experiment. The Result entries are preceded by an Application entry specifying which Application
file  has been used for the experiment, a Comment entry specifying the instrument serial number,
and a BaseLine entry corresponding to the background measurement at the beginning of the
experiment.

Figure 98: The Experiment File dialog

168

143

132



128

Chirascan Q100 User Manual 
 
                                                                                                                   © 2023 Applied Photophysics Limited

Software

Upon selecting any entry in the list, the upper panel in the dialog provides more detailed information
about the selected entry. If a Result entry is selected, the additional information includes:

· Well id: The number of the well
· Rack Name: The rack the well was located in
· Template: The experimental template used for acquisition
· FileName: The name of the Datastore created
· Repository: The repository where the Datastore has been saved

A selected Result entry can be plotted in Chirascan Viewer by clicking Plot.

Comment entries with custom user comments can be added to the list by clicking Add Comment and
edited by clicking Edit Comment.

The information of an experiment file can be printed by clicking the printer button in the top right corner.

Alternatively, the Open Experiment File dialog can be opened through the Experiment menu  in
Chirascan Autosampler .

8.3.6.7 The Scale Menu

The Scale menu gives access to the following functions (Figure 99):

· Set Plot limits… calls up the Select Range dialog that enables you to set  the limits for the x-
and y-axes.
· Reset Zoom resets  the scale to the original display size.
· On-line Auto-scale toggles automatic scaling so that any traces are always fully visible.
· X Logarithmic toggles the scale of the x-axis between logarithmic and linear. This feature can be

useful when time is plotted on the x-axis, as is the case for kinetic data.

Figure 99: The Scale menu

8.3.6.8 The Preferences Menu

The Preferences menu (Figure 100) is used to set the conditions for the graphics display and on-line
status and gives access to the following functions:

· Single Window when selected means that whenever a new tab of the Graphical Display  is
opened during data acquisition, the previous one is closed. If it is not selected, then whenever a new
measurement is made, the previous tab will remain open. If you are running an experiment that
involves a lot of measurements, it is recommended that Single Window be selected; if not, you could
end up with a large number of tabs. Single Window has no effect when opening files from the
database.
· Go On-line… will display the Connect... dialog (Figure 101) on which you will be asked to supply the

Chirascan IP Address. It is used when Chirascan Viewer has been started as a stand-alone program
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and you want subsequently to establish a link with the SCP . If the two programs are running on the
same computer, select Local in the Connect… dialog. The IP address under these circumstances is
always the default 127.0.0.1. 
· Show Online Plots on Same View when enabled means that whenever data acquisition starts, the

new data is displayed in the previous plot and overlaid with data from previous acquisitions. Show
Online Plots on Same View can be selected only if Single Window is enabled.
· Diagnostics is a submenu that only gives access to View Program Log, which is used for

diagnostic purposes.

Figure 100: The Preferences menu

The client-server architecture permits remote monitoring of measurements in progress. If a copy of
Chirascan Viewer is installed on a remote computer, establishing a client-server link by using the
Remote setting will enable you to follow a measurement on the second computer. 

The IP address of the Chirascan computer will not be the same as the default local IP address – your
network administrator will be able to inform you. If the address is correct and the instrument is running,
the Chirascan Viewer display panel will open. Chirascan Viewer will ‘listen’ to Chirascan Control and
report its status, behaving as a real-time display. If the address is incorrect, an error message will
appear.

Once the link between Chirascan Viewer and the SCP  has been established, Go On-line… will be
ticked and the Chirascan Viewer status bar  will read Ready (On-line).

Figure 101: The Connect... dialog

8.3.6.9 The Window Menu

The Window menu gives access to the following functions (Figure 102):

· New Window… opens a list from which a desired property can be selected. The new window will be
displayed at the same time as the original window in a tile format.
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· Cascade will display in a cascade format all property windows (e.g. CD, absorbance, HT) that have
been opened and are not currently minimized. 
· Tile horizontally will display in a horizontally tiled format all property windows (e.g. CD, absorbance,

HT) that have been opened and are not currently minimized.
· Tile vertically will display in a vertically tiled format all property windows (e.g. CD, absorbance, HT)

that have been opened and are not currently minimized.
· Arrange icons will tidy up any minimized property displays that have been strewn around the

Graphical Display .
· 1, 2 etc. refer to the open property windows: the displayed window is identified by the check icon.
· Windows… opens a dialog that allows activating a property window and closing, saving, cascading,

minimizing or tiling property windows selected from a list.

Figure 102: The Window menu

8.3.6.10 The Help Menu

The Help menu gives access to the following functions (Figure 103):

· Help… opens the user manual. You can browse the contents and search for specific words and
phrases.
· About Chirascan Viewer… opens the About Chirascan Viewer dialog, which gives the version

number and other information about Chirascan Viewer.

Figure 103: The Help menu

106



131

Chirascan Q100 User Manual 
 
                                                                                                                   © 2023 Applied Photophysics Limited

Software

8.4 Chirascan Autosampler

This section describes the Chirascan Autosampler program, the purpose of which is to create, edit, load
and run procedures for automated liquid handling. Chirascan Autosampler is part of the Chirascan
software platform architecture  together with other software components.

8.4.1 Introduction

8.4.1.1 Launching Chirascan Autosampler

If the USB connection has been made between the PC and the instrument, two-way communications
between Chirascan Autosampler and the autosampler will be established when Chirascan Autosampler
is launched. If there is no connection between the PC and the autosampler, Chirascan Autosampler can
be opened in Emulation Mode. Emulation Mode can be used for creating, editing and saving
spreadsheets for automated procedures on a PC remote from the autosampler and does not require the
autosampler to be powered on. For use in Emulation Mode, load the Application file
 default_norob.jsa.

8.4.1.2 The Chirascan Autosampler Window Layout

By default, Chirascan Autosampler opens with a window arranged as shown in Figure 104. Besides the
menu bar  at the top, this screen has the following three panels:

· The main panel at the top left showing the Racks and Hardware tab.
· The Actions panel to the right.
· The information panel at the bottom that can contain the Activity Log, Script Error, Wells View and

Robot Methods Activity View windows.

Figure 104: The Chirascan Autosampler window

The Wells View is used for setting up  automated experiments and the Robot Methods Activity
View indicates the current autosampler actions during such experiments. The Activity Log and the
Script Error windows provide detailed information on the actions being carried out by the autosampler
and are primarily used during service activities.
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The menu bar, Actions panel  and the tabs of the information panel can be hidden or shown by using
a context menu (Figure 105) that opens by right-clicking on the menu bar area or on the title of a panel.
Panels are movable and dockable in the usual Windows way.

Figure 105: The right-click menu

The Racks and Hardware tab  to the left gives access to two sub tabs, Racks and Hardware. The
Racks tab gives further access to two windows, Setting Up and Rack stage.

8.4.1.3 Chirascan Autosampler Configuration

The configuration of the autosampler is defined by Application definitions (stored as Application files
with a .jsa extension, JRun Server Application) which are stored in the SQL database. The name of the
currently loaded Application definition is shown on the title bar of Chirascan Autosampler. An Application
definition originates from two files:

· Implementation files (.jsi file format, default name: jsrobotimpl.jsi) contain the set of robot operations
that are available through the Actions panel  and definitions for the methods associated with these
operations.
· Settings files (.ini file format, default name: settings.ini) contain settings specific to a particular

autosampler, such as coordinates for racks, cell cartridges, the probe wash station and other
positions of the autosampler (local variables ) as well as hardware parameters like pump speeds
(global variables ).

Default methods and settings have been predefined by Applied Photophysics and should be adequate for
most autosampler applications. However, each time an Application definition is modified, for example,
after updating coordinates  of a cell cartridge, the changes must be saved. Application definitions are
stored with a revision  system similar to experimental templates and Datastores, which basically
means that existing Application definitions cannot be overwritten as changes to an existing Application
definition will be saved as a new revision. In this way, a record of all Application definitions that could
have been used to generate data is kept. Upon startup of Chirascan Autosampler, the Application file
that has been used most recently is automatically loaded.

The most recently used Application definition which is loaded upon software
start-up is not user-specific, i.e. if another user has loaded a new Application
file, next time any user starts the software, this new one will be loaded.
Therefore, settings such as rack coordinates might be different to what a user
has defined before!
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If changes to the autosampler configuration are required, Application definitions can be opened, and
Implementation and Settings files imported or exported by using the File menu .

8.4.2 The Racks and Hardware Tab

The system variables used by the autosampler can be set using Chirascan Autosampler. These
variables include the x, y, z coordinates of the autosampler components (microplate  wells, wash
stations, cell cartridges  etc.), aspiration and dispense volumes and speeds, air gap  volumes and
speeds, incubation and equilibration times, and so on. 

Chirascan Autosampler defines two types of variables: global variables used for general liquid handling
operations, and local variables, used for x, y, z coordinates of individual items, and the liquid handling for
specific sample cells. Global variables are set on the Hardware tab, local variables are set on the
Racks tab.

For example, the Dispense Speed set on the Hardware tab controls the rate that the syringe pump
dispenses liquid at during well filling from an auxiliary stage, whereas the Inject Speed, set on the
Racks tab, can be set differently for each sample cell type, and controls the rate at which sample is
injected into the cell.

There are two windows on the Racks tab, the Setting Up  window  and the Rack Stage
window : these can be opened or closed using the ribbon tabs to the left of the windows.

8.4.2.1 Setting the Local Variables: The Setting Up Window

The Setting Up window for a cell is shown in Figure 106.

Any changes to autosampler settings must be confirmed by clicking Apply to
take effect. Otherwise, subsequent autosampler actions or procedures will use
previous settings and therefore might result in unexpected behavior that could
result in damage to the probe.

The Apply button is disabled as long as no changes have been made to the current Application file
and becomes enabled as soon as any changes have been made but not applied yet. Confirming any
changes requires saving a new Application definition  or a new revision  of the current one.
Alternatively to clicking Apply, changes can be confirmed by clicking Save on the File menu  which
will save changes as a new revision of the current Application file. Settings can also be saved as a new
Application file by clicking Save As… in the File menu .

If a cell cartridge has been replaced  by a different one, click Detect Cell to let the software detect
the flow cell cartridge. The lower part of the Setting Up window will automatically be populated with the
settings specific to the installed flow cell.

If a new cell cartridge has been installed  for the first time, the Detected Cell Setup dialog will
appear to query the user for initial configuration of the flow cell. The parameters that must be provided in
this dialog are similar to those found in the Setting up window. To receive the parameters required for
initial configuration of a new flow cell, please contact Applied Photophysics. 
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Figure 106: The Setting Up window with cell selected

8.4.2.2 Setting the x, y, z positions

The autopositioner x, y, z coordinates of the sample cell, microplate wells, wash station and so on, need
to be calibrated before the autosampler is used for the first time. The coordinates will have been factory
set for a new system but may need recalibration if a new item is installed, for example an auxiliary
stage, or if a probe is changed. It is also recommended to recalibrate the coordinates of the injection
port each time the cell cartridge has been exchanged .

Although the coordinates are factory set, the probes may vary in length, and it
is suggested that recalibration is carried out if a new probe or cartridge is
fitted, or if any position appears to have changed. Failure to do so may result
in damage to the autosampler.
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The moving parts of the autosampler could cause serious injury to the user or
damage to the instrument. For safe operation the moving parts are contained
within an enclosure fitted with an interlock device, which is engaged while the
autosampler is operating. Do not attempt to open the enclosure door upon
autosampler operation or to override the interlock device. In some
circumstances, for example when manually adjusting the position of the probe,
it may be possible to move the autosampler arm using the autosampler
software while the enclosure door is open. Do not use the software to move
the autosampler arm while the enclosure door is open. Do not operate the
autosampler without the removable panels at the lower front, side and rear in
place. Do not introduce any object through the brush panel ports on the rear of
the autosampler while the autosampler is operating.

To calibrate the coordinates of a position, select the corresponding item from the Racks drop-down
menu at the top left of the Setting Up  window. If coordinates for a new item are to be calibrated, the
new item can be added to the drop-down menu by clicking New Rack. Existing racks can be deleted by
using Delete. 

If a flow cell is installed, its ID number  becomes available as an item in the Racks drop-down menu. 

The autopositioner coordinate settings for the selected item will be displayed on the upper half of the
Setting Up  window. The units are in millimeters, with the zero positions being to the left for the x-
axis, to the rear for the y-axis, and fully down for the z-axis. Note that the maximum travel of the
autopositioner on the z-axis is 209.9 mm, with 0 defined as fully down, and 209.9 mm as fully up.

The positions of cells, auxiliary stages (tubes), and the drain and wash positions of the wash station are
defined by single x- and y-coordinates, which are listed as X-First and Y-First, respectively. The
positions of racks are defined by the x- and y-coordinates of the first (A1) and last (H12) wells in the
microplate , and both these positions need to be defined. These are listed as X-First, Y-First and X-
Last, Y-Last respectively. The positions of the remaining wells are then automatically interpolated taking
into account the numbers of Columns and Rows. This information is summarized in Table 3. The order
of microwells can be reversed so that A12 is the first well and H1 the last well by unticking the
Front/Rear check box. By default, this check box is ticked.

Table 3: Summary of the x- and y-coordinates required for each position

Position X-First Y-First X-Last Y-Last

96 well plate Well A1 Well A1 Well H12 Well H12

Cell x-position y-position Not used Not used

Auxiliary stage (tube) x-position y-position Not used Not used

Wash station wash x-position y-position Not used Not used

Wash station drain x-position y-position Not used Not used

To calibrate the x- and y-coordinates for a position, choose the corresponding item in the Racks drop-
down menu and click the arrow button to the side of the X-First box. A message dialog will appear to
indicate that calibration be performed by the user.

The arm can now be moved manually on three axes. Move the probe to the correct x- and y-position and
click OK. For microplates, now click the arrow to the side of the X-Last box and repeat.

The z-coordinate for each position is set as Z-Max. This is the lowest position that the probe will move
to at each position. For cells it is the position at which sample will be dispensed; for wells and tubes, it
is the position at which sample will be aspirated, unless Liquid Detection is selected on the Hardware
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tab . To set the Z-Max coordinate, find the point at which the probe lightly bottoms at that position,
and add the increments suggested in Table 4 to the value in the Z-Max box.

Table 4: Suggested Z-Max positions for each cell

Position Z-Max above bottom

Well 0.5

Injection port (short path
length cell)

-0.05

Long path length cell 20

Wash station wash 0.5

Wash station drain Not applicable

Adding a negative value to the z-coordinate of the injection port ensures that the probe applies the
necessary pressure to create a seal during sample loading.
There is no bottom to the wash station drain position: Z-Max should be with the probe tip about 25 mm
below the top of the station.

There are three additional z-axis boxes on the same window. These are for the operations described
below. 

· Z-Travel: maximum z-position at rest (209.9 is normally set as being just within the fully up limit).
· Z-Start: position at which the probe slows down when moving to Z-Max: if Liquid Detection is

selected on the Hardware tab , this is the point at which the probe will slow down when moving to
locate the sample surface.
· Z-Dispense: position at which sample is dispensed into a well. This should be set to about 10 mm

above the bottom of the well.

Other settings are: 

· Diameter/Side: used to calculate the change in the sample surface position during aspiration, so that
the probe can maintain the depth set on the Submerge setting (below); the well is modeled as a

cylinder, so the volume is calculated as π·(d/2)2·z.
· Submerge: the distance below the surface of the sample to which the probe will penetrate before

aspiration. This is used in conjunction with the Liquid Detection option on the Hardware tab .

8.4.2.3 Setting the Cell Variables

The local variables for a cell are set on the lower half of the Setting Up  window.

Variables for all cells are:

· Recover volume: volume of sample to be recovered from the cell on completion of the procedure if
the cell wash method  CellWashRecycle is chosen.
· Aspirate volume: volume of sample aspirated (taken up) from the microplate.
· Conditioning volume: volume of the sacrificial conditioning sample.
· No. Conditioning volume: number of conditioning volumes.

Variables for flow cells only are:

· Header volume: difference between the dispensed volume and the aspirated volume. 
· Inject Speed: speed at which sample is injected into a cell.
· Inject Speed Clean: speed in µl per second at which cleaning fluid is injected into a cell.
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In addition to the aspirated volumes, allowance should be made for at least 50 µl of sample to remain in
the microplate well.

Suggested parameters for closed and open flow cells are given in Table 5. Note that the Remainder and
Total volumes are not enterable parameters but are included to indicate the typical total sample volume
required for each cell.

Table 5: Suggested parameters for closed and open flow cells

Cell path length 0.1 mm 0.2 mm 0.5 mm 1.0 mm 5.0 mm 10.0 mm

Recovery volume (µl) 35 45 67 105 500 800

Aspirate volume (µl) 35 45 67 105 500 800

Conditioning volume (µl) 4 6 7 6 25 25

Number of conditioning
volumes

1 1 1 2 2 2

Header volume (µl) 2 2 2 2 N/A N/A

Remainder (µl) 60* 60* 50 50 50 50

Total volume (µl) 101 113 124 167 600 900

Inject speed (µl/s) 40 60 60 80 N/A N/A

Inject speed clean (µl/s) 40 40 40 40 N/A N/A

Diameter (mm) N/A N/A N/A N/A 5.046 7.979

*For the two shortest path length flow cells, larger remainder volumes are indicated because it is
recommended to load microplate wells with volumes increased by about 10% of the total volumes
required to account for the fact that absolute variations in volume potentially resulting from aspiration or
evaporation etc. have a larger relative effect on small samples as compared to large samples. Moreover,
greater total volumes may be required if interactions between the sample and the microwell plate result
in formation of an extremely concave meniscus at the sample-air interface.

The diameter parameter for open flow cells is the equivalent diameter of a cylinder with the same cross
sectional area and is used to calculate the depth per volume during sample recovery.

8.4.2.4 Viewing the Installed Racks: The Rack Stage Window

The Rack Stage window  (Figure 109) gives a visual representation of the microplate racks and other
items installed on the autosampler. The window is used with the spreadsheet of the Wells View  to
create  an automated autosampler procedure.

8.4.2.5 Setting the Global Variables: The Hardware Tab

Global system variables of the autosampler are set on the Hardware tab (Figure 107). Note that this tab
is enabled only for Administrators.

The default settings have been found to work well for a wide range of samples, and it is normally not
necessary to change them. However, it may be necessary to change them, for example, for high
viscosity samples or samples that tend to form bubbles during aspiration, or to extend the equilibration
or cleaning times.

Any changes made on the Hardware tab must be confirmed by clicking Apply to take effect, which
requires saving a new Application definition  or a new revision  of the current one.
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Figure 107: The Hardware tab

System Global Variables

· Equilibration Time: duration between sample loading and acquisition.
· Cell Dry Time: time the vacuum pump is on to remove residual organic cleaning agent from the cell. 
· Cleaning Incubate: time that the cleaning detergent is in the cell before being rinsed out. 
· Pump Delay: time that the syringe pump is idle between operations. 
· Conditioning Air Gap: volume of the air gap between the control fluid and the conditioning sample.
· System Volume: maximum volume of fluid including control fluid, conditioning volumes and aspirated

sample volume. If this value is too large, the system could become contaminated.
· Retract Speed: speed at which the probe is withdrawn from sample wells. 

Pump

· Aspiration Speed: speed at which the sample is aspirated (taken up) by the syringe pump.
· Dispense Speed: speed at which the sample is dispensed by the syringe pump.
· Mix Speed: speed at which the sample is mixed in the microplate well; the mixing function is used

during titrations, for example.
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· Liquid Detection: the probe is able to detect the surface of the sample; this function is enabled by
default and can be used together with the Submerge variable on the Racks tab  to prevent the
outside of the probe from becoming contaminated by entering the sample too deeply, when performing
titrations or multiple samplings form the same well, for example.

Diaphragm pump peak flow rates

· Water: speed at which the water is pumped by the water diaphragm pump.
· Cleaning solution: speed at which the cleaning solution is pumped by the cleaning solution

diaphragm pump.
· Solvent: speed at which the solvent is pumped by the solvent diaphragm pump.

General

· Syringe Size: total volume of the syringe pump.
· Pump Type: type of the syringe pump.

Airgaps

· Leading Air Gap: volume of the air gap between the conditioning sample and the main sample.
· Travel Air Gap: volume in µl of the air gap aspirated after the main sample to prevent the sample

leaking from the probe during transport to the cell.
· Airgap Speed: speed at which the air is aspirated into the probe.
· Excess Volume: difference in µl between the aspiration and dispense sample volumes; it is unlikely

that a non-zero value for this variable will be needed in normal operation of the autosampler.

· Global Z-Travel: the maximum travel allowed for the probe in z-direction unless overridden elsewhere;
there is normally no reason to change the default value.

The settings on the General panel refer to installed components of the
autosampler and should not be changed unless the corresponding
components are changed.

8.4.3 The Actions Panel

The Actions panel (Figure 108) on the right side of the Chirascan Autosampler screen contains several
sub-panels that can be clicked to reveal access to a number of actions implemented as scripts. These
are used to execute short autosampler procedures or control individual components of the autosampler.
Note that most of the actions are required for servicing only. Execution of a script started through the
Actions panel can be stopped by clicking Stop All Actions in the Experiment menu  of Chirascan
Autosampler.

Stopping all actions might result in unexpected behavior; therefore, it is
recommended to close down and re-open the software to re-initialize the
autosampler after using this function.
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Figure 108: The Actions panel with the autosampler sub-panel opened

8.4.3.1 Syringe Pump

· ChangeSyringe calls up a wizard that guides through steps required for exchanging the syringe
pump (servicing only).

8.4.3.2 Cell Actions

· CloseShutter closes the shutter  of the sample chamber.
· OpenShutter opens the shutter  of the sample chamber.
· FillCell fills the installed cell with liquid from position tube1 (servicing only).
· TestingCellShutter starts a testing protocol  for the shutter of the sample chamber.
· ShutterWorkout starts a testing protocol  for the shutter of the sample chamber.
· CellWashHeating performs a more rigorous cell cleaning protocol including a long incubation with

detergent at an elevated temperature.
· CleanCell performs a standard cell cleaning protocol
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8.4.3.3 Chirascan

· TakeBaseline starts acquisition of a baseline as done at the beginning of an autosampler procedure.
· TitrationGuHCl sets up a microwell plate for preliminary chemical denaturation experiments; uses

solutions from positions tube1 (protein), tube2 (buffer) and tube3 (guanidine hydrochloride). 

8.4.3.4 Run Settings

· ReportRepeats shows a dialog giving the number of how often an autosampler procedure is executed.
· ResetRepeats sets the number of how often an autosampler procedure is executed to 1.
· Increase_Repeats increases the number of how often an autosampler procedure is repeated by 1.
· Decrease_Repeats decreases the number of how often an autosampler procedure is repeated by 1.
· RunBaselineFirstOn activates acquisition of a baseline at the beginning of autosampler procedures.
· RunBaselineFirstOff deactivates acquisition of a baseline at the beginning of autosampler

procedures.
· RunCellWashOn activates execution of a cell wash at the beginning of autosampler procedures.
· RunCellWashOff deactivates execution of a cell wash at the beginning of autosampler procedures.
· VerifyExperimentOn activates checking the validity of cell contents of the Wells View

spreadsheet at the beginning of autosampler procedures.
· VerifyExperimentOff deactivates checking the validity of cell contents of the Wells View

spreadsheet at the beginning of autosampler procedures.
· VerifyWellsView checks the validity of cell contents of the Wells View  spreadsheet.
· ShutDownLampOn activates shut down off both lamp and nitrogen flow at end of autosampler

procedures (not yet supported by the ANMS).
· ShutDownLampOff deactivates shut down off both lamp and nitrogen flow at end of autosampler

procedures (not yet supported by the ANMS).

8.4.3.5 Solenoid Valve

· OpenWasteValve opens the waste valve of the 3-way solenoid in the downstream flow system .
· CloseWasteValve closes the waste valve of the 3-way solenoid in the downstream flow system .
· OpenVentValve opens the vent valve of the 3-way solenoid in the downstream flow system .
· CloseVentValve closes the vent valve of the 3-way solenoid in the downstream flow system .
· OpenVacuumValve opens the vacuum valve of the 3-way solenoid in the downstream flow

system .
· CloseVacuumValve closes the vacuum valve of the 3-way solenoid in the downstream flow

system .
· RunVacuum starts the vacuum pump.
· VacuumOff stops the vacuum pump.

8.4.3.6 Autosampler

· ParkAutosampler parks the autopositioner at the very right and back of the autosampler.
· PrimeSystemQuick primes the system with water, detergent and solvent (3 mL each) and performs a

probe wash. Priming steps with detergent and solvent are each followed by water priming.
· PrimeSystemLong primes the system similar to PrimeSystemQuick, but volumes of initial priming

steps are increased to 30 mL each and protocol is performed twice.
· PrimeSystemSuperLong primes the system similar to PrimeSystemQuick, but volumes of initial

priming steps are increased to 30 mL each and protocol is performed three times.
· RunWaterPump delivers 10 mL from the water pump at the current probe position; used for liquid

handling test procedure (servicing only).
· RunCleansoInPump delivers 10 mL from the detergent pump at the current probe position; used for

liquid handling test procedure (servicing only).
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· RunSolventPump delivers 10 mL from the solvent pump at the current probe position; used for liquid
handling test procedure (servicing only).
· TitrationGuHcl executes a script  for preparation of microwell plates for chemical denaturation

experiments.
· SetDistValveToOne moves the 6-port valve in the upstream flow system repeatedly between position

one to six (servicing only).
· Valve1 moves 6-port valve in the upstream flow system  to position one (servicing only).
· Valve2 moves 6-port valve in the upstream flow system  to position two (servicing only).
· PauseExecution pauses  a running autosampler procedure.
· ResumeExecution resumes  a paused autosampler procedure.

8.4.3.7 Validation

· ValidateLiquidSensing validates the liquid detection function  using position tube1 (servicing
only).
· TestingCellShutter alternatingly opens and closes the shutter  of the sample chamber multiple

times with the probe moving in and out (servicing only).
· ShutterWorkout performs the same testing protocol as TestingCellShutter, but without probe

movement (servicing only).
· WasInitializationSuccessful checks if all components of the autosampler have been initialized

correctly.
· ValidateTempProbe checks for correct temperature readings by the internal temperature probe  of

the sample chamber.
· ValidateSampleChamber checks for correct function of the Peltier element  of the sample

chamber by ramping the temperature up and down.
· ValidateDispense transfers 500 µL from position tube2 to position tube1; used for liquid handling

test procedure (servicing only).

8.4.3.8 Data

· AverageAlternating performs automated data analysis  similar to AverageAll, but assuming
alternation  of buffer and sample wells.
· ExportCD exports CD data as a CSV file (comma separated value) into the subpath ..

\documents\mydata for all entries listed in the Experiment Result Folder and Experiment Result
Filename columns of the Wells View .
· ExportAbsorbance exports Absorbance data similar to ExportCD.
· ExportFluorescence exports Fluorescence data similar to ExportCD. Only applied to data obtained

with the Fluorescence Emission Monochromator accessory, not with the CCD Emission Fluorometer.
· ExportHT exports HT data similar to ExportCD.
· ExportTemperature exports Temperature data similar to ExportCD.
· ExportVoltage exports Voltage data similar to ExportCD.
· AverageAll performs automated data analysis  including averaging of repeat scans and baseline

subtraction.

8.4.4 Running an Autosampler Procedure

8.4.4.1 Creating the Procedure Spreadsheet

Before setting up an autosampler procedure from the Wells View  spreadsheet, all the wells to be
used have to be selected in the Rack Stage window . Selected wells are highlighted yellow (Figure
109). Wells can be selected the following ways:
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· Select a block of wells by shift-left-clicking and dragging the mouse to draw a selection box around
the wells to be selected. Any previous selections will be replaced.
· Select individual wells by ctrl-left-clicking on them.

Ctrl-left-click on a well that has been previously selected to deselect it. Use ctrl-shift-left-clicking and
drag the mouse to draw a selection box while keeping the previous selection.

For each selected well, a row in the Wells View  will be created, and all rows together constitute a
spreadsheet (Figure 109). If the Wells View  is hidden, use the right-click menu  to open it.

Wells are always used according to the following rules:

· Racks are always used from left to right.
· Wells of a given Rack are always used in ascending order of Well ID.
· Wells the corresponding rows of which in the Wells View are not populated will be skipped.

For example, if the spreadsheet would contain, from top to bottom, rows for Well IDs 4 and 3 of Rack 2
followed by Well IDs 5 and 6 of Rack 1, then the samples would be aspirated in the order Well 5 Rack 1,
Well 6 Rack 1, Well 3 Rack 2, Well 4 Rack 2.

The order of well selection does affect the order in which rows are appended to
the Wells View  but it does not affect the order in which wells will be used
during the autosampler procedure. Similarly, if the Wells View  is populated
by importing  a spreadsheet, the order of Well IDs in the spreadsheet does
not affect the order in which wells are used. 

Figure 109: Selection of wells in the Rack Stage

8.4.4.2 Populating the Procedure Spreadsheet

The Wells View contains a spreadsheet each row of which corresponds to a selected well. There are
twelve columns, with functions defined as in Table 6.
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Table 6: Overview of Wells View columns

Column heading Required
entry

Function

Numbered column NO The first column with numbers is for reference only (grayed
out) and does not specify the wells that samples will be
aspirated from.

Well ID YES Specifies the microplate well that the sample will be
aspirated from. These do not have to be sequential or
continuous, but will always be taken in ascending order,
then in order of rack number.

Label NO Sample identification, for user reference only.

Content Description NO Well contents information, for user reference only.

Remarks NO User comments, for the user reference only.

Experiment Template YES Experiment template to be used for the selected well; the
template must have been previously created and saved.

Sampling Method YES Sampling Method used for the selected well
(default:AutoSample). 

Cell Wash Method YES Cell Wash Method used for the selected well
(default:CellWash).

Probe Wash Method YES Probe Wash method used for the selected well
(default:ProbeWash).

Data Manipulation NO Operations for data manipulation to be performed on the fly
for the data from the selected well.

Experiment Result Folder YES Repository that the experimental data will be stored in.

Experiment Result Filename YES Name of the Datastore that the experimental data will be
stored under.

Rackname NO The last column is for reference only (grayed out) and shows
which rack the well is located in.

The contents of cells in the Label, Content Description and Remarks columns will be saved with the
results Datafile and can be viewed  using Chirascan Viewer. 

A procedure in the Data Manipulation column might be required, for example, if different experimental
templates are used for different wells as this requires a new background to be acquired for each
experimental template.

In the Experiment Result Folder column, a sub-repository structure can be specified by using
backslashes (‘\’, no leading or trailing backslash is required). If the path or repository does not exist, it
will be created in the current user’s root repository, which is ’Chirascan User’ for user Chirascan User by
default and can be changed in the Repository Property dialog .

If a Datastore with the name given in the Experiment Result Filename column already exists in the
specified repository, the data will be stored as a revision  of the existing Datastore, and will not
overwrite any previous data. However, this can complicate data analysis and it is therefore recommended
to use non-existing names. Automated data analysis  requires a unique name for each well and
baseline Datastores to contain the keyword '(b)uffer'.

The spreadsheet can be populated by direct input or by importing  from a Microsoft Excel™
spreadsheet or a CSV file. Spreadsheet cells can be populated directly either by typing or pasting text.
To copy the content of a cell into the clipboard, select the cell and press Ctrl-c. To paste from the
clipboard into a cell, select the cell and press Ctrl-v. To select an entire column for pasting, click the
column heading first. Alternatively, left-click and drag-down the black square at the lower right corner of a
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selected cell to copy its contents into cells below. If there are more rows than can be displayed in the
panel, scroll the mouse wheel while dragging to enlarge the selection further down. Clear the contents of
a cell by pressing Delete and confirm inputs by pressing Enter.

Populating the Experiment Result Filename column with a repeating set of names (e.g. when
including multiple identical replicates in the experiment) can be facilitated (Figure 110): left-click and
drag the cursor across multiple cells in the column to select a block of cells that have already been
populated. Then left-click and drag-down the black square at the lower right corner of the selection. Upon
releasing the left mouse button, a dialog will suggest appending Well IDs to the names: click Yes. The
contents of the block of cells selected previously will be repeated throughout the enlarged selection and
the names in each copy of the block will be appended by the Well ID of the first well in that block to
ensure unique naming.

Figure 110: Populating the Experiment Result Filename column by dragging a block of cells down

Experiment Templates, Sampling, Cell Wash and Probe Wash methods can be chosen from drop-
down menus in the corresponding columns by clicking the corresponding down-arrow button. Once
selected for an individual cell, these can be copied and pasted into other cells of the same column as
described above. 

Typically, the Experiment Template, Sampling Method, Data Manipulation, Probe Wash Method
and Experiment Result Folder are the same for every well. However, if preferred, any of these can differ
between wells. For example, you may wish to run some of the samples using one experimental template
and some using another, or you may which to use different ones for the sample and the buffer.

8.4.4.3 Editing, Exporting and Inporting Spreadsheets

The toolbar at the top of the Wells View  can be used for editing, exporting and importing
spreadsheets (Figure 111). It contains the following toolbar icons:

· Copy copies the contents of the selected cell into the clipboard
· Cut copies the contents of the selected cell into the clipboard and clears the cell
· Paste pastes the contents from the clipboard into the selected cell
· Clear clears the contents of the selected cell(s)
· Clear All removes all rows from the spreadsheet
· Export to CSV exports the spreadsheet to a CSV file (comma separated values)
· Import from CSV imports a CSV file (comma separated values) to populate the spreadsheet
· Open in Excel opens the spreadsheet in Microsoft Excel™
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· Open Selection in Excel opens the current selection of the spreadsheet in Microsoft Excel™
· Export to Excel exports the spreadsheet to an XLS file
· Import from Excel imports an XLS file to populate the spreadsheet
· Export Selection to Excel exports the current selection of the spreadsheet to an XLS file

Figure 111: The Wells View toolbar

Note that Copy, Cut and Paste only work for single cells, whereas Clear works for one or multiple
selected cells. After opening in or exporting the spreadsheet to Microsoft Excel™, the Excel file can be
saved and imported to populate the spreadsheet. Exporting and importing as CSV can be helpful if
Microsoft Excel™ is not available on the instrument computer. When a CSV file is imported, the Import
from CSV settings dialog will appear (Figure 112). The From row input box is used to set the position
of the first row to be imported, while the Row count input box is used to set the total number of rows to
be imported;. The Comma check box should be ticked. 

Figure 112: The Import from CSV settings dialog

8.4.4.4 Starting a Procedure

The moving parts of the autosampler could cause serious injury to the user or
damage to the instrument. For safe operation the moving parts are contained
within an enclosure fitted with an interlock device, which is engaged while the
autosampler is operating. Do not attempt to open the enclosure door upon
autosampler operation or to override the interlock device. In some
circumstances, for example when manually adjusting the position of the probe,
it may be possible to move the autosampler arm using the autosampler
software while the enclosure door is open. Do not use the software to move
the autosampler arm while the enclosure door is open. Do not operate the
autosampler without the removable panels at the lower front, side and rear in
place. Do not introduce any object through the brush panel ports on the rear of
the autosampler while the autosampler is operating.

To start an autosampler procedure, on the Experiment menu  click Start Experiment. A dialog will
remind the user to make sure that:

· Coordinates for the flow cell injection port have been calibrated
· There is sufficient fluid in the cleaning liquid reservoirs
· Waste collection bottles are empty
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Moreover, the software performs a basic validation of the information provided in the Wells View , e.g.
that all the specified templates and wash methods are available and that the current user has write
access to the specified experiment results repository, and informs the user if validation fails. If this is the
case, please check and correct the information entered in the Wells View .

8.4.5 The Chirascan Autosampler Menu Bar

8.4.5.1 The File Menu

The File menu (Figure 113) gives access to the following functions:

· New resets Chirascan Autosampler for a new procedure. The Well View  spreadsheet is cleared
and all settings that have been changed but not confirmed are reset to the values saved in the current
Application definition .
· Open… calls up the Load Application dialog that allows to open another Application definition .
· Save stores the current autosampler configuration as a new revision  of the currently loaded

Application definition .
· Save As… calls up the Save Application As… dialog that allows to store the current autosampler

configuration in a new Application definition .
· Import… calls up the Import Auto-Sampler JavaScript Application dialog that allows to load an

autosampler configuration from external files and store them in an Application definition  of the SQL
database. The external files required  comprise a settings file and an implementation file.
· Export allows to save the current autosampler configuration as external files; the submenu Javascript

allows for saving an implementation file, the submenu Settings allows for saving a settings file.
· Exit closes Chirascan Autosampler.

Figure 113: The File menu

8.4.5.2 The Experiment Menu

The Experiment menu (Figure 114) gives access to the following functions:

· Reinitialise AutoSampler reestablishes communications between autosampler and Chirascan
Autosampler, moves the robot to its home position and then parks the robot.
· Start Experiment starts  an autosampler procedure. To stop the procedure, click Stop

Experiment.
· Pause Experiment halts an autosampler procedure. Execution of any commands currently

processed will finish before the autosampler procedure is paused. To continue with the procedure,
click Resume Experiment.
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· Stop All Actions immediately stops any running scripts such as the AverageAll script.
· Setup Experiment File allows to set the name of the experiment file that will automatically be

created for an automated run.
· Open Experiment File allows to inspect experiment files created for previous automated runs similar

to the same menu entry  in Chirascan Viewer. 
· Stop Chirascan is only enabled if an acquisition is in process and stops the current acquisition. The

autosampler procedure is not affected and continues as normal.
· Options has two entries: Automatically Run Initialization on Restart to toggle automatic

initialization of the autosampler upon restart and Reset Javascript which sets all JavaScript activity to
its defaults and is only used by Applied Photophysics .

Figure 114: The Experiment menu

8.4.5.3 The View Menu

The View menu (Figure 115) gives access to the following functions:

· Menu bar toggles visibility of the Menu bar.
· Live Scene toggles visibility of the Robot and Pump View tab which is a deprecated function.
· Enable JavaScript Editor toggles visibility of the JavaScript Editor which is used for maintenance

and diagnostics only and access to which is password protected.
· Classic Toolbars has only one sub entry Main Toolbar which is a deprecated function.
· Status Bar toggles visibility of the status bar  at the bottom of the Chirascan Autosampler window.
· Activity Output Log Window toggles visibility of the Activity Log window.
· View Program Log calls up the robotics Log File Viewer that is used for diagnostic purposes.
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Figure 115: The View menu

8.4.5.4 The Help Menu

The Help menu (Figure 116) gives access to the following functions:

· Help… opens the user manual. You can browse the contents and search for specific words and
phrases.
· APL JavaScript API Manual… opens in a browser the JavaScript Interface Manual.
· About Applied Photophysics Robot Controller… opens the About Auto-Sampler dialog which

gives the version number and other information about Chirascan Autosampler.

Figure 116: The Help menu
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8.5 21 CFR Part 11 Compliance

The Chirascan software used to operate the Chirascan Q100 allows compatibility of the system and of
data obtained using the system with the Food and Drug Administration’s (FDA) part 11 of Title 21 of the
Code of Federal Regulations: Electronic Records; Electronic Signatures (21 CFR Part 11). This is
achieved through:

· Access control: Restricted access is controlled by imposing a requirement for electronic signatures
(log-in with a user ID and password).
o Access to the Chirascan system and to specific functions of the Chirascan software is controlled

through Microsoft Windows Security Settings and Microsoft Windows user accounts.
o Access to most aspects of the Chirascan software, including execution of most actions related to

the generation, modification, and storage of data and access to database repositories, is controlled
through definition of different user Roles.

· Record control: Creation and modification of electronic records is logged and original records are never
overwritten.
o An Audit Trail of user actions offers a complete and traceable record of software events.

o Version control and restrictions on files used to generate data, i.e. experimental templates,

configuration files and settings files.

Compliance of the Chirascan software provided with the Chirascan Q100 is indicated by the affix (CFR)
in the titlebar of Chirascan Control . For operation of the Chirascan software with 21 CFR Part 11
compliance, a valid license is required. Please contact  Applied Photophysics Customer Support for
inquiries about your license.

Most of the functions related to managing access privileges and permissions for 21 CFR Part 11
compliance in the Chirascan software are accessible through the Admin menu  in Chirascan
Control . Access to the following entries in this menu is restricted to system administrators:

· Users and Roles
· Manage Actions Reasons
· Schedule Database Backup

8.5.1 General System Security

To ensure compliance of the Chirascan Q100 system with 21 CFR Part 11 regulations, various
measures are required that go beyond usage of the Chirascan software. Most importantly, user access
to the system and specific functions of the Chirascan software is controlled through Microsoft Windows
user accounts and related security functions provided by the Microsoft Windows operating system. The
correct configuration of these aspects of the system is the responsibility of the system administrator.

Ensuring data security and managing access to the instrument PC to avoid
theft, tampering or corruption of data lies within the responsibility of the
customer’s security and group policies.

In addition to configuring the security settings of the Windows operating system and the Chirascan
software, the user organization must implement procedures and policies to complement the functionality
provided by the Chirascan system, e.g. to ensure secure storage and archiving of records exported from
the database of the Chirascan software, as these must generally be considered non-compliant with the
21 CFR Part 11 regulation. For more information about where such procedures must be established by
the user organization, refer to the 21 CFR Part 11 Compliance Booklet.
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Some of the responsibilities of the user's local IT department that are outside the scope of what the
Chirascan software provides to ensure 21 CFR Part 11 compliance include the following:

· Setting up firewall access to the system
· Including remote SQL access
· Moving database backups from the local disc to a network drive
· Implementing any local disc access group policies
· Making full system backups
· Preventing windows programs being run as other users
· Warning Applied Photophysics if any changes are made to the system configuration, such as name /

domain changes or system time and date

8.5.1.1 Windows Security Settings

To ensure compliance with the 21 CFR Part 11 regulation, 21 CFR Part 11 functionalities of the
Chirascan software must be complemented by some of the security functions provided by the operating
system. The required functions are specified in the 21 CFR Part 11 Compliance Booklet which
accompanies all 21 CFR Part 11 compliant Chirascan systems. As these systems are provided with
Microsoft Windows 10 Pro, please refer to the official Microsoft documentation available online regarding
details on how to configure the security settings summarized below.

· Accounts Settings 
o Other people: Add new local users, remove users or change account type. 

Note that user ID must be identical to printed name of user for 21 CFR Part 11 compliance.
o Sign-in options – Privacy: Disable ‘Use my sign-in info to automatically finish setting up my

device and reopen my apps after an update or restart’.
· Local Security Policies
o Account Policies – Password Policy

§ Enforce password history
§ Maximum password age
§ Minimum password age
§ Minimum password length
§ Password must meet complexity requirements
§ Store passwords using reversible encryption

· Account Policies – Account Lockout Policy
o Account lockout duration

o Account lockout threshold

o Reset account lockout counter duration

· Local Policies
o Security Options

Enable option ‘Interactive logon: Don’t display last signed-in’.
· Event Viewer
o Increase log file size by configuring ‘Maximum log size (KB)’ in log properties.

o Enable manual clearing by enabling ‘Do not overwrite events (Clear logs manually)’ in log properties.

o Archive event logs and clear at regular intervals to prevent them from filling up using ‘Save All Events

As…’ and exporting to .evtx file.
· Local Users and Groups 

Force each user to change the temporary password set by the system administrator at next logon
(enable ‘User must change password at next logon’).
· Local Group Policy

Local Computer Policy – Computer – Configuration – Administrative Templates – System –
Login: Enable ‘Hide entry points for Fast User Switching’.
· Directory Protection
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Directory Properties – Security – Permissions: Restrict access to directories (such as the
directory for database backups) to certain users or groups as required.

8.5.1.2 Account-Controlled Permissions

There are permissions to specific functions of the Chirascan software which depend on whether a user is
logged in with a standard Windows user account or with a Windows administrator account, independent
of the Role the user is assigned to in the Chirascan software.

Configuration Files

Many of the instrument settings are held in configuration files located in a hidden directory on the hard
drive of the PC (C:\ProgramData\Applied Photophysics\Chirascan\Config). Only Windows administrator
accounts may modify these files. Certain actions in the Chirascan software cause these files to be
edited (provided the user is an administrator). Upon such changes, the previous configuration file is
automatically copied into another directory (C:\ProgramData\Applied
Photophysics\Chirascan\Config\Old) by the software so that a record of each configuration file is kept. It
is down to the PC administrator to maintain the records of these configuration files.

The Device Dialog

Chirascan provides an interface to the several hardware components of the instrument through the
Device window  in Chirascan Control. In a standard Windows user account, the Device window only
gives access to a limited number of devices and it is not possible to change the instrument’s
fundamental configuration.

However, in a Windows administrator account, it is possible to access many dialogs that allow
modification of firmware settings that can severely affect the instrument’s performance. All such settings
are password-protected (by an Applied Photophysics defined password) and should only be modified
under instruction by an Applied Photophysics engineer. It is down to the PC administrator to ensure any
changes in the password-protected area of the Device window are recorded externally.

Database Management

Most of the data of the Chirascan software (including experimental templates, Datastores, Application
definitions, Audit Trail etc.) are stored in an SQL database . As the Chirascan software does not allow
importing any external data into the database, any data in the database is either newly created data or
derived thereof and, thus, can be considered 21 CFR-compliant if the system has been set up correctly.
System administrators are responsible for maintaining  the database. By default, a scheduled
backup  of the Chirascan database is made routinely; standard Windows user accounts do not have
access to this dialog. Restoring the database will discard all audit trails and records that were made
after the backup was created; therefore, standard Wiindows user accounts do not have permission to
restore a database backup. It is down to the PC administrator to authorize and record any such action.
Moreover, it is technically possible to access and modify the database through Microsoft SQL Server
Management Studio. Doing so may compromise the data records and therefore is only possible from
Windows administrator accounts and requires a password. It is down to the PC administrators to
authorize and record any such actions.

Autosampler configuration

Some functions in Chirascan Autosampler related to the configuration of the autosampler are only
available to Windows administrator accounts, such as the Hardware tab  where global variables can
be set.
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8.5.2 Chirascan Access and Permissions

Users of the 21 CFR Part 11 compliant Chirascan software are required to provide an electronic
signature to:

· Start any of the programs of the Chirascan software (Figure 117), including Chirascan Control ,
Chirascan Viewer  and Chirascan Autosampler .
· Execute any controlled actions within the software that have been configured  as requiring a

signature.

To obtain access, the entered user name and password must correspond to that of a Windows user
account on the PC as administration of passwords is managed through the Windows User Account
Control Settings. Once signed in, actions performed will be logged under that user name in the audit
trails.

Figure 117: Logon window for a Chirascan program

After five failed attempts to log in to a Chirascan program, a user account will be locked and the user will
be unable to start any Chirascan program until their account has been unlocked. To unlock users that
are currently locked, the system administrator must log in and start the Chirascan software; they will
then be queried to unlock individual users.

After five failed attempts to sign in for execution of a particular action, the user will be denied execution
of that action. However, the user can continue using the software and try again to provide a correct
electronic signature.

The Chirascan software can be used by only one user at a time. If a user other
than the current one intends to use the software, the current user must first
close down the software.

8.5.2.1 Managing Users and Roles

The Users and Roles dialog

The level of permissions given to a user in the Chirascan software is defined by their Role, and any user
must be assigned to a Role before access to repositories can be managed for that user. To manage
Roles, from the Chirascan Control menu bar  select Admin → Users and Roles to open the Users
and Roles dialog (Figure 118).
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Figure 118: The Users and Roles dialog

A list of currently defined Roles is available to the left of the dialog. After system installation, four default
Roles are defined:

· Chirascan Users: This Role is intended for users with limited permissions who operate the Chirascan
software from a standard Windows user account. By default, the standard Windows user account
Chirascan User is assigned to this Role.
· Method creators: This Role is intended for users who operate the Chirascan software from a standard

Windows user account but have some more permissions than Chirascan Users. By default, no users
are assigned to this Role.
· Administrators: This Role is intended for system administrators with full permissions who operate the

Chirascan software from a Windows administrator account. By default, the Windows administrator
account Chirascan Admin is assigned to this Role.
· Service: This protected role is used by Applied Photophysics for maintenance and servicing purposes

only. It cannot be renamed or deleted and no new users can be assigned to this Role. The Windows
administrator account APLService is assigned to this Role.

Initially after system installation, all default Roles have full permissions (i.e., all
available actions are assigned to these Roles) and any actions settings are
disabled. The system administrator must revoke actions from non-
administrator Roles and configure action settings as desired to ensure 21 CFR
Part 11 compliance.

A user can only log into the Chirascan software when being assigned to a Role. To assign a user to a
Role, right-click on the Role and click New → User (i.e., using the right-click menu ) or select the
Role and click the New User icon in the toolbar . Likewise, Roles and users can be deleted and
renamed by using the corresponding toolbar  icons or the right-click menu .

The names of users created in the Users and Roles dialog must be the same as the names of
corresponding Windows user accounts (however, case insensitive) that must have been created
beforehand.
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Roles are defined by the list of actions to the right of the dialog. This list can contain any of the
actions  that can be executed in the Chirascan software programs. Each Role can have a different
subset of actions; users in a certain Role are permitted to carry out only actions that are included in the
actions list of that Role. Roles other than the default Roles can be defined by creating new Roles and
configuring  their actions lists.

User Properties

When a user is selected in the list to the left of the Users and Roles dialog, the corresponding user
properties are shown to the right (Figure 119). Changes made to these require clicking Apply to confirm.

Figure 119: The user properties

The user properties include:

· User ID is the name of the user as it appears in the Users and Roles list.
· Firstname is an input field that allows to specify the real first name of the user.
· Lastname is an input field that allows to specify the real surname of the user.
· Role is a drop-down menu that allows to change the Role of a user.

A new user can only be created if first and last name are entered in the respective input fields.

Although providing first and last name of the user is mandatory and this
information  appears in reports, it does not appear in audit trail records or
anywhere else. For compliance with 21 CFR Part 11, the User ID itself must
therefore be the user’s full name.

The Users and Roles toolbar

The toolbar of the Users and Roles dialog is shown in Figure 120. Some of the options in this toolbar
are also accessible in the Users and Roles right-click menu .

Figure 120: The Users and Roles toolbar

· New Role creates a new Role. This icon is only enabled if the top of the list hierarchy, Users and
Roles, is selected.
· New User creates a new User assigned to the selected Role. This icon is only enabled if a Role is

selected.
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· Rename allows to rename the selected Role or User.
· Add Action to Role opens a dialog that allows to add actions  to a Role.
· Delete removes the selected Role or User.

· Export Selected Actions Settings allows to export the settings for the selected actions  to an
XML file.
· Import Role Actions Settings allows to apply actions settings from an XML file to the current actions

list. Only the settings for actions that are present in both the imported XML file and the current actions
list are applied, i.e., no actions are removed from or added to the actions list .
· Export Selection to revocable Actions List in a Rules Settings file allows to export a list of the

selected actions as an XML file that can be used to revoke  these actions from another role.
· Export Selected Actions as grant List of Actions allows to export a list of the selected actions as

an XML file that can be used to add  these actions to another role.

The Role Right-click Menu

Right-clicking a Role in the list to the left of the Users and Roles dialog opens the menu shown in
Figure 121. Some of the options in this menu are also accessible in the Users and Roles toolbar .

Figure 121: The Role Right-click menu

· New contains a sub menu that allows to create a new user.
· Import Actions Settings allows to apply actions settings from an XML file to the current actions list.

Only the settings for actions that are present in both the imported XML file and the current actions list
are applied, i.e., no actions are removed from or added to the actions list .
· Apply Grant List to Role adds  the actions in an XML file to the selected Role.
· Apply Revoke List to Role removes  the actions in an XML file from the selected Role.
· Rename allows to rename the selected Role.
· Delete removes the selected Role.

8.5.2.2 Configuring Actions

Action Definitions and Settings

Of all the actions that a user might carry out in the Chirascan software, a subset has been identified by
Applied Photophysics as having relevance to maintaining records in accordance with 21 CFR Part 11.
Actions of this subset can be assigned to or revoked from Roles, and after system installation, all
actions available are assigned to the Roles that have already been defined by default. It is the
responsibility of the system administrator to configure the sets of actions assigned to these Roles or
define new Roles as desired. If the default Roles are used, it is recommended to revoke actions from the
Chirascan Users and Method Creators Roles. For example, any action could be revoked from the
default Role Chirascan User if it:
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· modifies, deletes, or moves previously recorded data.
· alters the configuration of the instrument in any significant way, e.g. changing calibration values.
· changes the settings of any other user’s settings in any way.
· deletes or modifies any records of settings that were used to generate data (i.e. experiment

templates).

The default Role Method Creators could be set up similarly to the default Role Chirascan Users but
being granted actions required for method creation such as saving an experimental template.  If advice is
required about how Roles should be defined, please contact Applied Photophysics. Each action can
have any of the following settings checked or unchecked (Note that these settings apply to all Roles): 

· Need Signature: If ticked, a signature (in the form of a password) is required to execute this action
and a custom reason must be provided. 
· Need Reason: If ticked, either a custom reason must be provided or a reason from a list of user

defined reasons  must be selected for the action to be executed. Requesting reasons from a user
requires a signature, i.e., the Need Reason setting is only available for an action if its Need
Signature setting is ticked.
· Need Audit Trail Recording: If ticked, a record of this action will be recorded each time it is

performed. 

Actions monitored in the 21 CFR Part 11 compliant Chirascan software (using Applied Photophysics
user definitions) are listed in Table 7.

Table 7: Actions restricted and monitored in the Chirascan software

Name Description

START_SCRIPT_PROCESS Start an automated experiment run

STOP_SCRIPT_PROCESS Stop an automated experiment run

DELETE_RECYCLE_STORE_REPOSITORY Delete a Datastore repository from the database
recycle bin

DELETE_RECYCLE_STORE Delete a Datastore from the database recycle bin

RESTORE_RECYCLE_STORE_REPOSITORY Restore a Datastore repository from the database
recycle bin

RESTORE_RECYCLESTORE Restore a repository from the database recycle bin

APPLY_REVOKE_LIST_TO_ROLE Apply a list of action revokes in XML format to a Role

APPLY_GRANT_LIST_TO_ROLE Apply a list of action grants in XML format to a Role

IMPORT_ROLE_ACTIONS_SETTINGS Import a list of action settings in XML format

MOVE_REPOSITORY_INTO_REPOSITORY Move the location of a Datastore repository in the
database

COPY_REPOSITORY_INTO_REPOSITORY Copy/cut and paste one repository into another

DELETE_USER Delete a user from the Chirascan software

DELETE_ROLE Delete a Role from the Chirascan software

REMOVE_ACTIONS_FROM_ROLE Revoke action(s) from a particular Role

DELETE_APP_REPOSITORY Delete an application repository (repository for the
.jsa Application files)

DELETE_JSAPPLICATION Delete an Application file (.jsa)

CRCM_DELETE_REASON Delete a reason from the Manage Action Reasons

list

DELETE_TEMPLATE Delete an experimental template
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Name Description

SET_CD_CALIBRATION_FACTOR Set and save the Circular Dichroism calibration factor

CRCM_CD_CALIBRATIONVALUESET Set but not save the Circular Dichroism calibration
factor

PAUSE_CHIRASCAN Pause the spectrometer during an acquisition

RESUME_CHIRASCAN Resume the spectrometer from a paused state

STOP_CHIRASCAN Stop the spectrometer during an acquisition

IMPORT_APP_FILES Import files to create a new Application file (.jsa)

SAVE_APP_FILE Save the current Application file (.jsa)

SET_USER_DEFAULT_REPOSITORY Set the default Save to Repository for the current
user

SAVE_DATASTORE Save a new Datastore

DELETE_DATASTORE_REPOSITORY Delete a Datastore repository

DELETE_DATASTORE Delete a Datastore

MOVE_DATASTORE_TO_REPOSITORY Copy/cut and paste a Datastore form one repository
to another

RENAME_DATASTORE Rename a Datastore

ADD_ACTION_REASON Add a reason to the Manage Action Reasons list

SET_ACTION_NEED_SIGNATURE Set/Unset the Need Signature setting for an action

SET_ACTION_NEED_REASON Set/Unset the Need Reason setting for an action

UPDATE_REPOSITORY_SETTINGS Change the user access permissions on a repository

ADD_USERS_TO_REPOSITORY Add a user to a repository

UPDATE_USER_INFO Update user information in the Users and Roles

dialog

UPDATE_ROLE_ACTIONS Update Role actions

ADD_ACTIONS_TO_ROLE Add action(s) to a particular Role

SET_ROLE_NAME Set/change the name of a Role

SET_USER_NAME Set/change the name of a user

ADD_ROLE Create a new Role

ADD_USER Add a new user

SET_REPOSITORY_NAME Set/change a Datastore repository

ADD_REPOSITORY Create a new Datastore repository

RUN_CHIRASCAN_TEMPLATE Run an experimental template

SAVE_CHIRASCAN_TEMPLATE Save an experimental template

RENAME_USER Rename a user

LOAD_AUTOSAMPLER_APPLICATION Load an Application file (.jsa) into Chirascan
Autosampler 

COPY_DATASTORE_INTO_REPOSITORY Copy a Datastore and paste it into another directory

REQUEST_LOGON Request a log-on into one of the Chirascan programs

Changing Actions Settings

Actions settings can either be configured by ticking/unticking the check boxes of individual actions
settings in the Actions list of a Role, or by transferring a subset of actions settings from one Role to
another as described below.
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To export a subset of actions settings, first select the actions the settings of which are to be transferred.
To select multiple individual actions in the list, use Ctrl + left-click; to select a range of actions, use Shift
+ left-click. Then click Export Actions Settings in the Users and Roles toolbar  to obtain an XML file
containing the selected actions with their settings. 
To apply the exported settings to a Role, select the Role in the Users and Roles list, click Import
Actions Settings in the Users and Roles toolbar  and browse for the XML file. Only settings for
actions that are present in both the imported XML file and the current Actions list are applied, i.e., no
actions are removed from or added to the Actions list of the selected Role.

An exported XML file can also be opened in a text editor and modified by changing the relevant fields
with “1” representing ticked and “0” representing unchecked. After saving an XML file manually modified
in this way, it can be imported as described above.

Revoking Actions

It is possible to revoke actions from a Role by two ways: directly or by using a Revocable Actions List. 

To revoke actions directly from a Role, first select the Role from the Users and Roles list and then select
the actions to be revoked in the Actions list. Now right-click any of the selected actions and select
Remove from Role from the right-click menu (Figure 122). 

Figure 122: Revoking actions

To revoke actions from a Role using a Revocable Actions List, first select a Role from the Users and
Roles list and then select the actions to be revoked in the Actions list. Now click Export as Revocable
Actions List in the Users and Roles toolbar  to obtain an XML file that contains the actions to be
revoked. To revoke the exported set of actions from a Role, right-click the Role, select Apply Revoke
List to Role and browse for the XML file.
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Granting Actions

Similar to revoking actions, it is possible to grant actions to a Role by two ways: directly or by using a
Grant List. 

To grant actions directly to a Role, first select the Role from the Users and Roles list and then click the
Add Action to Role icon in the Users and Roles toolbar . This opens a dialog that lists all available
actions that are not yet granted to the selected Role (Figure 123).
In the list of this dialog, tick the Select check boxes of all actions to be granted. Do this either by
ticking individual check boxes, or by selecting all actions of interest followed by clicking the Check
selected Actions icon. To select multiple individual actions in the list, use Ctrl + left-click; to select a
range of actions, use Shift + left-click. Likewise, the Select check boxes of multiple selected actions
can be unticked at once by clicking the Uncheck selected Actions icon. Once the Select check boxes
of all actions to be granted are ticked, confirm by clicking OK.

Figure 123: Granting actions

To grant actions to a Role using a Grant List, first select a Role from the Users and Roles list and then
select the actions to be granted in the Actions list. Now click Export as Grant List in the Users and
Roles toolbar  to obtain an XML file that contains the actions to be granted. To grant the exported set
of actions to a Role, right-click the Role, select Apply Grant List to Role and browse for the XML file.
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Managing Action Reasons

Actions for which the Need Reason setting has been enabled require the user to provide a reason
before the action is executed. This reason will be logged in the Audit Trail  if the action's Need Audit
Trail Recording setting is activated. The Action Signature dialog requesting an electronic signature
then provides an input field where the user can either choose one of the predefined action reasons from a
drop-down menu or can enter a custom action reason (Figure 124). 

Figure 124: Action signature dialog with reasons drop-down menu

As the reasons input field is part of the Action Signature dialog, only actions that are configured to
require a signature may require a reason, too.

Figure 125: The Manage Action Reasons dialog
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To set and manage predefined reasons for actions, go to Admin → Manage Actions Reasons in the
Chirascan Control menu . This opens the Manage Action Reasons dialog (Figure 125) where
reasons can be added or deleted by using the corresponding toolbar icons.

Note that there are no predefined reasons by default and only custom reasons are used until specific
reasons have been defined here, independent of whether the Need Reason setting for reasons is
enabled or not.
Moreover, defined action reasons cannot be deleted once they have been used and, thus, are referenced
by the 21 CFR audit trail.

8.5.2.3 Managing Repositories

Within the Chirascan software, data are recorded as Datastores  organized as repositories in an SQL
database. It is possible to restrict and grant available Windows users access to the various repositories
in the repository hierarchy.

To manage access control of Datastore repositories, open the Repositories dialog (Figure 126) by
selecting Admin → Data Stores Repositories from the Chirascan Control menu . 

The Repositories Dialog

In the Repositories dialog, repositories can be added, deleted, renamed, and their properties inspected
by either using the corresponding icons in the toolbar  or using the right-click menu . In addition,
the Save to Repository  can be set, where any data obtained in Manual Mode  is stored. The
current Save to Repository  is shown at the bottom of the dialog.

Any repository manipulations other than viewing and changing properties that are accessible in the
Repositories dialog can also be carried out through Chirascan Viewer .

Figure 126: The Repositories dialog and right-click menu

The Repositories right-cick menu

Right-clicking a repository in the Repositories dialog brings up a menu with the following entries (Figure
126):
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· Add Sub Repository creates a new sub repository within the currently selected repository.
· Rename allows to rename the currently selected repository.
· Delete moves the currently selected repository into the Recycle Bin .
· Set as Save to Repository sets the currently selected repository as the Save to Repository ,

where any data obtained in Manual Mode  is stored.
· Properties allows to view and change the properties of the currently selected repository.

The Repositories toolbar

The toolbar of the Repositories dialog is shown in Figure 127 and contains the same functions as the
right-click menu  except one for deleting repositories.

Figure 127: The Repositories toolbar

The Repository Property Dialog

Repository permissions can be set for a user as long as it is assigned  to any Role, it is not of
importance to which Role. Access permissions of a user for a given repository can be viewed and
modified in the Repository Property dialog (Figure 128) by right-clicking on a repository and selecting
Properties. At the top of this dialog, some general information of the repository is shown, including its
name, date and time of creation and the name of the user who created it.

The dialog also presents a list that contains all users the permissions for which have already been set. A
user’s permission can be changed by using the drop-down menu in the Permission column. One of
three possible settings can be selected:

· No Access prohibits the user from viewing or editing the contents of the repository. This is the default
setting for all users (other than the creator of the repository).
· Browse allows the user to view data in the repository but not to create, delete or modify contents.
· Write gives the user full access to the repository, allowing the user to create, delete and manipulate

data in this repository (Note that actual permissions will depend on actions  available to the user’s
Role).

If the Recursive Apply check box at the bottom of the dialog is ticked, access permissions for the
repository will be applied to all sub repositories in the repository. Even if the access permissions for the
selected repository have not been changed in the dialog but Recursive Apply has been ticked, any
current access permissions for the selected repository will be applied to its sub repositories, overwriting
existing access permissions of sub repositories. However, this only applies to access permissions that
have already been defined for a particular user and sub repository: any users that have not yet been
added to the permission settings of a sub repository will remain without access to this sub repository
regardless of the permission settings of the parent repository. The Recursive Apply check box is
unticked by default.
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Figure 128: The Repository Property dialog

The check box in the column Set/Unset as User’s Root Repository sets the repository as the user’s
root repository, which is the highest-level repository the user will see. Setting this option will override any
previously set root repository, whereas clearing the box will return the root repository to the default
repository. It is recommended to set a separate root repository for each user or group of users. By
default, the root repository for users Chirascan User and Chirascan Admin is \Chirascan User\.

To save the access permission settings, click the Save Changes icon in the toolbar . You will also
be asked whether you wish to save the changes when closing the dialog.

Note that setting a repository as a user’s Save to Repository  does not change its access
permissions. To enable a user to save data to their Save to Repository , the access permission of the
Save to Repository  for this user must be set to Write.

If permission to the repository has not been set for a user yet, this user must be added to the list. By
default, users not in the list do not have access to the repository. Users can be added in the Repository
Users Selection dialog by clicking the Add Users icon in the toolbar  of the Repository Property
dialog.

The Repository Property Dialog

In the Repository Users Selection dialog (Figure 129), all users the permissions for which have not
been set yet are listed.
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In the list, tick the Select check boxes of all users to be added. Do this either by ticking individual
check boxes, or by selecting all users of interest followed by clicking the Check selected Users icon.
To select multiple individual users in the list, use Ctrl + left-click; to select a range of users, use Shift +
left-click. Likewise, the Select check boxes of multiple selected users can be unticked at once by
clicking the Uncheck selected Users icon. Once the Select check boxes of all users to be added are
ticked, confirm by clicking OK.

Figure 129: The Repository Users Selection dialog

The Repository Property toolbar

The toolbar of the Repository Property dialog is shown in Figure 130. Some of the options in this
toolbar are also accessible directly trough the Repository Property dialog list.

Figure 130: The Repository Property toolbar

· Add Users opens the Repository Users Selection dialog .
· Save Changes saves the changes made.
· Select All selects all entries in the list.
· Deny Access sets permissions for the selected users to No Access.
· Set can browse sets permissions for the selected users to Browse.
· Set can Write sets permissions for the selected users to Write.
· Set/Unset as selected User(s) root ticks/unticks the Set/Unset as User’s Root Repository check

box for all selected users.
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8.5.3 Chirascan Records and Logs

The Chirascan software maintains records in several ways depending on the type of data being recorded:

· Datastore metadata  which includes information about the acquisition settings, user remarks and
data manipulation history
· Templates  which define a set of acquisition settings
· The CFR Actions Audit Trail  which logs any controlled actions executed in the Chirascan software 
· Experiment files  which summarize information related to automated procedures

Upon modification, new revisions  are created for experimental templates , Datastores  or
Application definitions   so as not to lose the original data.

8.5.3.1 Managing Template Revisions

Datastores are generated using experimental templates  which contain acquisition settings and
information provided by the user in the Sample and Cell Description dialog . Experimental templates
are version controlled, i.e., any modifications made to a template result in the creation of a new
revision  of the template, so that a Datastore can always be traced back to the settings that were
used to generate it.

All templates are stored in a single location and access to templates is not selective for different Users
or Roles; all users may load and inspect any template. However, the system administrator can decide
through actions configuration  which Roles are allowed to save, run and delete templates.

The Manage Templates Dialog

Experimental templates and their revisions can be viewed in the Manage Templates dialog (Figure 131)
by selecting Admin → Manage Templates from the Chirascan Control menu .

Figure 131: The Manage Templates dialog
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At the top of this dialog, some general information of the template is shown, including its name, date and
time of creation and the name of the user who created it. The dialog also presents a list of the
experimental templates to the left, and a list of any revisions of the currently selected template is shown
to the right of the dialog.

Figure 132: Example of a template viewed in XML format
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General information about each revision is given under the following column headings:

· Revision: The number of the revision
· Saved Time: The time that the revision was created
· Store File Size: Size of the Datastore (in bytes) that this revision of the template will create
· Saved by: The name of the user that created the revision

All experimental templates are saved in the database in an XML format. Revisions of templates can be
viewed, deleted, loaded and exported using the corresponding icons in the Manage Templates toolbar
. To view the revision of a template, select the revision in the list and click the View Definition icon in
the toolbar (Figure 132).

The template will then be displayed in XML format that includes the following XML tags:

· Settings: Information under this tag relates to general instrument settings. These include acquisition
settings  and options such as the AutoShutter option. 
· Properties: These are the physical properties to be measured during acquisition such as Circular

Dichroism, Absorbance and Temperature. Properties  are the dependent variable of the acquisition. 
· Attributes: These include additional acquisition settings (such as time-per-point) and user defined

information such as given in the Sample and Cell Description dialog . 
· Dimensions: Dimensions refer to the independent variable  of the acquisition such as wavelength.

The contents of a template revision can be stored as an XML file by clicking Export… or copied into the
clipboard by clicking Copy.

The Manage Templates Toolbar

The toolbar of the Manage Templates dialog is shown in Figure 133 and contains following icons:

· View Definition opens a dialog that displays the selected revision in XML format.
· Delete Selected removes the currently selected revision.
· Delete with all Revisions removes the currently selected template with all its revisions.
· Load Template opens the currently selected revision in Chirascan Control and sets acquisition

settings accordingly.
· Export Template allows to save the currently selected revision as a new Datastore file.

Figure 133: The Manage Templates toolbar

8.5.3.2 CFR Actions Audit Trail

Any actions  set to be logged in the Audit trail are recorded into the CFR Actions Audit Trail. The CFR
Actions Audit Trail can be inspected in the CFR actions Audit Trail Viewer dialog by selecting Admin
→ View CFR Controlled Actions Audit Trail from the Chirascan Control menu .

The CFR Actions Audit Trail Viewer dialog (Figure 134) contains a list of records for actions that have
been logged. Any field of a record can be double-clicked to mark and copy the information within. Note,
however, that records in the CFR actions Audit Trail cannot be edited or deleted by any user.
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Figure 134: The CFR Actions Audit Trail Viewer dialog

The following information is shown for each action that has been logged:

· Time: Time stamp of when the action was completed/attempted
· Action: Name of the action completed/attempted
· Class: Class of the action completed/attempted
· Type: Type of the action record. This can be either of:
o INFO: The record informs that the action has been completed.

o ERROR: The record reports a failure to complete an attempted action. 

· User: Identity of the signed-in user when the action was completed/attempted
· Application: The Chirascan program in which the action was attempted. This can be either Chirascan

Control, Chirascan Viewer or Chirascan Autosampler. 
· Signed: Information whether the user signed (i.e. entered a password) to complete the action
· Reason: Reason for attempting the action (if required) that was chosen by the user
· Description: A brief description of what the action did

Messages are logged per day and it is possible to view any past day’s logs using the calendar to the left
of the dialog. The drop-down menus at the top of the dialog allow filtering the records:

· The User and Application drop-down menus allow filtering by the user for who was logged in and by
the program from which actions were attempted.
· The three fields to the right of the binoculars symbol allow to search for keywords within records using

Boolean logic. The first field is a drop-down menu that allows selecting the type of logic, and the two
fields on the right are input fields where keywords can be entered, referred to by the Boolean logic
types as S1 and S2.

Audit logs can be printed using the Print icon or exported to a CSV file using the Output CSV icon.

8.5.3.3 Printed Reports

If reports in paper form are required, several electronic records in the software can be printed out,
including:

· The 21 CFR audit trail, via the printer icon in the CFR Actions Audit Trail Viewer window
· Experiment file details, via the printer icon in the Experiment File window
· A list of Datastore revisions with properties, via the printer icon in the Store File Property dialog
· Data and meta data for a Datastore revision, via the printer icon in the Chirascan Viewer Standard

toolbar
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8.5.4 Database Maintenance

This section provides instructions on how to back up and restore data saved in the database. Applied
Photophysics suggests that the database is backed up at least once a week if the instrument is in
continuous use, or manually after any important experiment.

If you are in any doubt, please contact  Applied Photophysics Customer Support before attempting
the procedure.

Microsoft provides the Microsoft SQL Management Studio as a tool to backup
and restore MS SQL databases. However, this gives full access to the
database and, if used inappropriately, could result in complete corruption of
the database and all the data stored within. In order to safely backup or
restore the database, use the methods provided by Applied Photophysics.

The backup is a snapshot of the entire database. This means that all structures and data in the
database are saved. Similarly, a restore will restore the database to the exact state that it was in when
the backup was made. It is not currently possible to restore individual files or folders from a backup.

By default, backup files are stored on the PC in the following location:

C:\ProgramData\Applied Photophysics\Chirascan\dbbk

Note that this is the ProgramData directory (not the Program Files directory), which is a hidden folder.
You will have to enable the View Hidden Files and Folders option in Microsoft Windows Explorer
before you can navigate to this location.

8.5.4.1 Database Backups

The Database can be backed up either manually as described below, or automatically by setting up
scheduled backups . 

Ensure that Chirascan Control and Chirascan Viewer are not running. Shutdown Chirascan Server by
clicking its red stop icon on the desktop.

From the Microsoft Windows Start menu, navigate to All Programs → Applied Photophysics →
Chirascan → Tools.

Click Back-Up ProData Database. This runs Chirascan Control (ProDataSvr.exe) in a special backup
mode. You should see Chirascan Control start. The backup process may take several minutes. A
message dialog will inform about completion of the backup. Click OK.

You now have to copy the file from the backup directory  into a secure location on a server or suitable
backup disk.

The backup file is called db.bak. We recommend renaming the backup file with an indication of the
date, such as:

CHIRASCAN-Q100-20170225-db.bak

Copy this file to a secure place, such as a server or backup disk. Applied Photophysics recommends
that a copy of the backup is always kept off-site. The backup procedure should be carried out at least
once a week, or after any important experiment.
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8.5.4.2 Database Restoration

Applied Photophysics has also provided a mechanism to restore the data from a backup.

Use the restore database function with caution, as the restored database will
replace the current database completely, and any data in the current database
but not the backup will be lost. 

Ensure that Chirascan Control, Chirascan Viewer and Chirascan Server are not running. Use Microsoft
Windows Explorer to navigate to the Chirascan database backup directory .

Locate the file you want to restore from (for example CHIRASCAN-Q100-20121013-db.bak), and rename
it to db.bak. If there is already a file called db.bak in that location, rename it to something else
beforehand (preferably using the instrument name and date). From the Microsoft Windows Start menu
select:

Start → All Programs → Applied Photophysics → Chirascan → Tools

Click Restore Pro-Data Database from Back-Up.

You should again see Chirascan Server start up. A message dialog will inform about completion of the
restoration and ask for Chirascan Server to proceed. Click OK to confirm.

The Chirascan Server and MS SQL services have to restart now. This can take several minutes. Finally,
a message dialog will inform about completion of the restoration process. Click OK.

You can now restart Chirascan Server, Chirascan Control and Chirascan Viewer. 

8.5.4.3 Backup Scheduling

The database can be backed up automatically using the ProData Database Backup Scheduled Jobs
dialog (Figure 135) that is opened by selecting Database Scheduled Backups in the Admin menu
in Chirascan Control .

Figure 135: The ProData Database Backup Scheduled Jobs dialog

Data obtained on the Chirascan Q100 are stored in a database that is
separate from the Microsoft Windows file structure and is not automatically
backed up. The user should backup all data using the tool provided by Applied
Photophysics.
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To the left, the dialog presents a list of all backup schedule jobs that are currently set. Backup schedule
jobs can be added to or removed from the list by clicking the Add New Backup Job and Delete
selected Backup Job(s) toolbar icons, respectively.

The backup frequency for a selected backup schedule job can be set with the Occurence drop-down
menu to the right that offers the following options:

· At Regular Intervals allows to create a backup repeatedly after a custom duration.
· Daily allows to create a backup once a day on selected days of the week.
· Monthly allows to create a backup once a month.
· Once allows to create a backup once on a chosen date and time.
· Weekly allows to create a backup once a week on a chosen day of the week.

The settings for each of these options (Execution time, time interval, weekdays) can be configured below
the Occurence drop-down menu.
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9 Tips and Tricks

This section provides limited supporting guidance and recommendations on how to use the Chirascan
Q100 efficiently and might be most helpful for first-time users. If you need more comprehensive
resources or advice, please visit www.photophysics.com or contact  Applied Photophysics.

9.1 Manual Mode

The Chirascan Q100 can be operated in Manual Mode, as a stand-alone spectrometer independent of
the autosampler. This might be, for example, if the user wishes to run only a single sample or a small
number of samples. Preliminary measurements in Manual Mode should also be performed to establish
feasibility of thermal denaturation experiments using temperature ramps .

Always ensure that the shutter in the lid of the sample chamber is closed
during manual acquisition.

To operate the Chirascan Q100 in Manual Mode, it is generally not necessary for the autosampler to be
powered on or for Chirascan Autosampler  to be open. Thus, the software start-up  for Manual
Mode can be done as usual but omitting the last step.

It must be ensured that the shutter  in the lid of the sample chamber is closed during manual
acquisition. This shutter is left open at the end of automated runs and automatically closed upon closing
down Chirascan Autosampler. Therefore, if Chirascan Autosampler is kept open, the sample chamber
shutter must be closed manually before manual acquisitions. To do so, click CloseShutter in the Cell
Actions  sub-panel of the Actions panel .

All data acquired in Manual Mode is saved in the Save to Repository  with file names as defined in the
File Names dialog . 

Generally, settings for manual acquisitions are configured similarly as in the creation of an experimental
template  for automated runs.

Cuvettes with different optical path lengths  are used for manual acquisitions.

9.1.1 General Sequence

To make a good manual CD measurement for a sample, follow the general sequence, which is explained
in more detail in the following subsections.

1. Configure the acquisition settings  as required—some preliminary work may be required to
establish the optimal conditions.

2. Acquire a background . The background enables you to measure the absorbance spectrum of your
buffer and sample.
a. Mount the empty cuvette cartridge in the sample chamber , i.e., do not insert a cuvette.
b. Set the DataStore name for the background.
c. Click Background on the Background panel .

3. Acquire a sample CD spectrum . 
a. Load  the cuvette containing sample into the Single Cell Peltier Holder.
b. Set the DataStore name for the sample. 
c. Click Acquire on the Sequencer panel .
d. Check the sample total absorbance. If required, adjust  the absorbance at this point.

4. Acquire a buffer CD spectrum . This gives you the absorbance of the buffer and provides a baseline
CD spectrum, i.e. the spectrum of the buffer that you will later subtract form the sample spectrum.
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a. Remove and clean the cuvette and fill with the buffer, reload  the cuvette into the Single Cell
Peltier Holder. 

b. Set the DataStore name for the buffer. 
c. Click Acquire on the Sequencer panel .

If there are doubts about the suitability of the buffer at hand for CD measurements, it might make sense
to measure the buffer spectrum first, of course. In any case, it is important that the total absorbance
of the sample (i.e. including contributions from both buffer and molecule of interest), rather than just that
of the molecule of interest, is known, so that it can be kept within the reasonable working range. Only if
the total absorbance is below about 2 AU, or at most 2.5 AU, are CD spectra of reasonable quality
obtainable. Buffer, water and even heavy water absorb very strongly at wavelengths near and below
180 nm and therefore always contribute to the total absorbance at low wavelengths.
This is why a buffer baseline should always be acquired in a dedicated acquisition separate from the air
background rather than taking a background with the buffer in place. If the latter were done, the
absorbance for subsequent acquisitions would be referenced against the buffer, and an exceeding total
sample absorbance would remain undetected as the apparent sample absorbance would lack any buffer
contribution. In terms of data presentation and publication, only the spectral contribution from the
molecule of interest is usually of ultimate interest. To this end, the buffer baseline is subtracted  from
the sample spectrum.

9.1.2 Acquiring a Background

Every CD spectrometer has a CD background, caused by the interaction of CP light with the slight
birefringence found in the detector window and to a lesser extent in the cell. To see the true CD
spectrum of your sample, this background must be measured and subtracted from the CD spectrum of
the sample. For automated measurements, this is done automatically at the beginning.

Moreover, meaningful CD data can only be obtained if the total absorbance is within a reasonable range.
To evaluate if this requirement is fulfilled, simultaneous acquisition of CD and absorbance is
recommended. An absorbance reference is required to obtain total absorbance. As water absorbs
strongly at low wavelengths, this reference should be obtained with an empty cuvette cartridge.

1. Configure  the settings for spectral acquisition of the background.

Note that subsequent acquisitions can have a different wavelength range, step size or bandwidth only if
each data point has a corresponding value in the background. Therefore, a new background must be
taken whenever any of these settings is changed. Alternatively, a background that combines different
wavelength ranges and step sizes can be taken. For example, if you plan to acquire sample spectra in
both the near- and far-UV with step sizes of 0.5 and 1 nm, respectively, acquire a background spectrum
with a step size of 0.5 nm including both ranges.

2. To acquire a CD background together with an absorbance reference, make sure the Absorbance
check box is ticked.

3. If necessary, install the correct cuvette  adapter for the cuvette to be used. This is important as
different adapter window sizes affect the amount of light reaching the detector.

4. Make sure there is no cuvette in the cuvette cartridge and click Background in the Background
panel  to acquire a background.

The CD background is measured together with the absorbance reference and a Graphical Display  by
Chirascan Viewer automatically opens and displays the data. The data are stored in the Save to
Repository  as a DataStore, the name of which is generated by a seed name (the default seed name
for background data is ‘Base’) and a running number with leading zeros (e.g., ‘Base0001’). The Auto
Subtraction check box becomes active at the conclusion of a background scan: if you wish to subtract
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the CD background automatically from subsequently measured CD spectra, tick the Auto Subtraction
check box.

While an absorbance reference is always required to enable subsequent absorbance measurements,
enabling Auto Subtraction or taking a CD background at all is, in principle, not necessary if the buffer
spectrum is subtracted from the sample spectrum, as is recommended for basic data analysis.
However, always recording the CD background is good practice and can help confirming correct
operation of the instrument. In rare situations where a suitable buffer for baseline measurements is not
available, e.g. due to practical constraints of the application, at least the CD background must be
subtracted from sample spectra. In such cases, using Auto Subtraction might be more convenient than
manual background subtraction. In general, whether Auto Subtraction is used or not, it should be done
consistently so to avoid accidentally subtracting the background twice.

An example of a CD background is shown in Figure 136. 

Figure 136: Background CD spectrum

9.1.3 Loading the Buffer or Sample

To avoid spillages, the cuvette  is best removed from the cuvette cartridge before loading. Most
samples can be pipetted into the cuvette. Make sure that there is enough buffer or sample in the cuvette
to cover the window in the cuvette cartridge, and that there are no bubbles. If the measurement is to be
run at high temperatures, it may be necessary to remove dissolved gas before, to prevent bubble
formation. 
 
The cuvette should insert easily into the cartridge, and is sprung against the face of the cartridge to
ensure reproducible positioning. Always record the orientation of the cuvette, i.e. which side faces the
lamp, so that it can be replaced in the same orientation; usually, a mark on the cuvette indicating its
type helps to distinguish the two sides.
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Figure 137: Installed cuvette cartridge

Install  the cuvette cartridge by sliding it into the sample chamber and tightening its thumbscrews
(Figure 137). Finally, close the lid of the sample chamber.

9.1.4 Acquiring a Buffer Spectrum

To account for the CD signal of a buffer or other solvent, a baseline CD spectrum must be measured on
the buffer without sample. The baseline spectrum should be acquired using the same conditions as are
used for the sample spectrum, including using the same cuvette in the same orientation.

1. Empty and clean the cuvette. Then load it with the buffer.
2. Place the cuvette with buffer and in-sample temperature probe into the cuvette holder in the same

orientation as used for the sample.
3. Set the DataStore name for the baseline spectrum in the Spectrum input field of the File Names

dialog .
4. Let the buffer equilibrate until the target temperature is reached.

As the parameters for the acquisition of the baseline spectrum are identical to those for the sample,
there are no parameters that need to be adjusted at this point.

5. Click Acquire in the Sequencer panel  to start acquisition of the baseline spectrum.

The CD spectrum is recorded under the same conditions as applied to the sample and stored in the
Save to Repository  as a DataStore named as specified.

6. Check that repeat spectra overlay to make sure there is no baseline drift.
7. On completion of the measurement, remove the cuvette from the holder for cleaning and re-use.

Depending on the target measurement temperature, the autosampler cartridge
and cell may be very hot or cold, causing injury to the user when touched.
Ensure that they have been allowed to reach a safe temperature before
handling or use protective equipment (e.g., thermally protective gloves) if their
insertion or removal at extremely high or low temperature is required. Carry out
risk assessment and consider additional personal protective equipment if in
doubt.
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Depending on system configuration and experiment design, target

measurement temperature can reach between -20°C and 105°C. Extra care

should be taken when handling a potentially hot/cold cell as the target

measurement temperature is actively set through computer control and
monitored only via the Peltier controller display or the control software. As
unsafe temperatures cannot be identified otherwise (e.g., after hard- and
software is switched off or fails), the Chirascan Q100 may only be used by, or
under supervision of, trained laboratory personnel familiar with this user
manual and the risks associated with usage of the system and related
procedures, particularly when conducting experiments at elevated sample
temperatures.

9.1.5 Acquiring a Sample Spectrum

To perform a sample measurement, follow these steps:

1. Load  the cuvette with sample and place the cuvette in the cartridge. Don't forget to record the
orientation of the cuvette.

2. Set the measurement temperature : click the Target input box in the Temperature Control Unit
panel  and either input or use the up/down arrow buttons to input the required temperature, then
click Set to confirm.

3. Tick the Repeats check box in the Sequencer panel . Set the repeats number and configure
other acquisition settings as required.

It is recommended to always acquire repeat scans as these help in identifying baseline drift or sample
photolysis. All remaining parameters, including wavelength range, step size, bandwidth, and time-per-
point, should have already been set for the background.

4. Set the DataStore name for the sample spectrum in the Spectrum input field of the File Names
dialog .

5. Let the sample equilibrate until the target temperature displayed in the sample chamber panel  is
reached.

6. Click Acquire in the Sequencer panel  to start acquisition of the sample spectrum.

Chirascan Viewer automatically displays the data as it is collected, and the spectral results will appear
as illustrated by example spectra . When any CD spectrum is acquired on the Chirascan Q100, other
properties are simultaneously recorded. These include the voltage applied to the detector, the
temperature, and the absorbance spectrum (if selected on the Options panel ). They can be viewed by
right-clicking on the label of the y-axis in the Graphical Display  and selecting the property of choice
in the context menu.

7. Check that repeat spectra overlay to make sure that the sample does not undergo photolysis and
that there is no baseline drift.

8. Inspect  the corresponding absorbance spectrum: right-click the label of the y-axis in the
Graphical Display  and select Absorbance in the context menu.

9. If the absorbance is too high, reduce the path length or change the sample concentration of buffer to
optimize  the absorbance.

Remember that light intensity at low wavelengths may cause photodegradation of photolabile proteins.
Keep the bandwidth  and the time-per-point  as low as possible, commensurate with obtaining
reasonable quality data. If there is any doubt, repeat the experiment to ensure that the results are
reproducible, or perform a preliminary experiment to establish the timescale over which photodegradation
occurs. 
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9.1.6 Basic Data Analysis

In the example below, there are six traces (3 repeat baselines and 3 repeat lysozyme spectra). The data
used in this example can be found in the ‘Examples\Lysozyme Spectra’ folder which is installed with the
Chirascan software (the path will depend on the operating system). The example demonstrates how to
average the baseline spectra, average the sample spectra, subtract the average baseline spectrum from
the average sample spectrum, smooth the resulting baseline-corrected sample spectrum and remove the
original data. The end result will show the sample spectrum and its residual (smoothed minus
unsmoothed spectrum). Note that statistical analysis of replicate spectra requires averaged and baseline
corrected, but unsmoothed spectra.

1. With the Datastores Repositories View  open, navigate in the usual way until you find the baseline
measurement DataStore and double-click on it.

Chirascan Viewer displays the data contained in the DataStore in a Graphical Display .

2. Drag-and-drop the sample measurement DataStore onto the Graphical Display  with the baseline
spectra. 

Both baseline and sample spectra are shown in the same Graphical Display .

3. Click on  in the Graphical Display  toolbar to call up the Trace Manipulation dialog  (Figure
138).
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Figure 138: Raw data with Trace Manipulation dialog called up

The first three list entries are baseline spectra; the second set of three are the lysozyme spectra.

4. Select the first group of three list entries and click Average.
5. Select the second group of three list entries and click Average.

Two list entries named AVERAGE followed by a number will be added to the Visible Traces list and
plotted in the display. The first of these will be the average of the baseline spectra, and the second the
average of the sample spectra.

6. Select the first AVERAGE list entry and click Set Baseline.
7. Select the second AVERAGE list entry and click Subtract Baseline.

The list entry BASELINE SUBTRACTED (baseline-subtracted sample spectrum) followed by a number
will be added to the Visible Traces list and plotted in the display. 

8. Select the entry currently set as baseline and click Unset Baseline.
9. Select the baseline-subtracted spectrum named BASELINE SUBTRACTED and click Remove

Others.
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The Trace Manipulation dialog will appear as in Figure 139.

10.Click OK to close the dialog.

Note that even when the Trace Manipulation dialog is closed, any removed traces are remembered.
Should you wish to carry out further manipulation, simply re-open the dialog and all the traces will be
listed, whether visible or removed, enabling you to carry on where you left off.

Figure 139: Trace Manipulation dialog after spectrum manipulation

For final presentation, you might want to smooth  spectra. The result of the above manipulation and
subsequent smoothing is shown in Figure 140, with the smoothed and baseline-corrected spectrum of
lysozyme and the smoothing residuals plotted.

Figure 140: Smoothed and baseline-corrected spectrum of lysozyme (green) and smoothing residuals
(pink)

11.To save  the result, go to File → Save Current Plot… or File → Save Selected Traces… in the
Graphical Display  menu to call up the Save DataStore File...  dialog.
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The results of any manipulation are stored in a new DataStore or as a new revision of the active
Datastore if no name is provided. Complete information about the manipulated traces is saved with the
data. This information, including Template Settings, Remarks, History and Data Manipulation, can be
viewed on the Advanced Datastore Content Info panel . Convert  data into other file formats or
export  data as desired.

9.2 Choosing Acquisition Settings

In general, if you are not sure which acquisition settings to choose, i.e., if the wavelength positions of
spectral components or the maximum amplitude of the CD spectrum to be expected is unknown, then
perform a fast (using a short time-per-point and a larger step size), preliminary scan over the full
wavelength range. After establishing where the sample is CD-active and which sample concentration is
required for optimal absorbance, the settings can be adjusted for a more thorough acquisition.

The following advise on choosing acquisition settings refers to measurements in Circular Dichroism
mode, although other signals can be selected depending on the accessories fitted. 

Typical values for the acquisition settings that need to be configured  are summarized in Table 8. The
example values provided are typical for proteins, although proteins containing cofactors such as haems
may have wider wavelength ranges of interest. Other acquisition settings might need to be chosen
depending on the sample requirements.

Table 8: Typical values of acquisition settings for measuring CD spectra of proteins

Setting Typical Values

Wavelength range 260 nm to as low as possible (far-UV), 350 to 250 nm (near-UV)

Step size 1 nm (far-UV), 0.5 nm (near-UV)

Bandwidth 1 nm

Time-per-point 1 s

Repeats 3 or more

Temperature 20°C

9.2.1 Wavelength Range

The wavelength range of the Chirascan Q100 is from 1150 to 163 nm, depending on the buffer and cell
path length. Most samples, including proteins, are only CD active over a fraction of this range, typically
between 350 nm and 180 nm. It may not be possible to cover the full range in a single scan because of
the variation of the CD signal amplitude with wavelength.

9.2.2 Step Size

The step size will determine the number of data points that make up a spectrum. For a given time-per-
point, larger step sizes will reduce the overall scan time of an experiment but will also reduce the
resolution of the spectrum; smaller step sizes will improve the resolution of a spectrum, but will increase
the experimental time. An appropriate step size can be chosen using Equation 5: 

step size = peak width / 20 (5)

where the peak width refers to the full width at half height (in nm) of the narrowest peak in the spectrum.
If this is unknown, for samples in solution the step size is typically set between 0.2 nm and 1 nm. A
lower step size of 0.5 nm is typically used for proteins in the near-UV, where the spectra are more
detailed than in the far-UV. 

103 118

122

72



183

Chirascan Q100 User Manual 
 
                                                                                                                   © 2023 Applied Photophysics Limited

Tips and Tricks

9.2.3 Bandwidth

The bandwidth should be selected to maximize the light reaching the sample, without overly
compromising the spectral resolution or photolyzing the sample. In general, the signal-to-noise ratio ,
S/N, is proportional to the square root of the light throughput, and the light throughput is proportional to
the square of the bandwidth. Consequently, S/N is linearly proportional to the bandwidth. Doubling the
bandwidth will reduce the noise level by a factor of 2, tripling the bandwidth will reduce the noise level by
a factor of 3, and so on. 

However, a wider bandwidth may result in some of the finer details of the spectrum being obscured, and
there is a limit to the maximum bandwidth that can be set. This varies with wavelength because of the
non-linear dispersion of light by prisms: dispersion increases (and therefore maximum bandwidth
decreases) with decreasing wavelength. Maximum bandwidths at the shorter wavelengths vary slightly
between instruments.

The selected bandwidth is therefore a compromise between data quality and spectral resolution. At
longer wavelengths where the detector sensitivity is reduced, you may need to use higher bandwidths to
obtain a reasonable S/N. For most samples the bandwidth is typically set between 0.5 nm and 2 nm.

Usually, it is recommended to use a bandwidth ≤1 nm to ensure the detector is working within its linear
regime, especially as you go to the near-UV where samples absorb less light. With the sample in place,
the emulated detector HV should not drop below 200 V. If it does, reduce the bandwidth.

9.2.4 Time-per-Point

The time-per-point is the time taken for data sampling at each step. The longer the time taken, the better
the S/N. From Equation 6 the S/N is proportional to the square root of the time-per-point, so doubling the
time-per-point will reduce the noise level by a factor of √2, trebling the time-per-point will reduce the
noise level by a factor by a factor of √3, and so on. The chosen time-per-point will therefore be a
compromise between data quality and experimental duration, but as with the bandwidth, make sure that
you use a time-per-point that is short enough not to cause sample photolysis.

9.2.5 Repeats

Increasing the number of repeats has the same effect as increasing the time-per-point on the signal to
noise ratio, but using more than one repeat (typically 3) is helpful as it shows whether the sample is
stable, for example it could be undergoing photolysis. Using more than one repeat also gives an
indication of the data spread at each wavelength. If you want to perform a statistical analysis of the data,
then several scans (typically 5) are recommended.

9.3 Experimental Design

This section describes how to design a CD measurement and optimize the experimental conditions to
obtain high-quality data. The actual operation of the spectrometer is described in previous sections.
Though this section focuses on proteins, the approach to making a good CD measurement is the same
for other samples, although the settings may be different.

9.3.1 The Importance of the Absorbance

The simple rule of making an efficient CD measurement is not to allow the absorbance to be too high. As
CD spectroscopy is an absorbance technique, the CD signal is linear with sample concentration only if
total sample absorbance obeys the Beer-Lambert law. If the total absorbance, including that of the
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solvent or buffer, is much above about 2 AU, then the light level is too low and reliable CD measurements
cannot be made.

9.3.1.1 The Signal-to-noise Ratio

The most important factor when designing a CD experiment is the signal-to-noise ratio, S/N. For any
measurement made using electronic equipment, there are always two parts to the response. One part is
the signal, which is the “true” part of the response, due to the sample. The other is the superimposed
random part, the “noise”, due to the irregular emission of photons from a light source and the irregular
movement of electrons in electrical circuitry. The noise can never be eliminated, although it can be
reduced by good instrument and experimental design. The important consideration is not the actual
noise level, but the ratio of the signal to the noise. For CD measurements, this is given by [W.C Johnson
in Circular Dichroism and the Conformational Analysis of Biomolecules, ed. G.D. Fasman, Plenum,
1996, pp 635 to 652]:

S/N ∝ (I
0
 · Q · t · 10-A)0.5 ΔA (6)

where I
0
 is the intensity of the incident light, Q is the quantum efficiency of the detector (i.e. the fraction

of incoming photons that produce electrons), t is the sampling time, A is the absorbance and ΔA is the
difference in absorbance between L- and R-CP light as given in Equation 6.

9.3.1.2 Optimal Absorbance

Equation 6 maximizes when A = log10 exp(2) ≈ 0.87, which is therefore the optimal absorbance for
making CD measurements. Figure 141 shows the S/N as a function of wavelength, normalized to a
maximum of 1. The S/N is greater than 0.8 over the range between about 0.4 to 1.6, and the absorbance
should be within this range for as much of the spectrum as possible. There is insufficient light to make
CD measurements when the absorbance is much above about 2 AU.

Figure 141: Signal-to-noise ratio as a function of absorbance.



185

Chirascan Q100 User Manual 
 
                                                                                                                   © 2023 Applied Photophysics Limited

Tips and Tricks

9.3.2 Measuring the Absorbance

To obtain the total absorbance of a buffer or sample, a reference measurement in air is required
beforehand. To this end, a background is recorded with the cell cartridge in place. For manual
measurements , the background is recorded without a cell in the cartridge, but for automatic
measurements, the background is recorded with an empty cell. The background measurement must be
performed over the same or a broader wavelength range as that used for the buffer or sample.

9.3.3 Adjusting the Absorbance

The Beer-Lambert law (Equation 7) is used to adjust the sample concentration, the buffer type, and the
cell path length to give an absorbance that is appropriate for a given sample.

ΣA = Σ(ε ∙ c) ∙ l (7)

where ε is the extinction coefficient of each species, c is the concentration of that species, l is the path
length, and the summation sign Σ indicates that the contributions of all the species present are added
up. 

This means that the total absorbance can be adjusted:

· by changing the buffer and hence ε for the buffer (e.g., by dialysis).
· by changing the path length (i.e., using a different cell).
· by changing the concentration of the buffer or the sample (i.e., by concentrating or dilution).

The extinction coefficient of the sample cannot be changed, as that would mean changing the sample.
To obtain a high CD signal, the sample must be sufficiently concentrated, but to keep the total
absorbance low enough, the buffer absorbance must be as low as possible. To meet both these criteria,
a short path length cell is used, preferably with a low absorbance buffer, and the sample concentration is
adjusted to give the optimum absorbance.

9.3.3.1 Optical Pathlength

For automated measurements, standard cells are available in path lengths from 0.1 mm to 10 mm (see
Sample Cells and Cell Cartridges ). For CD measurements in the far-UV region (< 260 nm), 0.1 or
0.2 mm path length cells are recommended, as water and aqueous buffers absorb strongly in this region,
particularly at low wavelengths, and short path length cells are used to keep the buffer absorbance low.

In the near-UV region (> 260 nm) the choice of path length is usually less limited because water and
most buffers do not absorb strongly in this region. However, near-UV measurements are typically
performed with longer path lengths to account for the lower signal that can be expected in this
wavelength range. Therefore, a 5 mm or 10 mm path length cell is typically used. A 5 or 10 mm path
length cell must be used if fluorescence measurements are intended.

For manual measurements , Applied Photophysics recommends using CD or CD/fluorescence
cuvettes from Hellma GmbH, Müllheim, Germany, or Starna Group, Hainault, United Kingdom. Cuvettes
are available from 0.5 mm to 10 mm.

9.3.3.2 Buffer Absorbance

Buffer components can contribute to the total absorbance and this contribution is usually stronger at
lower wavelengths. Moreover, the wavelength range in which the absorbance is suitable can be limited by
excipients that are CD-active such as histidine or Triton X-100. If in such a case the total absorbance is
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too high even at low path length, one might want to consider dialysis of the sample against a different
buffer that has a lower absorbance.

Moreover, if a buffer contains CD-active compounds, it is recommended to dialyze samples against this
buffer and use the dialysate for baseline correction to ensure that any buffer contribution to CD spectra is
subtracted accurately.

Table 9 shows the absorbance cut-off for some common buffers in a 0.5 mm path length cell. At
wavelengths lower than the cut-off, the absorbance of the buffer is greater than 1 AU.

Even if an aqueous sample does not contain any excipients, buffer components or salt, absorbance by
the water itself can be limiting. If you wish to go below 180 nm, consider using heavy water (D

2
O): it

absorbs less in this region than normal water and is not expensive: buy NMR-standard D
2
O from a

reputable supplier. If you wish to go to 170 nm or even lower—and these can be somewhat difficult
experiments to perform—you will have to employ a cell with a path length of ≤0.1 mm and use heavy
water.

Table 9: Absorbance cut-off of some common buffers

Buffer path length Cut-off (A > 1 AU)

D
2
O

0.1 mm
171 nm

Water 175 nm

D
2
O

0.5 mm

174 nm

Water 178 nm

20 mM pH 7
Phosphate

181 nm

10 mM NaF 180 nm

10 mM NaCl 185 nm

1% DMSO 220 nm

100 mM Tris 190 nm

100 mM MES 201 nm

100 mM
HEPES

209 nm

100 mM
PIPES

210 nm

9.3.3.3 Sample Concentration

In the far-UV region, proteins have an extinction coefficient of about 7000 M-1 cm-1, where M refers to the
concentration of peptide bonds. For a 0.5 mm path length cell, this means that the protein concentration
should be about 0.2 to 0.4 mg/ml. In the near-UV region, the absorbance of proteins depends mainly on
the concentrations of the aromatic amino acids, particularly tryptophan. This results in an optimal
concentration ranging from about 0.45 mg/ml for proteins with a high tryptophan content, such as
lysozyme which has 6 tryptophan residues and a molecular weight of about 14 kD, to more than
2.5 mg/ml for molecules with a much lower tryptophan content.

9.3.3.4 Summary

It is not possible to cover all contingencies, but the guidelines covered in this section provide at least a
starting point in helping you to find the optimal experimental conditions. In a nutshell, consider the
following points for adjusting the absorbance for CD measurements:
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1. If possible, use a buffer that does not absorb strongly in the wavelength range of interest.
2. If necessary, use a shorter path length cell and increase the sample concentration accordingly.
3. Adjust the sample concentration to keep the total absorbance below 2 AU and centered on about

0.9 AU.

Measuring the CD spectra of proteins is the most common use of the Chirascan Q100. Conditions
recommended to ensure that protein CD spectra are of the highest quality even at very low wavelengths
are given in Table 10.

Table 10: Recommended conditions for measuring protein CD spectra

Lower wavelength limit Solvent path length Protein Concentration

180 nm Dilute buffer, H
2
O or D

2
O ≤ 0.5 nm 0.2 - 0.5 mg/mL

175 nm H
2
O or D

2
O ≤ 0.2 nm 0.5 - 1.0 mg/mL

170 nm D
2
O ≤ 0.1 nm 1.0 mg/mL
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9.4 Example Spectra

There are several files installed on the hard disk that can be used as templates to set up the Chirascan
interface or as tools to familiarize oneself with the use of Chirascan Viewer . The files are held in the
\Examples subfolder of the Chirascan software directory and can be accessed in Chirascan Viewer
by navigating to this directory in the file list .

9.4.1 Alcohol Dehydrogenase

The CD spectrum of 1 mg/mL alcohol dehydrogenase dissolved in water using a 0.1 mm path length
cuvette, plotted as CD (mdeg) against wavelength (nm), is shown in Figure 142. The acquisition settings
are given in Table 11.

Figure 142: CD spectrum of alcohol
dehydrogenase

 
Table 11: Acquisition settings for the spectrum in
Figure 142

Setting Value

Wavelength range 260 nm to 175 nm

Step size 0.5 nm

Bandwidth 1 nm

Time-per-point 3 s

Repeats 1

9.4.2 Bovine Serum Albumin

The CD spectrum of 1 mg/mL bovine serum albumin dissolved in water using a 0.1 mm path length
cuvette, plotted as CD (mdeg) against wavelength (nm), is shown in Figure 143. The acquisition settings
are given in Table 12.

Figure 143: CD spectrum of bovine serum
albumin

 
Table 12: Acquisition settings for the spectrum in
Figure 143

Setting Value

Wavelength range 260 nm to 175 nm

Step size 0.5 nm

Bandwidth 1 nm

Time-per-point 3 s

Repeats 1
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9.4.3 Cytochrome C

The CD spectrum of 1 mg/mL cytochrome C dissolved in water using a 0.1 mm path length cuvette,
plotted as CD (mdeg) against wavelength (nm), is shown in Figure 144. The acquisition settings are
given in Table 13.

Figure 144: CD spectrum of cytochrome C

 
Table 13: Acquisition settings for the spectrum in
Figure 144

Setting Value

Wavelength range 260 nm to 175 nm

Step size 0.5 nm

Bandwidth 1 nm

Time-per-point 3 s

Repeats 1

9.4.4 Lysozyme

The CD spectrum of 0.2 mg/mL lysozyme dissolved in water using a 0.5 mm path length cuvette, plotted
as CD (mdeg) against wavelength (nm), is shown in Figure 145. The acquisition settings are given in
Table 14.

Figure 145: CD spectrum of lysozyme

 
Table 14: Acquisition settings for the spectrum in
Figure 145

Setting Value

Wavelength range 260 nm to 185 nm

Step size 0.5 nm

Bandwidth 2 nm

Time-per-point 1 s

Repeats 3
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9.4.5 Vitamin B12

The CD spectrum of 0.2 mg/mL vitamin B12 dissolved in water using a 1 mm path length cuvette, plotted
as CD (mdeg) against wavelength (nm), is shown in Figure 146. The acquisition settings are given in
Table 15.

Figure 146: CD spectrum of vitamin B12

 
Table 15: Acquisition settings for the spectrum in
Figure 146

Setting Value

Wavelength range 600 nm to 200 nm

Step size 1 nm

Bandwidth 1 nm

Time-per-point 2 s

Repeats 1

9.4.6 Tris(ethylenediamine) Cobalt Chloride

The CD spectrum of 1 mg/mL tris(ethylenediamine) cobalt chloride dissolved in water using a 10 mm
path length cuvette, plotted as CD (mdeg) against wavelength (nm), is shown in Figure 147. The
acquisition settings are given in Table 16.

Figure 147: CD spectrum of tris(ethylenediamine)
cobalt chloride

 
Table 16: Acquisition settings for the spectrum in
Figure 147

Setting Value

Wavelength range 800 nm to 250 nm

Step size 1 nm

Bandwidth 1 nm

Time-per-point 0.5 s

Repeats 1
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9.4.7 Camphor Sulphonic Acid

The CD spectrum of 0.6 mg/mL 1-S-camphor-10-sulphonic acid dissolved in water using a 1 mm path
length cuvette, plotted as CD (mdeg) against wavelength (nm), is shown in Figure 148. The acquisition
settings are given in Table 17.

Figure 148: CD spectrum of camphor sulphonic
acid

 
Table 17: Acquisition settings for the spectrum in
Figure 148

Setting Value

Wavelength range 300 nm to 180 nm

Step size 0.5 nm

Bandwidth 0.5 nm

Time-per-point 1.75 s

Repeats 1

9.4.8 (R)-3-Methylcyclopentanone

The CD spectrum of vaporous (R)-3-methylcyclopentanone using a 10 mm path length cuvette, plotted
as CD (mdeg) against wavelength (nm), is shown in Figure 149. The acquisition settings are given in
Table 18.

Figure 149: CD spectrum of (R)-3-
methylcyclopentanone

 
Table 18: Acquisition settings for the spectrum in
Figure 149

Setting Value

Wavelength range 350 nm to 175 nm

Step size 0.1 nm

Bandwidth 0.1 nm

Time-per-point 1 s

Repeats 1

9.4.9 Autosampler Procedure for Lysozyme

The data for the following example are not included in the \Examples subfolder of the Chirascan
software directory. The example is described here only to illustrate a typical autosampler procedure.

For this example, a microplate of 6 replicates of buffer and 6 of lysozyme was run using the plate layout
shown in Figure 150. Three repeat scans of each replicate were acquired, giving a total of 18 buffer and
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18 lysozyme spectra. The experiment was performed twice, once for far-UV and once for near-UV
measurements.

2 B L B L B L - -

1 B L B L B L - -

A B C D E F G H

Figure 150: Microplate layout for lysozyme, B: buffer, L: lysozyme

The experimental details are summarized in Table 19, and the Autosampler spreadsheet for the far-UV
measurements is shown in Figure 152.

Table 19: Experimental details for automated acquisition of lysozyme CD spectra

Far-UV Near-UV

Lysozyme concentration 0.8 mg/ml 0.46 mg/ml

Buffer 10 mM Sodium phosphate, pH 7.0 10 mM Na phosphate, pH 7.0

Number of replicates 6 sample, 6 buffer 6 sample, 6 buffer

Volume per well 120 ml 900 ml

Total Spectra 18 sample, 18 buffer 18 sample, 18 buffer

Microplate storage
temperature

12⁰C 12⁰C

Cell path length 0.2 mm 10 mm

Signal Circular Dichroism Circular Dichroism

Measured
simultaneously 

Absorbance Absorbance

Wavelength range 180 to 260 nm 250 to 320 nm

Step size 1 nm 1 nm

Bandwidth 1 nm 1 nm

Time-per-point 1 s 1 s

Temperature 20⁰C 20⁰C

Number of repeats 3 3

Sampling Method AutoSample AutoSample

Cell Wash Method CellWash CellWash

Probe Wash Method ProbeWash ProbeWash

Figure 151: Wells View spreadsheet used for automated acquisition of lysozyme far-UV CD spectra

The raw spectra obtained for lysozyme and buffer are shown in Figure 152 (far-UV) and Figure 154
(near-UV), and the spectra after averaging and buffer subtraction are shown in Figure 153 (far-UV) and
Figure 155 (near-UV). Note that the baseline corrected far-UV spectra were cut-off at 182 nm, as total
absorbance at lower wavelengths was above 2 AU.
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Figure 152: 18 buffer and 18 lysozyme far-UV CD (left) and absorbance spectra (right)

  
Figure 153: 6 lysozyme far-UV CD (left) and absorbance spectra (right) after averaging and buffer
subtraction

  
Figure 154: 18 buffer and 18 lysozyme near-UV CD (left) and absorbance spectra (right)
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Figure 155: 6 lysozyme near-UV CD (left) and absorbance spectra (right) after averaging and buffer
subtraction
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10 Maintenance and Servicing

10.1 General Maintenance

Applied Photophysics recommends that the instrument is serviced regularly. This is best achieved by
holding a Support Plan. Please contact  Applied Photophysics Customer Support for further advice on
Support Plans.

The spectrometer has been calibrated by Applied Photophysics engineers during production or servicing.
Recalibration by the user is not recommended, except under instruction from an Applied Photophysics
Customer Support Specialist.

If used and maintained with care, the Chirascan Q100 including spectrometer and autosampler should
provide many years of reliable service. 

Do not allow aggressive or corrosive chemicals to come into contact with the
Chirascan Q100 as these may cause damage to the instrument: clean up any
spillages immediately. To clean the instrument, use a soft cloth with a dilute
solution of mild detergent in water.

The lamp  should be replaced  within the recommended 1000-hour lifetime, if it becomes difficult to
ignite, gives unstable output, or if if the output is diminished. It is recommended to also replace the
nitrogen filter  once a lamp replacement becomes necessary.

Water and cleaning solution in reservoir bottles should be replaced weekly by fresh solutions. When
preparing the dilution of the cleaning solution from stock, ensure proper mixing, e.g., mix with a
magnetic stirrer until the solution appears homogeneous and is not turbid anymore.

Check the autosampler visually on a regular basis, in particular the flow tubing, to make sure tubing is
not kinked, and that there are no leaks.

A liquid handling test procedure is performed half-yearly during servicing. This test procedure includes
checking the diaphragm pump performance and the accuracy of the syringe pump.

10.2 Cleaning cells

Applied Photophysics recommends cleaning cells with multiple water rinses, followed by an acetone
rinse, before finally blow-drying with nitrogen gas.
Compressed air can be used as long as it is clean and free of contaminants.
For mildly persistent contaminants, Applied Photophysics recommends the use of detergents such as
Hellmanex.
For heavily persistent contaminants, Applied Photophysics recommends soaking cuvettes in
concentrated nitric acid for 1-24 hour(s). 

10.3 Moving the Instrument

Do not attempt to move the autosampler or disconnect it from the
spectrometer except under instruction from an Applied Photophysics engineer,
as this may cause damage to the instrument. Do not attempt to adjust feet
height of spectrometer or autosampler as this may misalign the instrument.
Please contact Applied Photophysics Customer Support for further advice.

202
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The monochromator has components than can be damaged if their movement
is not restricted when the spectrometer is moved. This movement is restricted
by parking the monochromator.

Never alter height of the monochromator or autosampler leveling feet, as this
may impair light path alignment. 

The autosampler will have been connected to the spectrometer by an Applied Photophysics engineer
during the installation process. However, it may be that you wish to disconnect the autosampler for
transportation, or to re-install the standard sample chamber in the case of an upgraded system. For
advice, please contact  Applied Photophysics Customer Support.

To park the monochromator, open the Monochromator dialog through the Device window , and click
Park mono. Exit the software and switch off the electronics without any further actions once the parking
completes. Any adjustment of wavelength, bandwidth or attenuator will unpark the monochromator.
Restarting the electronics will also unpark the monochromator as the instrument goes through its
initialization sequence. Power should only be restored when the instrument is settled in its new location.

After moving or relocating the instrument, the spectrometer can be leveled by using a spirit level and
adjusting feet height, including monochromator leveling feet. However, this should only be done by
Applied Photophysics engineers as otherwise instrument alignment may be impaired. 

Applied Photophysics Customer Support should be contacted  for any further guidance or assistance
with relocation.

202

91
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10.4 Lamp Removal and Replacement

The xenon arc lamp operates at mains voltage. Power off the lamp before
removal.

The light source of the Chirascan Q100 is a 150-watt xenon arc lamp that
produces intense UV radiation that can be harmful to skin and eyes and may
even impair eyesight permanently. Do not allow the skin to be exposed to UV
radiation. Never look directly at the light source. Do not power on the lamp
unless it is correctly mounted in the lamp housing. Do not remove the lamp
system cover and do not open the lamp housing while the lamp is operative,
as indicated by the yellow lamp system cover indicator. Do not attempt to
remove the UV filter of the lamp housing port. Do not attempt to remove the
Single Cell Peltier Holder or any accessory that replaces it unless the lamp is
powered off or the lamp shutter is closed.

Xenon arc lamps have a high internal pressure and can burst, particularly when
hot, causing injury to the user and bystanders. Do not open the lamp housing
immediately after it is powered off. Handle carefully, do not submit the lamp to
shock, and wear eye, full face (shield / visor), and body protection, including
full arm covering. Do not touch the glass bulb of the lamp with bare hands.
When handling lamps, ensure that others are restricted from entering the area
or wear protective personal equipment as well. If not installed, always store
and transport lamps (old or new) only in safety metal cases provided by
Applied Photophysics to guard against implosion.

The lamp is at high temperature during operation. Do not remove outer lamp
system cover while the lamp is on. Surface temperature of the lamp unit
housing exceeds 50°C during operation, imposing risk of burns, DO NOT
TOUCH. After powering off, allow lamp housing temperature to decrease until
cool to touch (at least 30 minutes) before removing the lamp.

When changing a lamp, remember that the programmed schedules for the
ANMS will remain active. Do not power on a Xenon or Mercury-Xenon lamp
until the lamp spectrometer has been thoroughly purged.

When reconnecting the red and black power leads of the lamp, ensure that
they are not being connected the wrong way around.

To change a lamp, follow the steps below, referring to Figure 156.

First, remove the currently installed lamp:

1. Have an empty lamp storage box ready to receive the old lamp.
2. Shut down the computer and switch off the system by putting the black rocker switch for the System

on the front panel  to the power off (O) position.
3. Switch off the lamp power supply by putting the black rocker switch for the Lamp on the front

panel  to the power off (O) position, and leave for at least 30 minutes for the lamp to cool down. 
4. Unscrew the two thumbscrews at the back of the spectrometer that connect its end cover to the left

with the back cover.
5. Remove the spectrometer end cover by sliding it to the left, off the magnetic catches and clear of the

lamp housing.
6. Unplug the red and black leads at the back of the lamp power supply.

40

40
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7. Unscrew the two retaining screws on top of the lamp assembly.
8. Carefully lift the old lamp out of the housing and place in the storage box, securing with the retaining

screws.

Figure 156: Lamp housing fittings with lamp cover removed

Then, install the new lamp:

9. Unscrew the retaining screws from the new lamp storage box, remove the lamp, and carefully insert
into the housing.

10.Secure the lamp in the housing with the retaining screws.
11.Reconnect the red and black leads, replace the spectrometer end cover and screw in the

thumbscrews connecting it to the back plate.
12.Switch on the lamp power supply and the system with the corresponding black rocker switches on

the front panel , start the computer and open the ANMS  software.
13.Click Start Lamp Ignite Sequence in the ANMS  software and reset the timer on the system

front panel .
14.Please return the old lamp assembly to Applied Photophysics for recycling.

10.5 Probe Replacement

The moving parts of the autosampler could cause serious injury to the user or
damage to the instrument. For safe operation the moving parts are contained
within an enclosure fitted with an interlock device, which is engaged while the
autosampler is operating. Do not attempt to open the enclosure door upon
autosampler operation or to override the interlock device. In some
circumstances, for example when manually adjusting the position of the probe,
it may be possible to move the autosampler arm using the autosampler
software while the enclosure door is open. Do not use the software to move
the autosampler arm while the enclosure door is open. Do not operate the
autosampler without the removable panels at the lower front, side and rear in
place. Do not introduce any object through the brush panel ports on the rear of
the autosampler while the autosampler is operating.

Before changing the probe, first ensure that there are no hazardous materials in the flow line or probe. To
remove the probe, hold the probe firmly and unscrew the brass retaining ferrule (Figure 157, left).

40 64

64

40
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Figure 157: The probe and ferrule (left), the connection between the probe and the flow tubing (middle)
and the meshed flexible tubing protector (right)

Withdraw the probe from the holder by gently pulling downwards. It should be attached to the flow tubing
as in Figure 157, middle. Ease the probe from the tubing, taking care not to damage the tubing. If the
tubing does become damaged, remove the damaged part using a specialized tube cutter.

The new probe can then be inserted into the tubing. Take care to insert the probe into the tubing straight
as the upper end of the probe is sharp and might cut the tubing if held at an angle. It may be necessary
to hold the tubing using the emery paper provided. If the end of the tubing is not within reach, it can be
fed through from above, as it is routed through the autopositioner armature and meshed flexible protector
(Figure 157, right). There is no need to remove the protector for this, as the tubing can be gripped by the
protector.

Although the coordinates are factory set, the probes tend to vary in length, and
it is suggested that recalibration is carried out if a new probe is fitted, or if any
position appears to have changed. Failure to do so may result in damage to
the autosampler.
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10.6 Troubleshooting

If the instrument does not operate properly, please use Table 20 to eliminate any trivial causes of
incorrect function.

Table 20: Troubleshooting 

Symptom Cause Corrective Action

Instrument /
computer cannot be
powered on.

No power available.

Check that all power cables are correctly plugged in.

Check that the power at the mains outlet is powered on.

Check that all supply fuses are intact.

Communications
between instrument
and software failing.

Communications cable
loose or broken.

Check that the USB cable connecting instrument and
computer is correctly plugged in.

Check that the USB cable connecting instrument and
computer is intact.

Correct startup procedure
was not followed or
instrument has been
powered off before closing
down software.

Unplug and replug USB cable connecting instrument and
computer.

Close down and restart software. Power up hardware
before launching software.

No detector signal.

No light - lamp is not
ignited.

Set the lamp ignition sequence on the ANMS or choose
Lamp Immediate Start if the instrument has been purged
for a sufficient time. 

No light - shutter is in the
closed position.

Use the Chirascan interface to Open the shutter or
enable Autoshutter function.

No light – slits too narrow
or closed.

Check the bandwidth in the Monochromator panel of the
Chirascan interface and set the bandwidth to a
reasonable value, e.g. 1 nm

No light – sample is
opaque.

Reduce concentration and / or path length of sample
and / or buffer.

No light in far-UV –
instrument is not purged.

Oxygen absorbs light at wavelengths below 190 nm.
Ensure that the purge tubes are connected at both ends
and that there is nitrogen available, and purge the
instrument with clean nitrogen.

Signal is too noisy.

Bandwidth too narrow
Check the bandwidth in the monochromator section of
the Chirascan interface and set it to a reasonable value,
e.g. 1 nm.

Sample or buffer is highly
absorbing.

Reduce concentration and / or path length of sample
and / or buffer.

Lamp is old.
If the lamp has been run for more than 1,000 hours, its
output, especially in the far-UV, will be low. Replace
lamp.

Unstable line voltage Use stabilized supply.

Electromagnetic
interference from nearby
equipment.

Remove the source of noise from the proximity of the
spectrometer.
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10.7 Contact Information

If the instrument does not operate properly and the observed issue is either not covered in
Troubleshooting  or symptoms persist after consulting this section, please contact Applied
Photophysics Customer Support using the details below, with a detailed description of your issue and
the name of your spectrometer.

By telephone

UK & international:
US:

By e-mail

All inquiries:

+44 1372 386 537
+1 978 473 7477

support@photophysics.com 

Moreover, feel free to contact Applied Photophysics Customer Support if you have any doubts about
instrument usage or need additional information or special assistance regarding:

· Relocating the instrument
· Queries relating to the software or PC
· Preventative Maintenance and Support Plans
· Consumables, replacement parts and upgrades
· Training and applications support
· Compatibility with accessories or third-party equipment
· Method development using automated procedures
· Need to override the autosampler interlock
· Database backup procedure
· Flow system compatibility with specific samples
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Applied Photophysics Inc.
2331 Crownpoint Executive Drive, Suite F

Charlotte, NC 28227
United States

Tel.: +1 978 473 7477
Email: info.usa@photophysics.com

Applied Photophysics Ltd.
21 Mole Business Park
Leatherhead, Surrey, KT22 7BA
United Kingdom

Tel.: +44 1372 386 537
Email: info@photophysics.com

Head Office US Office
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